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General Information 
 
IPS Introduction 
 
The Integrated Positioning System (IPS) software allows for the integration of the EdgeTech 
Broadband Acoustic Tracking System (BATS), a ship's GPS and a heading sensor 
(GPS-GYRO, flux gate or gyro compass) to a personal computer (PC) running Windows 7, 8 
or 10 operating systems.  The system allows for the tracking and navigation of the primary 
surface support vessel (BATS platform), up to nine submerged targets (e.g., an ROV, AUV, 
submersible, towfish, diver, etc.) in addition to one remote ship and one Doppler Velocity 
Log navigation system. 
Notes: A secondary or remote ship can be displayed on the primary support vessel (IPS 
session) as target 9 provided the data can be transmitted to the primary support vessel. 
This is typically done using point-to-point RF data modems usually in the UHF 
bandwidth.  Doppler Velocity Log (DVL) units supported included the Teledyne (RDI) 
Workhorse Navigator and the Link Quest units.  
The position of the submerged targets relative to the ship is determined by the BATS and 
sent to a PC over a Local Area Network (LAN) or via an RS-232 serial link.  The submerged 
targets' relative bearings are adjusted to a true bearing using the information from the 
ship’s heading sensor.  The actual position (latitude/longitude) of the submerged target is 
then calculated based on the range and true bearing relative to the surface support ship's 
position as supplied by a GPS receiver.  The results are then graphically displayed on the 
PC's screen.  The data may be stored and retrieved for later processing. 
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Technical Support Contacts 
 
For Technical Support please contact EdgeTech: 
ORE Offshore is now EdgeTech 
 
EdgeTech 
 
4 Little Brook Road 
West Wareham, MA 02576  USA 
 
Main Phone #:  508-291-0057 
Fax #: 508-291-2491 
general email: info@edgetech.com 
website: http://Edgetech.com 
 
For emergency technical assistance, 
please call 508-942-8043 
 
 
Additional Useful Contacts 
 
NMEA Technical Information: 
 
Marine Electronics - The Official Journal of the NMEA 
National Marine Electronics Association 
 
website: http://www.nmea.org 
Phone: 410-975-9425 
Fax:    410-975-9450 
Email: info@nmea.org 
 
 
Serial Interface Card Technical Information: 
 
Lantronixs 
 
RS-232 to Ethernet Converter 
Part #: USD-2100 
Website: http://www.lantronix.com 
Phone: (949) 453-3990 
Fax:    (949) 453-3995 
Email: sales@lantronix.com  
 
 
C2G formerly Cables To Go 
 
Website:  http://www.cablestogo.com 
Phone:    1.800.506.9607  
 
 
Serial Multiplexer Technical Information: 
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NoLand Engineering, Inc. 
 
Website: http://nolandeng.com 
Phone:321-951-7329 
Email: info@nolandeng.com 
 
 
Horita Serial Control Titler Technical Information: 
 
Website: www.Horita.com 
Phone: 949-489-0240 
Email Technical Support: techsupport@horita.com 
 
 
ROV Telemetry 
 
OceanTools Ltd                        
 
Website: http://www.oceantools.co.uk 
Phone:+ 44 1224 709606 
Email: mail@oceantools.co.uk 
 
Gyro Compasses 
 
Subsea Technologies 
 
Website: http://www.subseatechnologies.com 
Phone:  281-398-5600 
Email:   sales@subseatechnologies.com 
 
 
KVH Industries, Inc. 
 
Website:  www.kvh.com 
Phone: 401-847-3327 
Fax:    401-849-0045 
 
Furuno U.S. 
 
Website: http://www.furunousa.com 
West Coast 
Phone: 360-834-9300 
East Coast 
Phone: 410-479-4420 
 
 
Raytheon Marine Company 
 
Website  http://www.raytheon-anschuetz.com 
Phone: +49 (0)431 3019 96440  
E-Mail: anschuetz.service@raytheon.com    
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Frequently Asked Questions 
 
1.  How do I get a target back on the view screen if it is out of the viewing area? 

Make sure the target of interest is displayed in the Focus Icon Box on the toolbar by 
clicking on the Focus Icon button until the desired target is showing.  Then use the 
toolbar  Home Key to put the target in the center of the viewing area.  The Zoom In, 
Zoom Out and Zoom Area buttons on the toolbar may then be used to further adjust 
the viewing area. 

2.  What should I check first if no new tracking data is being processed? 
First make sure that a Hardware Key is being used.  If the IPS Message Box displays a 
"Post processing only!" message that means the IPS did not find a hardware key on 
start up. Also check the About dialog box and make sure the hardware key number is 
displayed and not "Post Processing Only".  If this is the case the IPS program must be 
exited, the hardware key put in and the program restarted before new tracking data 
can be processed.  In addition, make sure that Ship's Position input and ORE Data 
input have been set properly in Inputs->System Inputs.  Next make sure that a 
communications port has been selected using the Communication dialog box.  If 
incoming serial strings are displayed in the Communications View Port Window, this 
would indicate that the communication port settings are correct, otherwise recheck the 
communications settings. 

3.  How do I calculate and display the Range and Bearing between two waypoints? 
First make sure the two waypoints have been set then use the View->Range and 
Bearing Calculator to calculate and display the range and bearing. 

4.  How do I set a Waypoint? 
There are several ways to do this.  You can set a Waypoint using the Waypoint Icon 
Box on the toolbar to add a waypoint whose position corresponds to the current 
position of the focus target.  You may also use the View->Waypoint List Window to 
access the IPS Waypoint Box and enter a Waypoint manually.  In addition you can use 
the View->Cursor Waypoint Activated option to add a waypoint by left mouse clicking 
the portion of the grid corresponding to the desired waypoint location. 
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IPS Help 
 
The IPS help manual is available online: 
 
https://gocut.tiwri.com/ 
 
Also entering F1 in almost all of the dialog boxes will display the corresponding help file entry. 
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List of Typical IPS Equipment 
 
The system has 4 major components: 
 
1.     ORE Broadband Acoustic Tracking System (BATS). 
 
2.     A GPS receiver that supports the GGA data format, a National Marine Electronics 

Association (NMEA) data string version 1.5 or higher. For example: 
$GPGGA,154325,2939.551,N,09533.814,W,9,5,002,0018,M,-06,M 
and optionally the following NMEA data strings: 
VTG- Vessel's Course and Speed over ground ($GPVTG,016.7,T,,,08.5,N,,) 
ZDA- Date time 
HDT- True heading (available from GPS positioning and heading systems ("GPS 
Gyro") or as a pass thru function) 
The first data string (GGA) contains the ship's position in latitude and 
longitude.  Latitude and longitude minutes carried out from 3 to 6 places right of the 
decimal point are acceptable.  A check sum at the end of the $GPGGA data string is 
acceptable but not necessary.  The optional data strings (VTG) contains the ship's 
course and speed over ground, (ZDA) data time and the (HDT) vessel's true heading.  
 

 
3.    GPS positioning and heading (GPS-GYRO) system, gyrocompass or flux-gate compass 

to provide vessel heading information.  The heading data can be sent to the IPS 
program through a serial port multiplexer, a USB RS-232 converter or Ethernet 
RS-232 converter. 

      Note:  Please contact ORE Technical Support Contacts  for additional assistance in 
compass selection.  The following is a list of acceptable compasses: 

A. An EdgeTech ORE Motion Reference Unit (MRU) Model No. ($POREM), 
NMEA format $PRDID or Maretron SSC200 solid state compass ($PMAROUT). 

B. Any device that outputs an NMEA data string in HDM, HDT, HDG, VHW or 
TSS HHRP format containing the ship's heading.  Examples are compasses 
produced by EdgeTech, Subsea Technologies, KVH Industries, Inc., Furuno, 
and Raytheon among others.  See the Technical Support Contacts section of 
this manual for information on contacting these companies.  Other formats 
may be supported, please contact ORE for assistance.  Please see the section 
GPS Receiver in this manual for more information. 

C. Heading sent directly to the PC via Ethernet using UDP (F-180 MCOM 
format). Please see the section on System Interfacing in this manual for more 
information. 
 

4.   A PC with XP or Vista 32 bit, Windows 7 32 or 64 bit and Windows 10 32 or 64 bit, 600 
x 800 graphics or better and one available USB port with a USB-RS232 converter and 
one Ethernet port. 

 
10 
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Suggested BATS-IPS Setup 
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Summary of Software Features 
 
The IPS software operates on a Windows compatible PC (XP or Vista 32 bit and Windows 7 
32 and 64 bit, 600 x 800 graphics) with at least one hundred and twenty eight (128) MB 
RAM.  The PC allows for easy handling of the ship's and target’s positional data, and also 
provides a graphic display of the data as it is collected.  The data may then be stored to a 
disk and reloaded at any time into the IPS program for review or for additional 
printouts.  In addition, the software also allows for the following: 
 

1.      Searching through the currently displayed data and/or through any data file loaded 
into the system WITHOUT the loss of any incoming data.  All meaningful mission 
data is saved in an IPS data file.  This data can be filtered using any of the filtering 
algorithms available in the filtering menu. See MENU BAR-> File Menu for 
information on saving and loading data from previous missions, and MENU BAR -> 
for information on filtering data. 

 
2.       Shifting the current viewing window to center on any target.  

 
3.       Scaling of the current area being displayed.  If Latitude/Longitude has been 

selected for the graphical display the available display units are units of nm, 
meters, yards or feet.  If UTM has been selected for the graphical display the only 
display units allowed are meters.  The text position display can be set to either 
UTM or Latitude\Longitude regardless of the graphical display setting.  See MENU 
BAR -> Display Settings for information on scaling the area currently displayed. 

 
4.       Navigation of the support ship or a submerged target relative to any target, 

beacon, or a specified location (latitude/longitude). 
 

5.       Output of a submerged target position in a variety of NMEA and other formats 
suitable for interfacing with other data acquisition and plotting systems.  In 
addition the Horita Titler may be used to provide video text overlay in real 
time.  Please see the Serial Out Command and Technical Support Contacts sections 
in this manual for more information. 

 
6.        Export of all ship and ORE target position data currently in memory in many 

common formats such as National Marine Electronic Association (NMEA) format, 
IPS format and GIS formats like KML and SHP. Please see the section Text/NMEA 
Export data and GIS/Image Export for more information.   
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Demo Replay Mode 
 
The Demo Replay Mode allows the user to open a file and play it back in real time.  The file 
being played back will emulate BATS input in that each point will be plotted using the 
current draw rate.  The draw rate can set by using either Target Settings or Ship Settings 
menu command.  A quality control check will be done before each new point is plotted.  If 
the position in the saved file is not within one foot of the raw data position displayed by the 
software prior to filtering, a warning will be displayed in the IPS Message window.  To use 
the demo replay feature follow the steps listed below. 
 
Note: Files used in the for demo replay mode must end in the extension .raw.  For example 
a file named demo.raw could probably be used for demo replay, while a file named demo.txt 
could not be used for demo replay. 
 
1.          Select the SYSTEMS INPUT -> Ships Position Data - > Demo/Replay 

option.  Please see the System Inputs section of this manual for more information 
on the SYSTEM INPUT menu command.  If the Demo/Replay option has been 
selected, the Compass Data will be automatically be set to NMEA. 

 
2.         Select FILE -> Open and open the file you wish to use for the demo replay.  Please 

see the File Open Command of this manual for more information on the FILE open 
command. 

 
3.          To close the file currently being used for demo replay, use the FILE -> Close menu 

option.  Please see the Close section of this manual for more information on the 
FILE close command.  At this point a new file may be selected for use as the demo 
replay file or the replay demo mode may exited. 

 
4.         To exit the demo replay mode, select the SYSTEMS INPUT menu command and set 

Ships Position Data to anything but Demo/Replay. 
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IPS Installation 
 
IPS Installation Steps 
 

1. Run the IPS setup.exe. 
2. Insert the IPS Security Key: 

 
 

Figure 1.        IPS USB Security Key 
   
Setup IPS Communication Port 
 
Serial Ports 

1. Run the IPS from desk top Icon . 

2. Depending on the system setup select serial or ethernet port as required for GPS or      
VRU data depending on the GPS. From the Main menu select Setup 
Menu->Communications Command. 

 
 

1. Select a Serial port from the upper left list box (i.e. Comm 1). 

2. Select a Baud Rate (typically NMEA devices default to 4800 baud). 
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3. Click on the [Open Port] button. Data from that device if available will be displayed in 
the “in coming data area” below. 

4. Continue this process until the necessary devices are on-line and being received by 
the IPS.  This typically includes: GPS (Ship lat/long), ship’s heading sensor (Fluxgate 
compass or gyro) and remote VRU. 

Ethernet UDP Ports 

1. From main IPS menu select Setup->Ethernet Settings. 

2. Select an unused UDP port. 

3. Typically "Header-Special Processing"can be set to None. 

4. Set Local Port number to the UDP port number that the RS-232 converter transmits 
the data to. 

5. Click on the  "Receive Data"check box. 

6. If the IPS is required to transmit data to another device/PC set the Remote Port and 
IP address of the remote device. Note the data format and target number being used 
are set in the Setup->Serial Out Command menu option. 
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Setup/configuration of IPS Input Devices 

1. From IPS main Menu-> Input Menu->System Inputs Command: 
 

                
 

 
1. If GPS NMEA positions are available select GGA or otherwise:  

2. Enter a fixed lat/long position or 

3. for CodaOctopus F180 or F190 systems select “F180 UDP”. 

4. Check DGPS only and Use GPS Check Sum boxes if required for GGA input. 

5. Select EdgeTech USBL Tracking System: BATS. 

6. Select the System Input “Compass” tab. 
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1.   Select the compass data format style. For NMEA 0183 serial data being received select 

the corresponding format. Typically the format HDT is provided by North seeking Gyros 
and HDM or HDG formats are provided by magnetic sensing based heading sensors 
(Fluxgate compasses etc.) Note if an Attitude Heading Reference System (AHRS) is 
being used such as TSS MAHRS, IXSA Octans or CDL MiniRLG/MiniPOS set the 
compass data field to none. 

2.   Note if the heading sensor provides an NMEA style check sum the user can select the 
check box “use Compass Check Sum”. The check sum field will have the following 
format ‘*CS’ where the ‘*’ will precede the actual check sum characters that range 
from 0..9, and A..F (hex encoded ASCII). 

3.   The remaining two tabs “Offset” and “VRU/Depth” allow for the configuration of an 
Attitude Heading Reference System (AHRS) as a TSS MAHRS, IXSA Octans or CDL 
MiniRLG/MiniPOS and allow the user to select the data format for NMEA depth data 
strings. 

4.   If valid data from the external devices (ORE USBL, GPS, compass etc.) is being 
received by the IPS, then the IPS should display the data in text format in the Position 
Boxes on the right side of the screen and graphically in the center of the screen. 

 

 



Integrated Positioning System Version 7.7.1.10 18 

Creative Underwater Technologies Copyright 1992-2019 

 
GPS Receiver 
 
Any commercially available GPS receiver should be suitable for use with the IPS, provided it 
can output the standard NMEA 0183 data strings "GGA" and "VTG".  A receiver with 
differential capability (DGPS) is strongly recommended. 
 
The GPS receiver may be connected to one of the Serial Multiplexer listener ports or to the 
PC serial port via a shielded RS-232 serial cable.  The GPS receiver may also be connected 
to a RS-232 USB converter which allows you to convert GPS data into USB accessible data 
that can be input on any windows comport.  In addition the RS-232 GPS data may be 
converted to an Ethernet UDP packet, however an Ethernet port must be opened in the 
IPS.   Please see the Ethernet Configuration section of this manual for more information. 
 
 
The operations manual for the GPS receiver should be consulted for details of the serial 
interface, and the procedures for enabling the required data strings.  The output protocol 
should be set to the NMEA standard of no parity, 8 data bits and 1 stop bit.  
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IPS BATS Setup Procedure 
 
Equipment 
 
1.   ORE BATS USBL 

1.1.        Deck cable (10 m) 
1.2.        Hydrophone (Model 4213C 22-30 kHz) 
1.3.        Ethernet switch 

 
2.        ORE Trackman software version 1.0.14.0 or later. 
3.        IPS software version 7 or higher & IPS USB security key. 
 

PC Software Setup 
1.        Install ORE TrackMan software and update if required. 
2.        Verify that data output format is set correctly using the text editor Notepad. 

2.1.        C:\Program Files\ORE Offshore\Trackpoint MMI 
 

2.2.        Files: SENT_OUT.INI and SENT_TPI.INI 
 

[PORE] 
FormatMask=3 
StartOfMsg=$ 
Format=PORE 
Delimiters=,* 
PositionMask1=0 
PositionMask2=0 
PositionMask3=0 
Types=cxtxaxxxxxxxx 
NMEA_Format=I02I,U002,c032,i01s,b032,XM62,YM62,DM51,R032,P032,E02I,
Q02I 
 
[POREG] 
FormatMask=3 
StartOfMsg=$ 
Format=POREG 
Delimiters=,* 
PositionMask1=0 
PositionMask2=0 
PositionMask3=0                                
Types=cxtxxxxxxxxxxxxxx 
NMEA_Format=I02I,U002,104I,204I,304I,Q02I,E02I,SM52,A022,B032,XM62,Y
M62,DM52,C032,P032,R032,tC3I,G031 
 

3.        Power on BATS (front rocker switch) 
 

(The order of the software start-up is important for supporting the TCP Server) 
 
4.        Install IPS Software – See the IPS installation guide. 

5.        Launch IPS from desktop icon  
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6.        Verify that an IPS security key was found, there should be a valid serial number on 

the startup screen or in the about box under the help menu. 
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7.        Open the IPS Inputs Menu->System Input->Ship and Target dialog box and 
select the BATS radio button in the ORE data group box. The IPS software will 
automatically start receiving data via UDP broadcast from TM (port 50002) and 
also start using the ORE time tag. Then select the required GGA input from the 
Ship's Position Input group box. 

 
 

8.        Select the IPS Setup Menu->Time Options dialog box and check Auto GPS Time 
Sync. 
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9.        If only receiving GGA NMEA formatted strings, check “Time Sync From GGA String” 

and be sure that the PC date and time zone are set correctly. 
 

 
 
10.        Select the IPS Ship and USBL offsets in Setup->Equipment Offsets->Ship Offsets.  

 
Note: Click [Apply] for each section 
 
Note: If using $POREG output from Trackman all offsets must be set in the IPS 
(Appendix A). 

 
Support Vessel (CRP = Center of Roll/Pitch of the support vessel) 

•        Ship: LOA and Beam 
•        GPS: GPS X,Y,Z location with respect to CRP 
•        Reference: Ref X (+ to Stbd of CRP), Ref Y (+ fwd of CRP, 

towards the Bowl) 
•        Hydrophone (Warning Only set the Hydrophone offsets 

in one location, either in IPS or in Trackman but not in 
both): 

o        Hx (+to Stbd of CRP),  Hy (+ Fwd of CRP),  Hz = 
(+below CRP) 

o        Hydrophone heading, roll, pitch bias = 0 (before 
calibration) 

•        Ctr Roll Pitch: Center of Roll/Pitch X,Y,Z 
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Example of the GPS and Reference Offsets Pages 

 
 
11.        Verify that valid ship (GPS) data is being collected and displayed. 
12.        Verify that the Firewall is disabled or the PC has access to TrackMan 

IP/port (50002). 
13.        Launch the TrackMan (TM) from the desktop or Windows Start->main 

menu.      
14.        The BATS status window should be displayed, indicating that the system boot-up 

is good, click [close]. 
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Note:  the S/N on the hydrophone and filter board should match the number displayed 
in the status window. 

 
 

 
 
15.        On the TrackMan, Select “Device List” double click on Remote Interface row 7 

(figure 2). 50002 for port number broadcast. 
 

 
 

16.    Toggle the “Use Checksum”, this actually enables the port for USBL pass through 
commands (Output format $PORG). UDP Broadcast 
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Set Beacons see Trackman software 
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System Interfacing 
 
To allow the integration of a BATS with GPS, the PC system will require an ethernet 
connection (local area network) if a Serial Multiplexer is used, otherwise at least two serial 
ports are required.  If only one port is used it could be linked to the Noland Engineering 
N183-41 Serial Multiplexer.  The Serial Multiplexer provides four NMEA standard listener 
ports ( IN1B, INIA, IN2B, IN2A, IN3B, IN3A, IN4B, IN4A ).  One Serial Multiplexer listener 
port is linked to the BATS system.  The output from the BATS system to the Noland Serial 
Multiplexer needs to have the serial cable configured for no handshaking.  
 
The second Serial Multiplexer listener port is linked directly to a GPS receiver.  Since the 
Serial Multiplexer provides four listener ports a depth sounder may be connected to one of 
the remaining listener ports.  The Serial Multiplexers RS-232 output ( RX, COM and TX) 
must be connected to the host PC system using a DB-9 cable supplied with the Serial 
Multiplexer.  The Serial Multiplexer will supply the PC with the relative position and current 
latitude/longitude of the support vessel using information from the EdgeTech USBL  and the 
GPS receiver.  Vessel heading information, derived from a flux-gate or gyro compass, can 
be supplied via the BATS system or the GPS receiver. For further information regarding the 
interfacing and setup of the Serial Multiplexer, see the Noland Engineering N183-41 manual. 
 
If the IPS is to be used in "ship only" mode with no input from a tracking system or if the 
tracking system is to be referenced to a fixed lat/long position rather than a GPS derived 
position, then only one device needs to be connected to the serial multiplexer. 
 
 
 

 
 
Note: The Lantronix UDS-200 can be replaced with either RS-232 to ethernet or RS-232 
MUX (e.g. Noland) or multiport (2-min) RS-232 to USB Hub converters. 
 
Note:RS-232 is the typical cable configuration when a handshake is not required. 
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Compass 
 
The Ship's heading information can be obtained from either a gyrocompass, flux gate 
compass, Attitude Heading Reference System (AHRS) or a "GPS Gyro".  Three methods are 
available for the IPS software to receive the compass information: 
 

 
1.  Compass input is through the GPS receiver as an NMEA string and transmitted to the 

IPS software in the NMEA string VHW.  The manufacturer's operations manuals for 
both the compass and GPS receiver should be consulted to verify the equipment's 
ability to handle the appropriate NMEA data strings, and also for the required interface 
cabling. 

 
 

2.  An alternative means of compass input to the IPS program would be to use any of the 
following NMEA data strings: HDM,HDT,HDG or TSS HHRP2 format into the PC directly 
via a free PC serial port, USB RS232 hub or a serial multiplexer.  See the following 
sections for more information on serial multiplexers. TECHNICAL SUPPORT CONTACTS 
and SYSTEM INTERFACING.  

 
 
3.  Ethernet (UDP) when using the CodaOctopus F-180 GPS positioning and referencing 

system. 
 
 
 
A variety of converters are also available to interface the synchro or digital output of a 
ship's gyro compass with into a PC.  For further information regarding these products, 
please contact ORE International. 
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Horita SCT-50 Serial Control Titler 
 
Requirements/Configuration: 
 
 
1.     SCT-50 (firmware version SCT330). 
 
2.     The IPS will broadcast ID 00, to all available SCT-50 units. 
 
3.     The IPS serial port must be set to match the SCT-50 baud rate (default 9600, [4800 

or 38400]. See IPS menu SETUP->Communications. 
 
4.    IPS configures the text in white over a black background. 
 
5.    IPS configures the SCT-50 real time clock to a 24 hour format hh:mm:ss. 
 
6.    The user must specify the priority target id, See IPS menu SETUP->Serial Out 

Command. 
 
7.    The target latitude and depth are displayed on the top line (top of video display). The 

units of the target depth with be meters if the IPS system units are set to meters units 
otherwise the depth units will be in feet.  See VIEW->Display Settings ->System. 

 
8.     The target longitude and the SCT-50 real time clock are displayed directly below the 

target latitude and depth. 
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Hardware Key 
 
A hardware key must be used with the IPS software for the IPS to process new tracking 
data.  The IPS USB hardware key is supported on all USB ports.   
 
 

 
Figure 1.        IPS USB Security Key 
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Operation 
 
Ship Position Box 
 
The Ship Position Box displayed in the upper right hand portion of the screen displays the 
name, latitude, longitude, depth, horizontal range, error codes, bearing and other 
information for the ship.  The entire list of parameters that may be displayed in the position 
box is given below.  The user may set which if any parameters will be displayed in the 
position box using the INPUT -> Ship Settings menu option.  In the Target Settings dialog 
box click the position box items tab and check the position box items that should be 
displayed.  If the most recent ships position received was an error then a question mark will 
be displayed instead of the number of satellites used to determine the ships position.  
 
The ship position box may be moved to a more convenient location by dragging the box 
with the mouse.  The position box can be expanded by dragging the borders of the box.   
 
The following table lists the text displayed in the ship position box and their descriptions: 
 

Time: Current system time To synchronize the IPS time with the GPS use the 
SETUP->Time Sync menu command. Uses         NMEA data from ZDA format. 

Latitude:   Latitude of current fix in N or S in ##:##.#### format. from GPS (data string 
GGA). 

Longitude: Longitude of current fix in E or W in ###:##.#### format. from GPS (data string 
GGA). 

UTM: UTM Eastings and Northings. 
Compass Depth:  Ship's heading and Depth if available. Heading data from NMEA strings HDT, HDG, 

HDM, VHW. Depth from NMEA data DBT. 
Roll Pitch:   Ship's roll and pitch if available.  From TSS-1 format. 
COG\SOG:          Current Course and Speed over ground (COG/SOG). Data from GPS NMEA data 

string VTG. 
Status: 1. The number of satellites used to determine the GPS position (From GPS data 

string GGA). 
 
2. The GPS tracking status: 
       ?-  Fix not available or invalid 
       ' '- C/A Standard GPS SPS mode fix valid 
       D- DGPS, SPS mode fix valid 
       P- PPS mode fix valid 
       R- RTK Fixed 
       F- RTK float 
       I-  Free inertial 
 
3. V or H DOP 0-99.9 (H- Horizontal dilution of precision). 
 
4. DGPS beacon correction age [sec].  Time in seconds since last SC104 type 1 or 

9 update. 
 
5. DGPS beacon reference station id. 
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Target Position Box 
 
The Target Position Box is initially displayed in the center of the viewing screen when target 
data is first received for the corresponding target. The target box displays parameters such 
as   the name, latitude, longitude, depth, horizontal range, error codes and bearing of the 
target.   The entire list of parameters that may be displayed in the position box is given 
below.  One target box will be displayed for each target for which data is received.  The 
target position box may be moved to a more convenient location by dragging the box with 
the mouse.  The target position box can be expanded by dragging the borders of the 
box.  The user may set which if any parameters will be displayed in the position box using 
the INPUT -> Target Settings menu option.  In the Target Settings dialog box click the 
position box items tab and check the position box items that should be displayed. If the 
most recent ORE System position was an error, then the time elapsed since the last valid fix 
will be displayed instead of the target name. 
 
The type of filter used for a target will be displayed after the target name in the target 
position box in the lower right hand corner of the screen.  For example if raw data is being 
used for target number one Fish, then only Fish will be displayed as the target name in the 
target position box.  If the velocity filter and on-site filter are set to on then Fish FVO will be 
displayed as the target name.  If the target name exceeds 16 characters then the last 4 
characters of the target name will be truncated to make room for the filter information if 
necessary.  The Max-Range, Min-Depth and Max-Depth settings will not appear after the 
target name as they are not specific for each target.  For more information see the Filter 
Command section of this manual. 
 
The entire list of parameters that may be displayed in the position box is given below: 
 
Time: Current DOS time. 
Latitude:     Latitude of current fix in N or S in ##:##.#### format. 
Longitude:   Longitude of current fix in E or W in ###:##.#### format. 
UTM:  Eastings and Northings. 
Compass Depth: Targets's Depth 
Roll Pitch: Compass heading roll and pitch. 
COG\SOG: Current COG\SOG of the current fix. 
Status: The number of satellites used to determine the GPS position. 
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Waypoint Icon Box 
 
The Waypoint Icon Box is the small square with the red W in it that is always displayed in 
the bottom right of the screen.  Clicking this window adds a waypoint at the end of the 
waypoint list whose position corresponds to current position of the focus target.  After the 
waypoint has been added to the waypoint list, the Waypoint List window will be activated 
and the position information corresponding to the new waypoint will be displayed in the 
Waypoint List windows edit boxes. 
 
The Waypoint Icon Box also works when the IPS is in search mode.  Use the VIEW -> 
Search Mode menu command to activate the search mode.  Once Search mode is activated, 
use the right mouse button to select a data point.  The up and down arrow keys may also 
be used to step through the data points one at a time when in search mode.  The data point 
that is selected when the Waypoint Icon Box is clicked will be added to the waypoint list. 
 
Waypoints may also be added in the Waypoint list window and using the right mouse button 
in the chart/map portion of the screen if the VIEW -> Cursor Waypoint Activated menu 
command has been selected. 
 
Also See: 
 
Display Search Mode 
 
Display Waypoint Box Command  
 
Waypoint List Window 
 
Cursor WayPoint Activated 
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Waypoint List Window 
 
The waypoint dialog box allows the user to enter, edit and delete waypoint positions.  Up to 
forty-five waypoints may be used when running a sailplan.  The Waypoint List window may 
be used to navigate to a single waypoint, center on a selected waypoint, skip a selected 
waypoint and stop the current sailplan.  To display the waypoint box click the red W on the 
right side of the toolbar or use the VIEW drop down menu to select the Show Waypoint Box 
Command.  The waypoint dialog box has a waypoint entry page and a display settings page.  Each 
page is represented by a tab. To move from page to page click the appropriate tab. The two pages are as 
follows: 
 
Waypoint Entry: 
 
If a sailplan is currently active then existing waypoints may not be altered or deleted.  If 
the user attempts to delete, replace or edit a waypoint while a sailplan is running, an IPS 
error message will be displayed. 
 
The Waypoint box is composed of edit boxes for entering the latitude, longitude, memo, 
depth and time for each waypoint, a list of existing waypoints and twelve push buttons.  To 
select options in the Waypoint List window use the mouse or the tab key.  To scroll through 
the list of existing waypoints use the mouse or the arrow keys.  The highlighted waypoint is 
considered the selected waypoint.  The information corresponding to this waypoint appears 
in the latitude, longitude, memo depth and time edit boxes.  To add, delete or edit 
waypoints use the appropriate push buttons.  
 
The user may manually enter the time and depth for each waypoint if desired.  However, 
the IPS program will automatically set the waypoint time to the current time.   If a time is 
entered manually, the following message 'Use Edit Box Time Instead of Current Computer 
Time?' will be displayed.  Click the enter key or press enter to use the manually entered 
time.   The depth entered must be between 0 and 16404 feet (0 to 5000 meters).  To view 
the time and depth of a waypoint that was just entered, use the arrow keys or mouse to 
select the waypoint, and the time and depth of the waypoint will be displayed in the Time 
and depth edit box. 
 
Waypoints may also be added by using the Target Waypoint (T w) toolbar button, which is 
next to the Waypoint toolbar button.  Clicking the Target Waypoint icon box adds a new 
waypoint whose position corresponds to the current position of the focus target. 
 
 
Entering New Waypoints: 
 
When entering a new waypoint manually as opposed to using the Target Waypoint Icon or 
the Cursor Waypoint Activated function, the waypoint must be in a specific format to be 
accepted.  The acceptable formats are given below: 
 
Latitude:        N or S     Degrees: 0 to 90     Minutes:  0 to 60    Fractional Minutes: 0 to 
9999 
Longitude:     E or W     Degrees: 0 to 180   Minutes:  0 to 60    Fractional Minutes: 0 to 
9999 
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If a waypoint field is not entered correctly an error message will be displayed and an 
acceptable entry must be made in the field before the user can edit another field.  However, 
the cancel button may be used to exit the dialog box at any time. 
 
The maximum memo length is thirty.  The arrow, home, end and delete keys may be used 
when editing and viewing entries in the memo box.  You may use the Ctrl Ins key 
combination to copy a memo, and use the Shift Ins key combination to paste a memo. 
 
Push Button Functions: 
Load Wpt File: 
Pops up a file open dialog box that allows the user to loads a  previously saved *_WPT.DB 
file into the current IPS session.  The waypoints may then be used in a sailplan or 
edited.  If waypoints already exit, the file waypoints may be appended to the existing 
waypoints or the existing waypoints may be cleared and over written.  If a sailplan is 
running it must be exited before the waypoint file is loaded. 
GOTO: 
The Goto push button starts a sailplan and navigates to a selected waypoint.  The ship or 
target in the focus box will be used for the sailplan.  To select a waypoint scroll through the 
list of existing waypoints using the mouse or the arrow keys.  The waypoint that is currently 
highlighted is considered to be selected. 
Insert: 
Puts a new waypoint above the selected waypoint.  Highlight the way point you want to 
appear directly below the new waypoint.  Enter the new waypoints latitude, longitude and 
memo (optional) and click the Insert push button.  When the new waypoint is added to the 
list a number representing the waypoints position in the waypoint list will be displayed in 
the viewing grid (if the waypoint coordinates are in the viewing grid). 
Delete: 
To delete a waypoint select it using the mouse or arrow keys, then click the Delete 
push button. 
Copy: 
Copies an existing waypoint.  First select the waypoint to be copied then click the Copy 
push button. Then use the Paste push button to fill the waypoint edit boxes with the 
information from the waypoint that was just copied.  The waypoint may then be added to 
the waypoint list using the Add, Insert or Replace push buttons.  The waypoint will also be 
copied to the windows clipboard.  Therefore if you use the Copy push button to copy a 
waypoint, you may paste it into most other windows applications (i.e. Word, Excel or 
Notepad) provided the waypoint was the last item copied. 
Paste: 
Pastes the most recently copied waypoint into the edit boxes above the waypoint list.  The 
waypoint may then be added to the waypoint list using the Add, Insert or Replace push 
buttons.  
Rep: 
Replaces the selected waypoint with information entered in the latitude, longitude, memo, 
time and depth edit boxes.   The IPS program will automatically set the waypoint time to 
the current time if   If a time is not entered manually. This is useful when editing existing 
waypoints.  To edit an existing waypoint select the waypoint using the mouse or arrow 
key.  The waypoints latitude, longitude, memo, time and depth will appear in the edit 
boxes.  Edit the waypoint information as required and click the Replace push button to 
replace the old waypoint with the edited waypoint. 
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New: 
The New button adds a new waypoint to the end of the waypoint list.  To add a new 
waypoint enter the latitude and longitude of the waypoint in the edit boxes provided.  An 
optional memo may be entered in the memo edit box.  The user may manually enter the 
time and depth of the waypoint if desired.  However, the IPS program will automatically set 
the waypoint time to the current time.   If a time is entered manually, the following 
message 'Use Edit Box Time Instead of Current Computer Time?' will be displayed.  Click 
the enter key or press enter to use the manually entered time.   The depth entered must be 
between 0 and 16404 feet (0 to 5000 meters).  Click the New push button to add the 
waypoint to the end of the waypoint list.  When the new waypoint is added to the list a 
number representing the waypoints position in the waypoint list will be displayed in the 
viewing grid (if the waypoint coordinates are in the viewing grid). 
Mark: 
Converts the selected waypoint to a marker.  To make a waypoint a Marker select the 
waypoint then click the Mark push button.  The waypoint will no longer be used for plotting 
routes but will still be displayed on the screen and will remain in the waypoint list. 
Skip: 
To Skip the waypoint displayed in the sailplan window, click the Skip button.  This feature is 
only allowed if a sailplan is running. 
RXTE: 
Redraws and resets the cross track error lines based on the current ship or target 
position.  This feature may only be used if a sailplan is running. 
Ctr: 
Centers the viewing grid on the selected waypoint.  If the grid does not remained centered 
on the selected waypoint make sure that the neither the ship or targets are set to auto 
center.  Please see INPUT -> Target Settings Command and INPUT -> Ship Settings 
Command 
for more information on centering the ship or targets.   Not currently operational. 
Stop: 
The Stop push button will disable the currently running sailplan, if one is running.  A 
sailplan may also be disabled by closing the Sailplan Window or un checking the run check 
box in the SETUP -> WAYPOINT MENU dialog box. The existing waypoints may not be 
altered or deleted if a sail plan is currently active.  New waypoints may be added to the end 
of the waypoint list if a sailplan is currently active, but the sailplan must be restarted in the 
WAYPOINT dialog box for the new waypoint to be included in the sailplan. 
 
 
Display Settings: 
 
To access this section of the dialog box, at least one waypoint must already be 
entered.  Waypoints may be entered manually using the Wpt Entry page of this dialog box 
or the Target Fix toolbar button.  The waypoint that is selected (highlighted) in the Wpt 
Entry page is the waypoint the following parameters will be applied to.  The apply button 
must be used to apply the settings listed below to the selected waypoint. 
 
Label Alignment: 
Sets the position of the waypoint screen label in relation to the waypoint.  The options are 
Lower Right, Middle Right, Upper Right, Lower Left, Middle Left and Upper Left.  The IPS 
default is Middle Right.  To select  a different label alignment click the arrow button on the 
right side of the combo box.  A drop down box displaying the label alignment options will 
appear.  Make a selection  using the mouse or the arrow keys.  
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Label Font Size: 
Sets the font size of the waypoint screen label in relation to the waypoint.  The options are 
12, 14, 16, 18, 20, 24, 28, 32 and 36.  The IPS default is 12.   To select  a different font 
size click the arrow button on the right side of the combo box.  A drop down box displaying 
the font size options will appear.  Make a selection  using the mouse or the arrow keys.  
Range Ring Size: 
Sets the radius of the waypoint range ring in system units.  This feature is not currently 
operational. 
Range Ring Color: 
Sets the color of the waypoint range ring.  When the Range Ring Color button is pressed, 
the IPS Color Set dialog box will appear.   Select  the color you want using the mouse, tab 
or arrow keys and press the OK button to set the waypoint Range Ring color.  This feature 
is not currently operational.   
Label Color: 
Sets the color of the waypoint label.  When the Label Color button is pressed, the IPS Color 
Set dialog box will appear.   Select  the color you want using the mouse, tab or arrow keys 
and press the OK button to set the waypoint label color.    
Include in Sailplan:  
This feature is not yet operational. 
Send Wpt as RPDA: 
Sends the Waypoint data out as an RPDA message.  This feature is not yet operational. 
Display Txt on Screen:  
Toggles the display of the waypoint label.  If the box is checked the waypoint label will be 
displayed.  The IPS default is checked, display the waypoint label. 
WPT Screen Label: 
Allows the user to enter a waypoint label of up to 29 characters that will be associated with 
the waypoint selected in the Wpt entry page.  The position, font size, color and whether the 
waypoint label will be displayed can be set using the parameters described above. 
Apply:  
Applies the waypoint parameters set above to the waypoint selected in the Wpt Entry page. 
 
 
Also See: 
 
Display Waypoint Box Command 
 
Waypoint Icon Box 
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Focus Icon Box 
 
The Focus Icon Button is the toolbar button that displays either a ship or target 
icon.  Clicking the focus icon button allows the user to switch the focus from one target or 
ship to another.  Only targets which are being tracked have their icons displayed on the 
focus button.  The target currently displayed in the focus button is the target that will be 
used in search, by the Waypoint Icon Box and when the home key is used to center a 
target. 
 
 
Also See: 
 
Waypoint Icon Box 
 
Search 
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Home Key 
 
Pressing the home key places the target currently displayed in the Focus Icon Box in the 
center the viewing area.  



Integrated Positioning System Version 7.7.1.10 39 

Creative Underwater Technologies Copyright 1992-2019 

Automatic Identification System (AIS) 
 
 

 
 Example of AIS Display Information 

 and Tracking for a Ship 
 
 
 
The IPS will display Automatic Identification System (AIS) data when  AIS(!AIVDM string) input 
is detected as serial or UDP data through an Ethernet packet. Double click on the green 
triangular shape to display information about a specific vessel in a text box. The information 
includes name, classification, call sign, course and speed, registration number, MMSI, and 
additional data if available. To stop AIS display click the AIS toolbar button to display the AIS 
dialog box and uncheck the AIS Displayed Enabled check box.  
 
The IPS will also automatically display Aids To Navigation data (AToN) data when valid AToN 
data is received through an !AIVDM string. To stop AToN display click the AIS toolbar button to 
display the AIS dialog box and uncheck the Process AToN check box. 
 
If valid AIS or AToN data is received it will automatically be displayed and the AIS toolbar icon 
will change from grey to light blue. 
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Note: The AIS and AToN features should be used in combination with a navigation chart. 
Please see the Menu->Chart-> Chart Open section of the IPS manual.  
 
The following AIS settings are available in the AIS dialog which is displayed when he AIS 
toolbar icon is clicked: 
 
Set AIS CPA: 
Sets AIS closest point of approach. When another vessel's path would lead to a CPA that is less 
than the CPA set by the user, the triangular shape representing that vessel turns red. The 
minimum AIS CPA is 0.25 nm and the maximum AIS CPA is 20.00 nm. The default is 2.00 nm. 
 
Set AIS No Activity Time Out: 
Sets the time required for a vessel to be removed from the display due to no data updates 
concerning that vessel. The minimum AIS No Activity Time Out is 5 minutes and the maximum 
No Activity Time Out is 20.00 minutes. The default is 15 minutes. 
 
Zoom to AIS Extent: 
Will zoom to display all current AIS targets. To zoom back in click the zoom in button on the 
toolbar. This feature does not work with the AToN data. 
 
 

 
Example of AIS Display Information and tracking for an Aids To Navigation (Buoy) and 
Ship. The IPS marks the Aid To Navigation with a magenta circle and the initials AIS.  

The AtoN and the unnamed vessel are circled in red.  
 

  
IPS AToN Marker 
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AToN Display Enabled: 
Aids To Navigation data (AToN) will be displayed automatically when valid AToN data is 
received through an !AIVDM string. Double click on a buoy shape to display a text box with 
information about that buoy including the MMSI number, name, type, position, position accuracy 
and update time. The default is on. 
 
AIS Displayed Enabled: 
AIS data will be displayed automatically when valid AIS data is received. Double click on a the 
green triangular shape to display a text box with information about that ship including the MMSI 
number, classification, call sign, course and speed, registration number, name, type, position, 
position accuracy and update time. The default is on. 
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Search 
 
The search mode allows the user to search through the currently displayed or any loaded 
data file.  The search mode can also be used to save selected data points to a file.  See the 
section below for more information.  The data points that are displayed in Search mode can 
be used whether the currently active mode is SHIP or TARGET.  The Search Position window 
will initially be displayed in the center of the screen.  The information displayed is set in the 
Search Data Settings Dialog Box.  The information that can be displayed about the selected 
data point includes: ship name or targets name, the targets latitude, the targets latitude, 
the targets depth or compass position and the time the data point was acquired. 
 
To activate the search mode follow the steps listed below: 
 
 
1.     Use the focus button in the Tool Bar at the top of the screen the screen to select the 

target or ship whose data will be searched (the focus button will display a picture of 
either the ship or a target.).  If you change the focus during a search session, the 
change will not be reflected in the current search session. 

 
        Note: The Display Mode must be Chart or Grid for the Search Mode menu item to be 

enabled.  Please see the VIEW  -> Display Settings sections of this manual for 
more information. 

 
2.      Open the VIEW drop down menu and select SEARCH MODE.  If Search Mode is 

activated a check mark will be displayed to the left of the menu item.  Please see the 
VIEW-> Display Search Mode section of this manual for more information on this 
menu item. 

 
3.       Once Search mode is activated, use the right mouse button to select a data point.  If 

the right mouse button is clicked and a valid data point is within 48 miles, the data 
points position information will be displayed in the Search Position information 
window. 

 
4.      The Search Position Box tool bar allows the user to navigate the selected ship or 

target    position data.  The Search Position Box tool bar buttons are as follows: 
 

 Start, moves to the start of the data base, with respect to time. 
 

 Previous, steps backward through the data base (time history), one 
data point at a time. 
 

 Jumps backward in time through the data base ten points at a time. 
 

 Next, steps forward through the data base one point at a time. 
 

 Fast forward through the data base ten points at a time. 
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 End, moves to the end of the data base, with respect to time. 
 

 Start Marker, marks the selected data point as the start of a group of 
data points.  The selected data point will be marked with a letter 'A'.  The 
group of data points may then be used for operations such as USBL 
calibration.  To select a data point use the Start, Previous, Next or End 
buttons described above. 
 

 End Marker, marks the selected data point as the end of a group of 
data points.  The selected data point will be marked with a letter 'B'. 
 

 Save As, a Save As Dialog Box will appear allowing the user to save 
the selected data points (A to B) to a specified disk file in IPS format.  Please 
see the FILE -> File Save As Command section of this manual for more 
information.  Use the Start Marker and End Marker push buttons described 
above to select the group of data points to be saved. 
 

 Deletes the selected data point.  To select a data point use the Start, 
Previous, Next or End buttons described above. 
 

 Adds a waypoint using the latitude and longitude of the selected 
point.  The number of the new waypoint will be displayed in red on the 
grid.  If the Waypoint Box is currently being displayed, the new waypoint's 
latitude and longitude will be displayed in the latitude and longitude edit 
boxes in the waypoint box.  The latitude and longitude may be edited at this 
time and a memo may be added if desired. 
 

 A system calibration is completed using search data from Start Marker 
A to End Marker B.  There must be at least 10 data points between the start 
and stop markers.  Please see the VIEW -> System Calibration section of this 
manual for more information. 
 

 Allows the user to search for a data point by data and time.  Enter the 
date and time in the edit boxes provided and the corresponding data point 
information will be displayed in Search box. 
 

 Displays the Search Track Details box. 
 
In addition, the following keys are available for searching the data 
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points.  The Search Position Window must have focus for these keys to be 
used in a search session. 
 
 
 
[Down Arrow]        Down arrow, will step backward through the data base 

(time history), one data point at a time. 
[Up Arrow]             Up arrow, will step forward through the data base one 
point at a time. 
[PgDn]                   Move to the start of the data base, with respect to 
time. 
[PgUp]                   Move to the end of the data base, with respect to time. 
 

5.       To exit the search session, open the VIEW drop down menu and select SEARCH 
MODE.  If SEARCH MODE is disabled, the check will not be displayed to the left of 
the menu item.  Another way to end the search session is to close the Search 
Position window.  
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Data Subset 
 
Load the *.tdbt file. 

 
1. To see what targets are available use View->Mission Statistics. Expand the Mission 
Statistics window to view all of the targets (Ship ID = 10). Note times 07:59 to 11:31 
and number of samples (Target-1 2232 pts, Target-2 2209) 

 
2. To see all of the display data points use the Focus toolbar icon to cycle through the 
targets (including the ship). Right click in the plot area and select INPUTS->Target 
settings to adjust the number of pts being displayed. 
 
3. Activate search mode (View-> Search Mode) for the target of interest. 
 
4. Use the Search Mode Flashlight icon to set the START time for a sub-set of the data to 
be saved (e.g. 09:00-10:00). The triangle search icon will jump to the nearest target 
point corresponding to that time (e.g. Target-1 8:59:56.750). Then click on the Search 
tool bar START icon to mark the beginning of the data subset you want. 
 
5. Use the Search Mode Flashlight icon to set the END time for a sub-set of the data to 
be saved (e.g. 09:00-10:00). The triangle search icon will jump to the nearest target 
point corresponding to that time (e.g. Traget-1 8:59:56.750). Then click on the Search 
tool bar END icon to mark the end of the data subset you want. 
 
6. To save out the selected sub-section of the data click on the Search tool bar 
"File-Disk" icon and choose the folder of interest. Name you sub-set of data (e.g. 
"SubSet 0900-1000_trk"). 
 
7. Upon completing export of all required sub data sets exit the IPS. 
 
8. To Export the subsets of data into text or GIS data formats Launch the IPS and open 
the subset file you just created. 
 
9. Use File->Export Data->Text to create a new file from the subset file. 
 
10. For example to Export Target Position and Depth in TPD format: 
       Click the TPD radio button. 
       For raw data select "Raw Data". 
       Select desired time format (e.g. HH:MM:SS.ss). 
       For JUST Target data (to exclude ship data) click "Target Data Only". 
       Click [Ok]. 
       Enter a file name- and save. 
 
11. The text file will be saved in folder the IPS data was load in from. 

 
Example of exported data: 
$IPTPD,01,4134.3697,N,07054.4133,W,001.0,M, 9:00:27.11,T,R 
$IPTPD,02,4134.3924,N,07055.3026,W,001.0,M, 9:00:37.69,T,R 
$IPTPD,01,4134.8754,N,07054.6082,W,001.0,M, 9:00:57.94,T,R 
$IPTPD,01,4134.4916,N,07054.3268,W,001.0,M, 9:01:02.85,T,R 
$IPTPD,02,4134.9296,N,07054.5675,W,001.0,M, 9:01:13.00,T,R 
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Remote IPS Display 
 
The remote display feature of the IPS requires one IPS session (PC) to act as a master or 
server providing the raw tracking data that may be displayed by any number of PCs (remote 
hosts) running the IPS in Remote Display mode.  The remote display data is transmitted via 
standard Ethernet using UDP (datagram) communications. 

Note: An IPS hardware Security key is required on the 
Master Station side only!  

 
Master Station Configuration: 
 
1.        IPS Main Menu -> Settings -> Ethernet Configuration 
 

 
 
2.        Enter a Local Port number of zero ‘0’. Setting it to 0 enables the TCP/IP stack to 

choose a port at random. Otherwise, a port number above 2000 is suggested as 
port numbers 1 to approximately 2000 are reserved. 

3.        Click (select) the Transmit IPS Data option. 
4.        Enter a Remote Port number. The Remote Port is the UDP port on the Remote 

Host where UDP datagrams will be sent.  A valid port number (a value between 
1 and 65535) is required.  

Note:  This is the Remote Port number that will be entered in the “Remote Display” PC’s 
IPS Ethernet Configuration dialog box Local Port field. 
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5.           Enter the IP address of the Remote Host. The Remote Host property specifies the 
IP address (IP number in dotted internet format) of the remote host. If Remote 
Host is set to 255.255.255.255, the IPS will broadcast the data on the local 
subnet. 

6.            Testing Ethernet Configuration. In order to test the communications link 
without the availability of real time tracking data (GPS / ORE USBL inputs) the 
Master station may be configured to “Demo/Replay” mode using the Input-> 
System Inputs dialog box and selecting “Demo/Reply” mode as Ships’s Position 
Input. Then under the File menu select “Open” and choose any previously 
generated IPS tracking file *_Raw.DB to simulate the availability of real time 
data. 

Note:     An IPS hardware Security key is required on the Master Station side even if the 
master station is running in Demo/Replay mode. 

 
Remote Display (Host) Configuration: 
 
1.           IPS Main Menu -> Settings-> Ethernet Configuration: 
 

 
 
2.           Enter the number that was used as the Master “Remote Port” in the Local Port 

field. In this example a “Local Port” number of 14520 is required because 
that number was used as the master remote port number. 

3.           Check the option “Receive Data”. 
4.           The settings for the “Remote” section are optional and are only required to 

support bi directional communications back to the Master station. 
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5.           To display the data use the IPS Main Menu -> Inputs-> System Inputs -> Ship 

and Target tab. Select the following options: “Remote Display (UDP Data)” 
under the Ship’s Position Input section. 
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IPS 3D Sensor Processing 
 
The IPS 3D sensor processing supports three basic functions: 
 

Display of 3D data sets from ASCII (.dat) files in UTM (Northing, 
Easting and depth format) or in latitude, longitude and depth (.txt).  An example 
of a UTM text file is: 

 
Date (yyyy-mm-dd) HHMMSS.zzz, X-Northing, Y-Easting, Depth [m] 
 
2006-03-28 102721.607,10.602,-4.944,4.944 
2006-03-28 102721.707,10.631,-4.869,4.950 
2006-03-28 102721.807,10.659,-4.793,4.970 
2006-03-28 102721.907,10.687,-4.718,4.983 
Note:  Date-time data is used for 3D calibration and 3D data times may be shifted if 
required to match the appropriate navigation time tags using the time bias option. 
 

Conversion of 3D sensor data from local (sensor) coordinates to 
geodetic coordinates. 

 

3D sensor calibration using established Multibeam calibration Patch 
test methods.  

 
IPS 3D Data Display 
 
The IPS 3D data display allows a user to load ASCII X,Y,Z text files into a 3D display 
environment.  A concise pop up menu that is activated by right clicking on the 3D 
display window has the following options: Home, Center, Rotate, Zoom, Pan, Info, 
Make Wpt, Load File, Add Data File, Make VRML File, Save as BMP and Clear Plot. 
 
IPS 3D Calibration 
 
The IPS supports the calibration of 3D sensor data (x,y,z) using the standard 
Multibeam patch test method. That is the IPS solves for the three mounting angles of 
the 3D sensor with respect to the navigation coordinate system (Heading, Roll and 
Pitch). The patch test method starts with the user collecting the calibration data in 
three separate runs.  Each of the three calibration runs are designed to minimize the 
effect of the other two variables and maximize the error effect on the angular variable 
in question.  For example, to collect calibration data for determining the 3D sensor roll 
mounting angle (with respect to the navigation coordinate system) one would collect 
3D sensor data over a flat bottom either by running a down and back pattern over the 
same patch of flat bottom or by spinning the 3D sensor over a flat section of the sea 
floor (i.e. ROV).  The 3D data is then imported into the IPS as an ASCII text file in the 
following format in either UTM Northing, Easting, depth  or Latitude, Longitude and 
depth. 
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File Format: 
 
 

Date (yyyy-mm-dd) HHMMSS.zzz, X-Northing, Y-Easting, Depth [m] 
 
 
    2006-03-28 102721.607,10.602,-4.944,4.944 
     2006-03-28 102721.707,10.631,-4.869,4.950 
     2006-03-28 102721.807,10.659,-4.793,4.970 
 
 
 
 

The user then enters the initial estimate of the mounting angles and the sensor x,y,z 
offsets with respect to the platforms center of roll & pitch (CRP).   Next, if required, 
the user should enter a time bias to map or modify the 3D sensor data point time tag 
to match sync to the IPS navigation time (figure 1).  The user then clicks on the “3D 
calibration” option that pops-up another dialog box that allows the user to select the 
angle of interest, the maximum range that the mounting angle should be in and 
several other values as described below. The IPS will then process the data file in the 
following manner: 
 

1.   Open and read in the ASCII 3D sensor text file. 

2.   Assign the navigation data to the individual 3D data points using time tags and user 
specified time bias. 

3.   Step through the range of mounting angles for the variable in question (heading, roll 
or pitch) based upon the users initial mounting angle guess, angle error range and 
angle interval. The results of this process are displayed in the IPS calibration plot 
that shows the optimum mounting angle at the minimum of the plot. 

4.   The 3D data can then be displayed in the IPS 3D Viewer to visually verify that the 
new mounting angle improved the overall data quality. Figures 2 and 3 show the 
before and after 3D plots from a roll test. 
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5.  
Figure 1.    IPS 3D sensor calibration dialog boxes, graphical QC plot and 3D plot. 
        

 
Figure 2.  Side view of raw georeferenced roll calibration data displaying the effects of 

a roll bias between the navigation coordinate system and the 3D sensor. 

 
Figure 3.   Side view of the corrected georeferenced roll calibration data after the new 

roll mounting angle as determined by the IPS has been applied. 
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3D SONAR Calibration (Patch Test) Example 
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Integrated Positioning System Version 7.7.1.10 62 

Creative Underwater Technologies Copyright 1992-2019 

Calibration Procedures 
 
Equipment Offset Measurements 
 
Recommended Setup: 

 
USBL setup with GPS timing input string (reference: BATS manual 4450MA0250 RV A, 
section 3.3.4 “USBL GPS/Time Sync”). 
Omni directional transponder ready for shallow water calibrations. 
Transponder float collar with anchor and surface float or transponder stand (tripod) with 
surface float to maintain the transponder in roughly vertical position. 

 
Verify the Following Parameters: 

 
1.    Equipment offsets are relative to the vessel’s center of roll/pitch (CRP) and still 

waterline as the origin (0,0,0). 
Enter the required ship offsets into IPS (Setup->Equipment Offsets->Ship 
Offsets->Hydrophone): 
1.1.        Hydrophone X____________m (+ to Stbd, w.r.t CRP) 
1.2.        Hydrophone Y____________m (+ Fwd, w.r.t CRP) 
1.3.        Hydrophone Z____________m (+Down, below still waterline) 
1.4.        Set the Hydrophone heading, roll & pitch mounting angles to 0.0 deg 
Note: The hydrophone tip should be at least one meter below the keel. 
 

    Enter the required GPS offsets into 
     IPS (Setup->Equipment Offsets->Ship Offsets->Ship/GPS):  

1.5.        GPS X        ______m (+ to Stbd) 
1.6.        GPS Y______m (+ Fwd) 
1.7.        GPS Z        ______m (+Down, below still waterline) 
1.8.        D    ______________m (Distance from CRP To Geometric center) 
1.9.        The Reference position can be set to X,Y = 0 in Setup->Equipment 

Offsets->Ship Offsets->Hydrophone). 
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IPS Equipment Offsets Ship\GPS Dialog Box 

 
2.        Verify the forward hydrophone alignment mark is positioned forward (within +/- 20 

deg). 
2.1 Manual beacon depth _________ m (see item 2.2 in the Sheltered Water 
Calibration section below). 

 
 
 
 
Set the Following TrackMan Software Parameters: 
 
5.        Data Output format $POREG 
6.        Filtering 

6.1.        Filter Level 4 or 5 
6.2.        Detector Threshold MED-LOW to High   
6.3.        Averaging 0 points (çCritical) 
6.4.        [X] Quality Factor Filter (enable) 
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Sheltered Water Calibration 
 
IPS Requirements 
 

•        Hydrophone X,Y,Z offsets w.r.t CRP/still water line 
•        Correct sound velocity 
•        GPS input 
•        True ship’s heading 
•        Time sync’ed enabled in IPS 
•        USBL time sync’ed 
•        TM filtering set to average 0 points 
•        Hydrophone heading, roll & pitch mounting angles set to zero in TM 
•        Beacon deployed at a known depth with TM depth set to manual and “input” or the 

use of a depth telemetry beacon 
•        Collection of sufficient number of data samples (typically once every two seconds) 
•       Data is collected with good geometry, by following the suggested calibration 

pattern (figure X) at a maximum range of 3-5 time the   beacon depth 
 
Sheltered Water Calibration 

 
1.        Select site 

1.1.    On-site Sound Velocity Cast SV _________m/s  {-for shallow water, SV at 
hydrophone will be suffice). 

1.1.1.        Enter SV into Trackman & into IPS (Inputs->System 
Inputs->Offsets->ORE Sound Velocity). 

1.1.2.        If available enter in vessel’s depth sounder ___________m/sec. 
1.2.        Determine depth of beacon site using calibrated depth sounder. 

1.2.1.        Actual site Depth ___________m. 
2.    Ready transponder with surface float and weight for deployment at site of depth.  Set 

the actual line length for 10-20 ft more than the actual depth. 
2.1.        Set the beacon up to float or be positioned 1.0 meter above the bottom 

using beacon float collar or stand. 
2.2.        Beacon Depth ____________m. 

3.        Power on Beacon 
4.    Deploy the beacon at site and log actual deployment position (take a fix). 

Lat__________________             Long_________________ 
5.    Enter into the Navigation plot the waypoint for the calibration pattern (figure 1). 
6.    Center on beacon waypoint and zoom in to a grid scale such that the individual 

squares are about 3-5X the depth of the beacon.  For example, if the beacon is 
deployed at a depth of 50 meters zoom in so an individual squares are about 200 
meters.  The vertical size of a grid square is enclosed in brackets [  ] in the status bar 
at the bottom of IPS, as shown below: 

 
7.       Have the vessel slowly (2-3 knots) follow the calibration pattern (figure1) and 

collect two sets of data (into one file). 
8.        Run the USBL calibration routine (See procedure below). 
9.        Calibration Hydrophone Mounting angle Offsets: 

9.1.        Heading _______________ deg (+ CW – alignment mark rotated ” to 
Stbd”  ) 
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9.2.        Roll___________________ deg (+ Port side Up – Top of Hyd port side is Up) 
9.3.        Pitch__________________ deg (+Bow up – Hyd Fwd Top edge Up) 

10.        Enter Calibration Hydrophone Mounting angle Offsets into IPS as reported. 
11.        At main corners of calibration pattern verify tracking quality. 
 
 

 
Figure 1.        Suggested USBL calibration pattern. If possible, the vessel should not 

operate at a horizontal range greater than 5 times the depth of the beacon.  
 
After or in tandem with the sheltered water calibration the IPS Off-Line USBL Calibration 
Procedure should be run. 
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IPS Off-Line USBL Calibration Procedure 
 
1.        Verify IPS USB security key is installed. 
2.        Launch IPS. 
3.        Load collected calibration data using the (File->Open) menu command. 
4.        Set target focus to the ORE ID from menu toolbar. 

 
5.        From the Target Properties toolbar icon set the number of display points to 

500-1000. 
6.        Enable search mode (View-> Search mode). Note: the cursor will change from an 

arrow pointer to a Gun sight ¤. 
7.        Click on any calibration data point, then the search dialog box will pop up. 

 
8.        Jump to first data point and click to “Mark” the Start point. 
9.        Jump to the last data point and click to “Mark” the End point. 
10.        Start the USBL calibration which will generate the following: 

10.1.        The USBL Calibration dialog box, enter the required settings. 
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10.2.        Before and After Frequency plots. 
10.3.        A text file of the calibration results. 
10.4.        Display the IPS System Calibration dialog box. 
10.5.        Update the IPS nav plot with the corrected positions. 

11.        If the calibration was meaningful the Before and After frequency plots should 
show that the position of the beacon goes from broadly distributed positions to a 
very tight cluster as seen in the figures below:  
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1.  The IPS System Calibration dialog box with the results of the calibration will also be 
displayed and a PDF format report is also generated in the directory where the data for 
the calibration is locates. 
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Three Axis Magnetometer Calibration 
 
Creating a Magnetometer Calibration 
 

1. Launch the IPS with the USB security key. 

2. If you know the location of the magnetometer calibration create an IPS waypoint now 
for later use, see section 7.2 below. 

3. Select File->Export Sensor XYZ from the main menu. 

4. If required, and you are using the $PIMAG or SLD data format., you can specify the 
region of data to be processed. Set the “Time Bounds”, under the Data Bounds tab.  See 
below for examples of the data formats used. 

1. Check (enable) the “Use Time Bounds” and [Apply]. 

5. Under the “Process and Export” tab set the “Sensor File” to mag calibration data file in 
either the raw Honeywell HMR2300, HMR3000 (XDR) ASCII data formats, the $PIMAG 
formatted text or SLD *.csv file. 

6. Click on the [3-Axis Mag Cal] button. 

7. Enter in the total earth field Nanotesla [nT] for the specific Mag calibration site. 

1. Use your latitude and longitude or zip code to find the total earth field at the 
following website http://www.ngdc.noaa.gov/geomag-web/#igrfwmm.  

2. Or select an IPS waypoint near the calibration area, you may use the waypoint 
entered earlier. The IPS will automatically calculate the earth’s magnetic field using 
the Enhanced Magnetic Model (EMM) based on the waypoint latitude and longitude 
and the first data point’s UTC date-time at sea level. 

3. Or enter the default value of 50,000, however this may cause a small bias relative 
to Earth's actual magnetic field. 

8. The processed magnetometer calibration data should be represented as a single green 
line that overlaps the blue Earth field line.  If this is the case, click on the [Save 
calibration] button to generate a PDF calibration report including a calibration plot and a 
Mag calibration text file with the calibration coefficients. If you do not get a desirable 
result, try one of the following suggestions. If the points are scattered collecting more 
data may improve the calibration. If the line has a slope, this is usually caused by the 
temperature not being at a steady state, the magnetometer’s temperature must 
equilibrate to the temperature that you are calibrating in. This applies only to 
non-temperature compensated magnetometers. 

Magnetometer Output (Machine Readable) Text File Format: 

 
[TotalField]51508 
[Threshold]184 
[a11]0.915631199985504 
[a12]0.00729029969385857 
[a13]0.0137476726049316 
[a21]0.00729029969385852 
[a22]0.930359671865496 
[a23]-0.00217196119162317 
[a31]0.0137476726049316 
[a32]-0.0021719611916232 
[a33]0.930237010025602 
[b1]0.132084211077783 
[b2]0.046174601186279 
[b3]0.235802094970093 
[StdDev]0.000922 
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3-Axis Magnetometer Calibration Plot 
 

 
Figure 1. Example of a 3-axis magnetometer calibration plot showing the raw 

magnetometer data in red and the same magnetometer data processed using the 
magnetometer calibration coefficients in green. If the calibration is valid the green 
line should overlap the blue line that is the Earth’s total magnetic field at the 
calibration site in Gauss [G]. 

 
The calibration of the three axis magnetometer requires it to be moved in three dimensions, 
if possible through a variety of heading, roll and pitch positions in an area that is free of 
magnetic clutter (away from steel ships, commercial docks etc.) 
 
Example Magnetometer PDF report (Cal plot image not show below, see figure 1). 
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Georeferencing of Magnetometer data (IPS $PIMAG) 
 

1. With either valid real time data being collected or an IPS file loaded into IPS. 
 

2. Click on File->Export Data -> Sensor XYZ. 
 

3. Select the “Process Export” tab. 
 

4. Click on the Sensor File” of IPS Magnetometer file ($PIMAG or SLD). 
 

5. Click on “Support File” to set the corresponding magnetometer calibration file 
generated by the IPS (*.txt). 

 
6. Set the IPS target number. 

 
7. Click on button Georeferenced Local Sensor Data. 

 
Note: HMR3000 or HMR2300 data files can be converted from raw (uncompensated) to total 

field compensated using the same procedure as Georeferencing IPS $PIMAG or SLD 
data files. In this case no valid navigation data needs to be loaded into IPS. 

 
 
IPS File Formats Supported (using UTC time):  
 
If you are using a format currently not supported, contact EdgeTech and we will add the 
required format. 
 
$PIMAG,HHMMSS.sss,MM-dd-yyyy,x,y,z<CR><LF>  where X,Y,Z are in Gauss. For 
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Example: 
 
$PIMAG,180023.803,05-08-2014,0.209067,-0.189467,-0.373400 
 
Or 
 
Honeywell HMR-2300 ASCII format 28 bytes (fixed field) 
SN | X1 | X2 | CM | X3 | X4 | X5 | SP | SP | SN | Y1 | Y2 | CM | Y3 | Y4 | Y5 | SP | SP | SN 
| Z1 | Z2 | CM | Z3 | Z4 | Z5 | SP | SP |<cr><lf> 
 
Where, SN= negative sign or a space, CM-comma, SP-Space. For example: 
   4,079  - 1,250  - 5,539  
-      47        485  - 6,921  
 
Honeywell HMR-3000 ASCII format 
 
$HCXDR,A,37.8,D,PITCH,A,-45.0,D,ROLL,G,2696,,MAGX,G,8681,,MAGY,G,-3536,,MAGZ,G,9
754,,MAGT*1C 
 
Or 
wwww.RIEmbedded.com, SLD AHR 9Axis Orientation Logger (inexpensive MEMS 
device) 
Default ASCII format: 
 
SLD-AHR Default format settings (using UTC time): 

www.SimpleMEMS.com         
Battery Voltage        4.152 Volts 
Sample Rate (SR)        (256) Hz 
Timestamp Format (TSF)        (0) Absolute 
Accelerometer Status (AS)        (1) On 
Acceleration Format (AF)        (0) G's 
Accelerometer Full Scale (AFS)        (2) +/- 2 G's 
Magnetometer Status (MS)        (1) On 
Magnetic Field Format (MFF)        (0) Gauss 
Magnetic Field Gain (MFG)        (1300) milli-gauss 
Gyroscope Status (GS)        (1) On 
Angular Rate Format (ARF)        (0) DPS: Degrees per second 
Angular Rate Full Scale (ARFS)        (250000) milli-degrees per second/250 DPS 
 

Example SLD *.csv log file header and data 
 

Year        Month        Day        Hour        Minute        Second        Sub-Second        Acceleration-X (G's)        Acceleration-Y (G's)        Acceleration-Z (G's)        MagneticField-X 
(Gauss)        MagneticField-Y (Gauss)        MagneticField-Z (Gauss)        AngularRate-X (dps)        AngularRate-Y (dps)        AngularRate-Z (dps) 
2016        7        19        21        15        36        0        -0.987        0.067        0.003        -0.6536        -0.2364        -0.3051        2.7        2.4167        -7.8 
2016        7        19        21        15        36        0.0039        -0.99        0.064        0.004        -0.6491        -0.2373        -0.3061        2.2        2.8333        -8.275 
2016        7        19        21        15        36        0.0078        -0.986        0.064        0        -0.6491        -0.2373        -0.3061        1.6667        3.175        -8.5833 
2016        7        19        21        15        36        0.0117        -0.984        0.062        -0.005        -0.65        -0.2373        -0.3071        1.3583        3.1583        -8.7 
2016        7        19        21        15        36        0.0156        -0.975        0.057        -0.01        -0.65        -0.2373        -0.3071        1.525        2.975        -8.2917 
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3 Beam Operation 
 

Conversion of WinFrog USBL Text Files to IPS File Format 
 
Conversion of WinFrog USBL Text Files to IPS File Format (*_raw.db & *_trk.db) 
The WinFrog .dat text file should be in the following format: 
3,10-04-03 07:32:11.8,N33 58.3701,W119 36.7739,-60,3762221.14, 
258596.00,0.00,0.00,0.00,55.04,56.50,0.71,0.00,NONE,0.000,0.00,0.00,0.00,0.00,0.00,De
lta<CR><LF> 
Note: Only the date, time, latitude, longitude and depth data fields are imported (used); 
10-04-03 07:32:11.8,N33 58.3701,W119 36.7739,-60 
Conversion/Import Steps: 
 

1. File->Import WinFrog Text File. 
 

 
 
2.        Then choose a tracking ID not equal to the ID assigned or used for the DVL 

navigation. Typically the DVL target is set to an ID or 1 or 9, therefore the USBL ID 
could be set to 2 (ID = 2). 

 
 
3. Select the WinFrog .dat (text file) to be converted. 
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4. Click [open]. When the conversion is completed the following message box will pop up. 
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Merging DVL and USBL IPS Files 
 
Processing Steps: 
1.   File Merge DVL/USBL Nav Data. 

 
 
2.      Select the file name of the DVL navigation data file: 

 
 
3.        Select the IPS USBL navigation file. This could be data that was converted from a 

WinFrog .dat nav file that was converted to an IPS file, see Conversion of WinFrog 
USBL Text Files to IPS File Format. 
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4.        Enter the name of the new merge file. 

 
 
5.            When the settings dialog box pops up you can alter the raw DVL data and select 

how to fuse the DVL and USBL data.  A quick method to fuse the DVL and USBL 
navigation data is to select the "Shift DVL as Data Set" radio button in the 
"Merge USBL/DVL" group box. This routine will calculate the mean lat/long error 
between the DVL data set and the USBL data set and then apply the delta 
lat/long error terms to the DVL data set. (Note a USBL /DVL time bias could 
cause the data to not match correctly). Therefore, if the USBL time bias is know 
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it should be applied in order to ensure that the USBL position times accurately 
match the DVL position times.  Using the Kalman Filter method would solve drift 
over time method, but longer + complex. 
Note: The USBL time bias will be added to the USBL times. 
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6.           Select [OK] to start the process. As the processing is taking place the status 

may be monitored by viewing the IPS Message box. 
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Creating a 3Beam Data File 
 
Suggestion:     right click on the Windows menu bar and activate then shrink the Task 

Manger dialog box (now the icon should be on your menu tool bar). 
 
1. Load a merged or DVL navigation data file using the File->Open command. 

 
 

 
 
 
 
2. Click on the focus button to select the DVL target. DVL Targets are typically ID 1 (fish 

shape) or 9 (Sub shape). 
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                                                              Focus Button ______/\ 
 
3.   Click on the sub icon and select an appropriate target (e.g. target ID 1, Fish) set point 

color to a highly visible color like a light green and the track size to 2500 with a skip 
point of 1. 

 
4.  Enter search mode IPS Menu bar View -> Display Search Mode 

   
 
5.  Move cursor over any fish data point and click on it. The search dialog box will pop up. 
 
6.  Use Search dialog box tool bar icons to move to a start of a transect and click the start 

icon. 
 
 
7.   Then move to the end of the transect and click on the End icon. If IPS waypoints were 

taken during a dive or the Start/End times are known the IPS Waypoint dialog box may 
be used to determine the time of a given waypoint. The time can then be used to jump 
to a given location: 
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8.   Click the track icon.  
9   Add the 3Beam pitch (mounting) bias (e.g. -35.00 deg., Down is negative). 

10.  Click Export. It takes approximately 3.5 min to complete a 500 meter transect on a 800 
MHz PC. The progress of the process may be monitored in the IPS Message box.  Two 
3beam data files are created. (E.g “0310030812.txt” and (0310030812_Stat.txt). 
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11.  When the process is completed the following message box will pop up. 

 
12.  To view the quality of the IPS Path fit to the actual data zoom in. A thin black line 

representing the statically best fit path is shown. 
 



Integrated Positioning System Version 7.7.1.10 88 

Creative Underwater Technologies Copyright 1992-2019 

 
13.  The 3beam file *_Stat.txt contains the following processing data: 

 
 
a)        Start Time            End Time              nr        Lat r        Long r            DMean        DStdDev         nD 
b)         8:12:22.439         8:14:11.305        425        0.7929        0.9981        0.1951        0.107699          421 
c)     The nr is the number of data points used for the curve fit, where the nD is the number of data points used to 

calculate the mean and StdDev for the individual distances from each data point to the predicted data point. 
 
 

14.   The 3-Beam data format (rev 4) is: 
3-Beam file format to support Doppler Velocity Log (DVL) Navigation and Attitude 
Heading Reference System (AHRS) data. 
 

Time 
MMDDYYHHmmsszz
z 

Roll 
[deg] 
+ Port 
side up 

Pitch 
[deg] 
+ Bow 
up 

True  
Heading 
[deg] 
0-359.99 

Alt 
[m] 

DVL 
North Vel 
[m/s] 
+ North 
NEU 

DVL 
East Vel 
[m/s] 
+East 
NEU 

DVL 
Distance 
along 
Mean path 
[m] 

Depth 
[m] 

X 
Long [deg] 
(WGS-84) 

Y 
Lat [deg] 
(WGS-84) 

022802130443281 R -0.68  P 38.20 H 358.48 A 1.25 N 0.124 E .025  M 229.512 D 60.02 X 
-119.61276953  

Y 
33.9731897
3 

Notes: 
1. time format zzz is ms not hsec. 
2. DVL X & Y velocities have been corrected for roll and pitch and are with respect to North. 
3. Each data string is followed by a <cr><lf>. 
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Menu Bar 
 
Menu Bar Overview 
 
Operator control of the IPS program is via the PCs mouse, a series of drop-down menus 
arranged across the top of the viewing window and the IPS toolbar under the menu 
bar.  The individual menu selections and toolbar options are described in the following 
sections. 
 
The IPS menu system is divided into seven logical paths, each originating from the basic 
menu bar.  These selections may be accessed in three ways.  The first is by using the 
mouse and clicking the desired menu option.  The second is using the F10 key to get to the 
Menu Bar and then using the left or right arrow keys to select a menu.  The third method is 
entering the appropriate hot key.  The hot key is ALT and the highlighted letter of the 
selection. For example, the hot key for the FILE drop down menu is Alt F.  To exit the Menu 
Bar click any other area on the screen or use the Escape key.  When a selection has been 
made a drop down menu displaying all of the options for that selection appears.  To access 
any of the options listed for that selection use the mouse, up or down arrow keys or the 
highlighted hot key.  For example, the hot key for Save in the File selection is S.  
 
In addition, individual dialog boxes may be accessed by using the Ctrl key and the letter on 
the left of the menu item.  For example, pressing Ctrl T will display the Target Setting 
dialog box. 
 
Menu items that have an ellipsis ( … ) after the menu item have corresponding dialog 
boxes.  Clicking on the menu item causes the dialog box to appear.  There are two ways to 
access dialog box options.  The first is clicking on the appropriate radio button, checkbox or 
edit box.  The second method is using the tab key to cycle through the dialog box 
options.  A text box indicates that you need to enter the information being requested.  Click 
on or tab to the text box and enter the necessary information.  To exit the dialog box and 
save changes click the ok button.  To exit a dialog box without saving changes click the 
cancel button.  Pressing an apply button sets the dialog box parameters, and pressing the 
cancel button after pressing the apply button will not reverse these settings. 
 
Menu items that toggle an IPS setting or set whether or not an IPS feature is displayed (i.e. 
the IPS Message Box) are checked when the setting is on.  When the parameter is set to off 
the check mark disappears.  Examples of this are MENU BAR-> SETUP -> Auto Save and 
MENU BAR->VIEW -> Show Toolbar. 
 
The seven Menu Bar selections are described in detail in the Menu Bar section: 
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File Menu 
 
File New Command 
 
The New command clears the current display buffer WITH THE LOSS OF ALL COLLECTED 
DATA for the current mission (unless the data has been previously saved to a file). 
 
File Open Command 
 
The Open command loads a previously saved mission into a buffer.  A window displaying 
the current directory and all subdirectories and IPS data files in that directory will appear. 
 
File Close 
 
The Close command returns the display from a previously saved data file to current mission data. 
 
File Save Command 
 
The File Save command saves the current mission (data) to a specified disk file in IPS 
format.  Position data saved using this command may be loaded back to the IPS program 
for post processing.  The File Save As dialog box displaying the current directory and all 
corresponding sub-directories will be displayed if the data for the current mission has not 
been saved yet. 
 
 
File Save As Command 
 
Displays a dialog box allowing the user to enter the name of the file to be saved.  If the file 
name entered in the dialog box matches the name of an existing file the File Exists message 
box will be displayed.  The message box gives the user three options: 
 

 
Yes:       The file that already exists will be over written and all data in the old 

file will be lost. 
 
No:        The user will be given another opportunity to save the current data 

file under a different name.  This is the default option. 
 
Cancel:   The save dialog box will be exited and no new data will be saved. 

 
If the name entered as the file to be saved matches the name of the file last used to save 
real time mission data File Name Unavailable will be displayed.  The user will then be 
allowed to enter a new name to be used for saving the current data. 
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Export Data Command 
 
Text/NMEA Sub Menu 
 
This option displays a dialog box that allows the user to generate a text file composed of all 
ship and ORE target position data currently in memory.  When you click on the Text/NMEA 
File sub menu command the Text/NMEA Settings dialog box will appear.  After setting the 
parameters listed below, click the Ok push button.  The SaveAs dialog box will 
appear.  Enter the name of the text file in the space provided and click the Ok push 
button.  The default name is Run1.txt.  The user may change the name, however it is a 
good idea to not use *.trk or *.raw as the file extension as this may cause the text file to be 
confused with an IPS format file. 
 
Position data IPS files with *.trk and *.raw extensions that are loaded into memory using 
the FILE -> Open command may also be output as a text file.  However a text file 
generated using the Save as Text File command may not be loaded back into the IPS for 
post processing.  To save position data in a file for post processing use the  -> FILE -> 
Save command. 
 
A dialog box allowing the user to set the following Text/NMEA parameters will appear when 
the Text/NMEA sub menu is selected: 
 
 
Text\NMEA Format:  
allows the operator to select a National Marine Electronic Association (NMEA) format or IPS 
format for the serial output.  Check the appropriate radio button to select one of the nine 
formats.  The nine options for NMEA serial output are GGA2,  
DTF, DTF NOAA, TLL, TPD,  Waypoints Only, Waypoints w/ ArcView, UTM(x,y,z) and $PIUDP 
data.  If a GGA output format is selected, the priority target must be set to a target that is 
being tracked or no data will be sent to the output file. 
Note: When the TPD format is selected as NMEA serial output the target's depth will be 
given in the current IPS system units.  This means the target's depth will be expressed in 
meters if meters are the current system units and feet in all other cases. 
 
Priority Target:  
allows the user to select which of multiple targets will be sent out as a text string if GGA 
version 2.0 has been selected for serial output.  This is necessary because neither GGA 
format includes a target ID or name.  If the Text\NMEA Format is GGA, the priority target 
must be set to a target number that is being tracked, or no data will be sent to the output 
text file.  All other serial output options include a target name or ID.  Therefore text strings 
will be output for all targets for which valid data is being received if any other serial output 
format is selected.  This is the only effect Priority Target has on any of the target's 
parameters.  Enter the appropriate target number in the edit box provided. 
 
Display/Raw:             
allows the user to choose to save either the data displayed to the screen or all data 
collected by the IPS software.  If Display is selected data eliminated using the Filter 
Command and data not displayed due to the INPUTS->Target Settings Command-> Draw 
Rate setting will not be included in the text file. 
 
Time Format (Seconds): 
allows the user to select the format used for the time format field of the data file. 
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Check Sum:                
allows the user to enable or disable the check sum field.  A check sum is a field at the end 
of the data string that can be used by the receiving software to verify that the text string 
has not been corrupted during transmission.  If the check sum is enabled an asterisk will be 
displayed after the text string format selected. 
 
Target Data Only: 
allows the user to eliminate ship position data from the text file.  Only position data 
pertaining to ORE targets will be added to the text file.  However, not all of the output 
formats have ship's data.  For example, the GGA format does not have a target ID field so it 
will only contain the info for the "Priority Target."  Whereas, TPD, DTF, TLL all have a target 
ID fields and can be created with or without the ship data depending on if the "[ ] Target 
Data Only" check box is enabled. 
 
GIS/Image Sub Menu 
 
This option displays a dialog box that allows the user to generate an image file using the 
current screen display. When you click on the GIS/Image File menu sub command the 
GIS/Image Settings dialog box will appear.  After setting the parameters listed below, click 
the Ok push button.  The SaveAs dialog box will appear.  Enter the name of the text file in 
the space provided and click the Ok push button.  The default name is Run1.*.  The user 
may change the name, however it is a good idea to not use *.trk or *.raw as the file 
extension as this may cause the text file to be confused with an IPS format file. 
 
GIS Image Format:     
allows the operator to select the image format used for the saving the current IPS 
screen.  Check the appropriate radio button to select one of the six formats.  The six 
options are MIF(Map Info), DXF(Auto Cad), GPX(GPS eXchange Format), SHP(ESRI Shape), 
KML(Google) and JPG Bitmap Image ESRI Reference File. 
 
View Area:                   
allows the user to select the entire screen to be saved as an image instead of just the 
chart.  If Bitmap Image Reference has been selected as the GIS image format this option is 
automatically set to on.  
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Didson Sub Menu 
 
This dialog box allows the user to embed IPS latitude and longitude data in the Didson 
binary file and/or to mark the location a Didson image was recorded at by setting that 
location as an IPS Waypoint. 
 
Didson File:                
displays the name of the Didson file selected.  This edit box is for display purposes only and 
may not be edited by the user. 
 
Select File:            
this option displays a dialog box that allows the user to select the Didson file to be 
used.  The selected file will be displayed in the Didson file edit box above. 
 
IPS Target:  
allows the user to select the target who's track will be used to generate the latitude and 
longitude data that will be embedded in the Didson file.  Only the ship and targets that are 
being tracked will be displayed in the list box. 
 
Heading:    
allows the user to enter the Didson heading bias.  The maximum roll bias that may be 
entered is 359.90 degrees.  The offset may be positive or negative.  The IPS default is 0.0 
degrees. 
 
Pitch:     
allows the user to enter the Didson pitch bias.  The maximum pitch bias that may be 
entered is 180.0 degrees.  The offset may be positive or negative.  The IPS default is 0.0 
degrees. 
 
Roll:  
allows the user to enter the Didson roll bias.  The maximum roll bias that may be entered is 
180.0 degrees.  The offset may be positive or negative.  The IPS default is 0.0 degrees. 
 
Time Bias:    
allows user to enter a time bias that will be applied to the Didson data.  The maximum time 
bias that may be entered is 3600.00 seconds.  The offset may be positive or negative.  The 
IPS default is 0.0 degrees. 
 
Add as Waypoint:   
allows the user to mark the latitude and longitude where the Didson image was recorded by 
setting it as an IPS Waypoint. 
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IPS Screen FTP Export Sub Menu 
 

  ] 
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The IPS Screen FTP Export allows a user to host on a web site in near real time the 
navigation plot area as seen by the IPS operator. This utility simply copies the IPS plotting 
area into a jpg and transfers it to a web server or other host using ftp at a rate set by the 
“Export Interval”. The basic vessel (“ship”) and target information will be displayed on the 
left hand side of the jpg image as shown in the figure above.  The IPS software always 
creates a jpg image named: nav_plot.jpg in a sub folder “ftp”.  This folder is created by IPS 
in the startup directory (typically C:\Program Files\ORE). This image is overwritten upon the 
creation of a new jpg image (screen grab) at an interval set by “Export Interval”.  For 
information on running a remote instance of the IPS on a host computer please see the 
Remote IPS Display and Ethernet Configuration sections of this manual. 
 
Export Interval:          
sets the time period in seconds between updates of the IPS plotting area jpg and its 
transfers by FTP to the host site.   The maximum interval is 60 seconds and the minimum is 
0.  The default value is 10.  
 
Remote Host Path:       
allows the user to enter the path of the remote host (i.e. web server) that the jpg will be 
transferred to. 
 
Remote IP Address:     
allows the user to enter the IP address of the remote host (web server). 
 
User Name:                 
allows the user to enter the FTP account on the remote host (web server) for the IPS screen 
export.  The maximum length for the user name is 20 characters. 
 
Password:  
allows the user to enter the password for the IPS screen export  This may not be required 
depending on how the ftp site account has been configured on the host (web server). 
 
Enable: 
allows the user to select whether or not the IPS export data function is active.  If this 
feature is not enabled the other settings are saved but the jpg images will not be created or 
ftp’ed to the host system.  If the box is checked the function is enabled.  
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3D Sensor Processing Sub Menu 
 
This dialog box allows the user to process 3D sensor data.  Please see the IPS 3D Sensor 
Processing and the 3D SONAR Calibration (Patch Test) Example sections for more 
information.  The dialog box is composed of five pages each represented by a tab. To move 
from page to page click the appropriate tab. The pages are as follows: 
 
Process and Export Tab 
 
Sensor XYZ File: 
Displays the sensor XYZ file that is being processed. 
 
Select File: 
Allows the user to select the sensor XYZ file to be processed.  The file open dialog box will 
appear when the Select File button is pressed. 
 
Support File: 
Displays the support file that is being processed. 
 
Select Support File: 
Allows the user to select the support file to be processed.  The file open dialog box will 
appear when the Select Support File button is pressed. 
 
IPS Target: 
Allows the user to select which of the currently tracked (real time) or previously tracked (old 
data) targets will be associated with the 3D sensor data for processing.  The ship, which is 
target 10 may also be used.  The default is the current target in focus. 
 
 
3D Plot: 
Displays the 3D plot created using the 3D sensor data.  If you right click on the image 
displayed in the 3D Plot Viewer a sub menu with the following features will appear.  The 
features are Home, Center, Rotate, Zoom, Pan, Info, Make Wpt, Load File, Add Data Set, 
Make VRML File, Save As BMP Clear Plot and View Axis.  If 3D data is currently loaded into 
the 3D viewer then the Create VRML option will generate a .wrl (v 1.0 VRML) web viewable 
file and two pop-up dialog boxes will appear. The first to allow a sensor ID to be assigned 
and the second is for a title/description. Both of these inputs will be added to the VRML file 
header. 
 
QC Cal Plot: 
If a valid 3D calibration (patch test) was performed the QC Cal plot button will pop up the 
most recent plot. 
 
2D Alignment 
Aligns the two sonar images selected in Sensor File and Support based on the parameters 
set in the 2D alignment dialog box. 
 
Auto Area Select 
this feature will use PCA (Principle Component Analysis) to select the optimal area to use for 
2D alignment between files. 
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Georeference Local Sensor Data Button: 
Opens a dialog box that allows the user to enter a geo reference file containing raw 3D data 
(in sensor coordinates) based upon the values set in the IPS offset dialog box and currently 
loaded in IPS navigation file. The process also allows for a Z offset to be applied in units of 
meters. 
 
3D Sensor Cal Button: 
Opens the 3D Sensor Calibration Dialog Box.  From here the user can select which 
processing step of the “Patch Test” 3D calibration process to use, see the 3D SONAR 
Calibration (Patch Test) Example section above.  Also see the section below titled "3D 
Sensor Calibration Dialog Box". 
 
Start 3D Cal Button: 
Will process the data file(s) specified in the file selection fields using the method specified in 
the “3D Sensor Calibration Dialog Box”. 
 
3D Alignment 
Aligns the two sonar images selected in Sensor File and Support based on the parameters 
set in the 3D alignment dialog box. 
 
Target Detect Button: 
Will make an automated comparison between two geo referenced files in UTM coordinate 
systems. The output is a text file that specifies the geodetic location of the points (bins) that 
are statistically different. 
 
Use Tide File: 
Adds offsets to multi beam data to account for tides. 
 
3D Sensor Calibration Dialog Box 
 
Variable:  
allows the user to choose either the heading, roll or pitch angle to apply to the parameters 
listed below. 
 
Angle Error Range:      
allows the user to enter the angle error range.  The maximum angle error range allowed is 
20, the minimum is 0 and the default is 5. However 20 is a good number Calculates the 
mounting relative to the navigation coordinate system. 
 
Data Cell Size:              
allows the user to enter the data cell size used in the 3D calibration.  The maximum data 
cell size allowed is 10.0, the minimum is 0.10, and the default is 1.00. 
 
Minimum Samples/Bin:      
allows the user to enter the minimum number of samples per bin that can be used to 
calculate the 3D calibration.  The maximum data cell size allowed is 100.0, the minimum is 
10.0, and the default is 30.00. 
 
Angle Interval: 
allows the user to enter the angle interval that will be used when calculating the 3D 
calibration. The maximum angle interval allowed is 1.00, the minimum is 0.02 and the 
default is 0.5. 
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Minimum Depth:          
allows the user to enter the minimum depth that will be used to calculate the 3D 
calibration.   The largest minimum depth allowed is 4000.00, the smallest is 0.0 and the 
default is 5.0.   
 
 
Time Range: 
allows the user to enter the maximum time delay range that will be used to calculate the 3D 
calibration.   The largest maximum time delay range allowed is 2000.00, the smallest is 
100.00 and the default is 1000. 
 
 
Export to XYZ Tab ASCII:      
if enabled (checked) this feature will export the sensor data to an ASCII file.  The default 
setting is off. 
 
Auto Area Select: 
if enabled (checked) this feature will set the Auto Area Select to on.  The default setting is 

off. 
 
Depth: 
allows the user to select - Z (Negative Down) or + Z (Positive Down) as depth setting. 
 
Time Delay Interval: 
allows the user to enter a time delay interval of 5,10,20,50 or 100. 
 
 
 
Configuration Tab:   
 
Sensor Mounting Angles: 
allows the user to enter the following sensor mounting angles. 
 
Heading:                    
allows the user to enter the heading mounting angle.  The maximum heading mounting 
angle allowed is 359.99 degrees and the minimum is -359.99.  The default is 0. 
 
Pitch:  
allows the user to enter the pitch mounting angle.  The maximum pitch mounting angle 
allowed is 180.00 degrees (bow up) and the minimum is -180.00.  The default is 0. 
 
Roll:  
allows the user to enter the roll angle.  The maximum roll angle allowed is 90.00 degrees 
(port side up) and the minimum is -90 degrees. The default is 0.   
 
Sensor Position Relative to Center of Roll Pitch: 
 
X (Port-Starboard):      
allows the user to enter the X sensor position.  The maximum sensor X position allowed is 
180.00 degrees and the minimum is -180.00.  The default is 0.  A positive value indicates 
an X position on the starboard side of the CPR. 
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Y (Forward Aft):         
allows the user to enter the Y sensor position.  The maximum sensor Y position allowed is 
180.00 degrees and the minimum is -180.00.  The default is 0.  A positive value indicates a 
Y position forward of the CPR. 
 
Z (Vertical): 
allows the user to enter the Z sensor position.  The maximum sensor Z position allowed is 
180.00 degrees and the minimum is -180.00.  The default is 0.  A positive value indicates a 
Z position above the CPR. 
 
Depth: 
allows the user to select - Z (Negative Down) or + Z (Positive  Down) as depth setting. 
 
Time Bias:  
allows the user to enter the time bias that will be applied to the sensor data.   
 
Subtract Time Bias:         
if enabled (checked) subtracts the time bias instead of adding it when processing the 3D 
data.  The time bias is added or subtracted from the sensor time, not the IPS Navigation 
time. 
 
 
Data Bounds Tab: 
When running a 3D calibration the user may want to select only a specific segment of the 
data for use in the calibration.  This segment may be defined either by area or by time. To 
use either method enable the appropriate check box and enter the desired area or time 
bounds in the corresponding edit boxes.  If neither the Use Area Bounds check box or the 
Use Time Bounds check box is checked all the data will be used for the 3D calibration.  
 
               Area Bounds 
 
Use Area Bounds: 
if this check box is enabled the segment of the data defined using the 3D area values 
entered below will be processed in the 3D calibration.  The IPS default is disabled. 
 
Median Filter 3D Cal File: 
applies a median filter for each sonar/laser line being processed.  This is done by scanning 
the data a line at a time to get rid outliers caused by fish, floating debris or sonar noise. 
 
 
XMin/Easting/Long: 
allows the user to enter the minimum bounding area X value (UTM Easting or longitudinal 
value) that will be used during the 3D sensor calibration process 
 
YMin/Northing/Lat: 
allows the user to enter the minimum bounding area Y value (UTM Northing or Latitude 
value) that will be used during the 3D sensor calibration process. 
 
XMax/Easting/Long: 
allows the user to enter the maximum bounding area X value (UTM Easting or longitudinal 
value) that will be used during the 3D sensor calibration process. 
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YMax/Northing/Lat: 
allows the user to enter the maximum bounding area Y value (UTM Northing or Latitude 
value) that will be used during the 3D sensor calibration process. 
 
 
Min Depth:                        
all data points above the value entered will be excluded from calibration processing.  The 
minimum depth allowed and the default value are both 0 meters.  The maximum Minimum 
Depth allowed is 3048 m (10000 feet).  Enter the Minimum Depth in meters in the edit box 
provided. 
 
Max Depth:                   
all data points below the value entered will be excluded from calibration processing.  The 
maximum depth that may be entered and the default value are both 3048 m (10000 
feet).  The minimum depth is 0 feet.  Enter the Maximum Depth in meters in the edit box 
provided. 
 
               Center Box 
 
XMin/Easting/Long: 
allows the user to enter the minimum bounding area X value (UTM Easting or longitudinal 
value) that will be used during the 3D sensor calibration process 
 
YMin/Northing/Lat: 
allows the user to enter the minimum bounding area Y value (UTM Northing or Latitude 
value) that will be used during the 3D sensor calibration process. 
 
File Area Bounds: 
When the scan button is pressed the IPS will determine the minimum and maximum extents 
of the file and display them in the appropriate edit boxes as a guideline. 
 
Time Bounds: 
Will process 3D calibration data only within specified time boundary if the “Use Time 
Bounds” check box is checked. 
 
Use Time Bounds:  
If enabled (checked) the time bounds entered below will be used during the 3D sensor 
calibration. 
 
Min Time: 
Allows the user to enter the minimum time bounds used during the 3D sensor calibration.   
 
Max Time: 
Allows the user to enter the maximum time bounds used during the 3D sensor calibration. 
 
        
Modem File 
 
The Modem File menu command allows the user to process a saved micro modem file.  The 
micro modem file will be converted from hex encoded data strings to readable text. 
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Merge DVL/USBL Nav Data 
 
Please see the Merging DVL and USBL IPS Files section of this manual for more information. 
The following biases and parameters may be applied to DVL data.  If the corresponding 
check box is checked then the bias will be applied or the parameter will be used.  If the 
check box is not checked any value entered in the corresponding edit box will be 
disregarded. 
 

USBL Time Bias:                      
Allows user to enter a time bias that will be applied to USB data. 
 

                         
DVL Altitude 
Bias:  

Roll: Enter the roll bias.  The roll bias must be between 90.00 and -90.00. 

 
 

Pitch: Enter the roll bias.  The roll bias must be between 90.00 and -90.00. 

 
 

Heading: Enter the heading bias.  The roll bias must be between 360.00 and 
 -360.00. 

                               
 

Sound Velocity Scale Factor:  
Allows user to enter the sound velocity scale factor.   The roll bias must be between 1.15 
and 0.05.    

 
Depth Bias:                             
Allows user to enter the sound depth bias.   The roll bias must be between 1.15 and 0.05.    

 
New DVL Start Lat/Lon:        
Resets the DVL position to the latitude and longitude entered below.  The IPS default is off. 
 
DVL Start Lat/Lon:                 
Allows the user to enter a new latitude and longitude that can be used to reset the DVL 
tracking.  New DVL Start Lat/Lon above must be on (checked) for the these parameters to 
be used. 

 
Merge USBL/DVL:                 
Allows the user to choose to not to merge the USBL/DVL data with ORE data, to shift the 
DVL data as a Data Set or to use a Kalman Filter to merge the data.  If the Kalman Filter 
radio button is selected the Kalman Filter Settings button will be enabled allowing the 
Kalman Filter Settings dialog box to be displayed. See the Kalman Filter Settings section 
below for more information.  The value and selection of the Kalman filtering parameters 
entered depends on which data and which type of correction the user feels is less 
noisy.  Merging the USBL data with the DVL data is useful because while the DVL data is 
more precise (less error between data points) it tends to drift over time while the USBL data 
is noisier but is more accurate with regard to geodetic position. These values can be 
determined by an offline equipment calibration such as a USBL calibration.  Please see the 
System Calibration Section of this manual for more information.  The IPS Default is Kalman 
Filter. 

 
Kalman Filter Settings:          
Opens the Kalman Filter Settings dialog box.  This button is only enabled if the Kalman 
Filter option is selected in the group box above. 
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USBL   
 USBL ID: Allows the user to enter the ID of the USBL target that is 

being tracked.  The ID must between 1 and 9.   The 
default value is 1.   
Note: this cannot be the same as the DVL ID. 

 Positioning 
STDEV: 

Allows the user to choice to apply a positioning Standard 
deviation correction when the merging USBL/DVL data.  
The default is on.  Either the Positioning STDEV or the % 
SR correction may be used but not both.    

 Positioning 
STDEV Value: 

Allows the user to enter the positioning standard deviation 
that will be applied when the merging USBL/DVL data.  
The positioning standard deviation is determined by offline 
analysis and equipment calibration.  The standard 
deviation must be between 0 and 200.000 meters and the 
default value is 10 meters.  

 % SR 
Correction: 

Allows the user to apply a percent slant range correction 
when merging USBL/DVL data instead of using the 
positioning standard deviation.  The default is off. 

 % SR 
Correction 
Value: 

Allows the user to enter the slant range correction percent.  
The slant range correction is determined through 
equipment calibration.  The SR percentage must be 
between 0.05 and 5.00 meters and the default value is 1.0 
meters.  

DVL Velocity STDV 
Value: 

Allows user to enter the velocity standard deviation that 
will be applied when  merging USBL/DVL data.  The 
velocity STDV must be between 0 and 2.000 milli seconds 
and the default value is 0.115 meters per second.  

 Apply Altitude 
Correction: 

Allows the user to apply an altitude correction when 
merging the USBL/DVL data.  The default value is off.   

 Generate 
Unfiltered DVL 
Path: 

Allows the user to generate an unfiltered DVL path using 
the target number entered below in Unfiltered DVL Path 
Target ID. The default value is on.   

 Unfiltered DVL 
Path Target ID: 

Allows the user to enter the target number used to 
generate an unfiltered DVL path.  The target must be 
between 1 and 9 and the IPS default is target 4.    

Filter 
Process 

Position Noise: Allows the user to enter the position noise.  The position 
noise must be between 0 and 200.000 meters and the 
default value is 0.100 meters.  

 Depth Noise: Allows the user to enter the depth noise.  The depth noise 
must be between 0 and 20.000 meters and the default 
value is 0.010 meters.  

 Manual Velocity 
Noise: 

Allows the user to enter the manual velocity noise.  The 
manual velocity noise must be between 0 and 20.000 milli 
seconds and the default value is 0.03 meters per second.  

 Calculate: Allows the user to have the IPS calculate the processed 
velocity noise based on a calculation that provides optimal 
filtering.  The IPS default is on. 

 HZ Process 
Rate: 

Allows the user to enter the HZ process rate.  The HZ 
process rate must be between 2 and 30 and the default 
value is 0.03 meters.  

Depth: Depth STDV: Allows the user to enter the depth standard deviation.  The 
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depth standard deviation must be between 0 and 20.000 
meters and the default value is 0.010 meters.  

 Vertical Velocity 
STDV: 

Allows the user to enter the vertical velocity standard 
deviation.  The vertical velocity standard deviation must 
be between 0 and 2.00 meters and the default value is 
0.00 meters.  

 Use 
DVL/SVP/CTD 
Depth: 

Allows the user to use the DVL,SVP and CTD depths when 
merging the USBL/DVL data.  The default value is on.  
  

Graph Depth 
Profile:  

 Opens a dialog box that displays the raw input and the 
Kalman filtered data.  The difference between the 
predicted value (the position the filter calculates the target 
should be) and the actual raw position is also displayed.  
The IPS default is on.  
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Import WinFrog Text Data 
 
A dialog box allowing the user to enter the USB ID of the device the WinFrog data will be 
imported from will be displayed.  The ID number must be between 1 and 9.  The default is 
2.  After the ID number is entered, a save as dialog box allowing the user to enter the 
name of the file the data will be saved to is displayed. 
 
Copy to Clipboard 
 
Copies selected data to the clipboard.  The data in the clipboard can then be used to create 
bitmaps or JPGs. 
 
File Print Command 
 
The Print command allows the user print the current view of the display screen and/or other 
associated IPS statistics.  If You do not want to print press Cancel. 
 
Printer Options:         
Allows the user to select what data will be printed.  The options are Display Plot, Waypoint 
List, Calibration Results, Equipment Offsets and Mission Tracking Statistics. 
 
Title:                          
Allows the user to enter a title of up to sixty characters which will be printed across the top 
of each page except the display plot page. 
 
Font Size:                  
Allows the user to select a font size from 8 to 18 that will be used to print all text in the IPS 
printout. 
 
Orientation:               
Allows the user to select a whether the printout will be printed as a portrait(vertically) or 
landscape (horizontally). 
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Print Setup Command 
 
The Print Setup command allows the user to select the printer type, paper size to be used 
and print properties such as color and margin size. 
 
File Exit Command 
 
Exits the IPS program. To save data before exiting the program use the FILE ->Save menu 
option.  If data was previously saved, the name of the file the data was saved to and the 
time of the last save are displayed in the IPS caption.  One of three message boxes will be 
displayed depending on whether or not data has been collected and saved.  They are as 
follows:  
 
If no data has been saved yet (a file has not yet been assigned for saving current mission 
data) the 'Session (data) has not been saved! Exiting will result in the lost of all data!' 
message box will be displayed.  The message box gives the user the following three 
options: 
 
Yes:      The program will be exited and no data will be saved.  This is the default option. 
No:       The program will not be exited and no data will be saved.  The user must use the    

FILE -> Save command to save the data to a file. 
Help:     Displays this section of the IPS help file. 
 
If data has already been saved to a file but more data has been collected since the last 
save, the 'Exiting will result in loss of data collected in the last [time elapsed since last 
save]' message box will be displayed if the IPS program is exited.   The message box gives 
the user the following three options: 
 
Yes:      The program will be exited and no additional data will be saved.  Previously saved 

data will remain.  This is the default option. 
No:        The program will not be exited and no additional data will be saved.  The user 

must use the FILE -> Save command to save the additional data to a file.  
Help:     Displays this section of the IPS help file. 
 
 
If no data has been collected, the 'No Data Collected- Safe to Exit' message box will be 
displayed. 
 
Yes:     The program will be exited immediately. This is the default option. 
No:       The program will not be exited. 
Help:    Displays this section of the IPS help file. 
 
Also See: 
 
File Save As Command 
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Input Menu 
 
Target Settings Command 
 
The Target Setting command allows the user to set certain parameters for a chosen 
target.  Immediately after the Target Settings Command is selected the Target Selection 
dialog box with ten radio buttons and corresponding bitmaps is displayed.  To select a 
target click the radio button to the right of the bitmap representing that target, then click 
the Ok push button.  To escape without changing any targets, click the cancel push button. 
If You clicked Ok then a dialog box composed of five pages each represented by a tab will 
appear. To move from page to page click the appropriate tab. The pages are as follows: 
 
Position Box Tab: 
 
Target Number:                          
Displays the target number selected in the target selection dialog box. All changes made in 
the dialog box will be applied to this target number.  This field is for display purposes only 
and cannot be edited by the user. 
 
Font Settings:                              

   Clicking on this button displays a dialog box that allows the user to select the font color and 
font size of the text displayed in Target Position Box. 

 
Target Name:                               
Allows user to edit the name of the submerged target ID selected in the previous dialog 
box.  The name may be up to eighteen characters long. 
 
Target Name Position:                
Allows the user to select automatic or manual positioning of the target name.  If the user 
selects manual then the user can select the orientation of the target name using the Target 
Name Alignment combo box. 
 
Target Name Alignment: 
Allows the user to set the alignment of the target name with respect to the bitmap 
representing that target.  The options are Lower Right, Middle Right, Upper Right, Lower 
Left, Middle Left and Upper Left.  The default setting is Upper Left. 
 
Position Box Display Items:         
Allows the user to select the values that will be displayed in the Target Position Box by 
toggling the corresponding check box.  If the box is checked, the value will be displayed in 
the target position box.  The following are the possible values that may be displayed:  
 

Time of fix. 
Target Latitude and Longitude. 
UTM: Eastings and Northings. 
Depth 
Heading Roll and Pitch: Compass 
heading roll and pitch. 
COGSOG: CTD salinity and sound 
velocity. 
Horizontal Range: Range, Relative 
Bearing and True Bearing. 
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XYZ: ORE x,y,z values. 
Error code and message. 
Pinger: Pinger bearing information. 
 

Range and Bearing to Selected Target:  
If enabled (checked) displays the range and bearing to from one target to another.  Select 
the targets using the Select Target for Range Bearing push button below.  The bearing 
from target to target will be displayed in the Target Position Box.  At least two targets 
must be being tracked for this feature to be enabled.   
 
Relative and True Bearing Displays: 
If enabled displays the compass rosettes showing the relative and true bearing on the 
bottom of the Target Position Box.  At least two targets must be being tracked for this 
feature to be enabled.   
 
Select Target for Range Bearing:         
Allows the user to select the targets that will be used in displaying the range and bearing 
and relative and true bearing discussed above. 

 
Raw Display Tab: 
 

Unavailable at this time. 
Filtered Display Tab: 
 
Target Number:                          
Displays the target number selected in the target selection dialog box. All changes made in 
the dialog box will be applied to this target number.  This field is for display purposes only 
and cannot be edited by the user. 
Track By:                  
Allows the user to select whether the number of data positions on the screen will be set by 
points or time. 
 
If No. Points is selected, the value in the edit box opposite the No. Points radio button sets 
the number of currently collected data point positions that will be displayed.  The number of 
points displayed may range from 0 to 16000.  The display begins with the currently active 
data point and moves back through the data points with respect to time.  The "snail trail" is 
displayed in the color selected below using the Point Color button.   The trail length is 
independent for each target.  For normal use, select approximately 10 to 40 points.  To 
display all points enter 16000.  In both Relative mode and North Up mode no data points 
are displayed. 
If Time is selected all the data points between the time entered the time edit box and the 
current time will be displayed. 
Note: If skip decimation is set to anything besides 0, points will be skipped.  Please see the 
help file item directly below. 
 
Skip Decimation:                     
Allows the user to set the number of points in the snail trail to be skipped.  For example, if 
the number 1 is entered, only every other point will be displayed.  If 10 is entered only 
every 10th point will be displayed. This setting allows the user to view an extensive history 
of the mission without displaying every point.  Each point is still saved in the mission 
database, regardless of what number is entered in the skip edit box.  A number between 0 
and 99 may be entered.  The default is 0. 
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Point Color:                              
Clicking this button displays a dialog box that allows the user to set the color of the points 
displayed in the view screen snail trail for the corresponding target. 
 
Tracking:                                  
Allows the user to specify whether or not data from the target ID just selected in the 
previous dialog box will be tracked and updated by the IPS software.  The default mode for 
Targets is auto.  The position information for all targets will be displayed in the target 
position boxes.  When data is initially received for a target a position box for that target will 
be displayed in the center of the viewing area.  The target position box can then be moved 
to another location.  
 
Auto Center:                                 
Places the target ID just selected in the previous dialog box at the center of the display 
screen if the current position goes out of the current viewing area.  To center the viewing 
area about a target that may be currently out of the viewing display press the Home 
key.  Only one target or the ship may be centered at a time. 
 
Display Label:                           
Displays the target name in the viewing area. 
 

DVL Navigation Only:                     
Enables or disables navigation by DVL allowing the capability of processing subsea DVL data 
from a RDI in the PD6 format or the IPS NMEA style string $PUVN.     
 
Display Range Ring:                  
Enables or disables the display of a range ring centered about the target.  The radius of the 
range ring is determined by the Display Range Size. 
 
Range Ring Size:                         
Sets the radius of the range ring in system units. The Range Ring is always centered about 
the vessel. 
 
Display Range Color:                    
Sets the color of the range ring. 
 
System Units:                             
Displays the system units set in the VIEW->Display Settings dialog box.  This field is for 
display purposes only and cannot be edited by the user. 
 
Draw Rate:                                  
Sets the rate at which the positions for the target will be displayed in the viewing area.  The 
maximum amount of time allowed between display updates is 3600 seconds (60 
minutes).  The minimum amount of time allowed between display updates is 2 seconds.  If 
a draw rate has not been set, the default time of 20 seconds between each screen update 
will be used. 
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Waypoint Settings Tab: 
 
Text Display:                                
Allows the user to select the values that will be displayed in the Target Position Box by 
toggling the corresponding check box.  If the box is checked, the value will be displayed in 
the target position box.  The following are the possible values that may be displayed: 
 

Range and Bearing 
ETA 
TTG 
XTE 
 
 

Apply:                                         
displays the values selected above in text display in Target Position Box immediately.  
 
 
DVL TAb: 
This feature acts as a shortcut to begin DLV navigation if the apply button is pressed and 
resets the current position to the for latitude and longitude entered in the edit boxes if the 
DVL Reset button is pressed.  The DVL navigation will be based on the values entered in 
Equipment->Target Offset DVL Tab.  
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Ship Settings Command 
 
The Ship Setting command allows the user to set certain parameters for the ship.  When 
this menu command is selected a dialog box composed of four pages each represented by a 
tab will appear. To move from page to page click the appropriate tab. The pages are as 
follows: 
 
Position Box Tab: 
 
Font Settings:                           
Clicking on this button displays a dialog box that allows the user to select the font color and 
font size of the text displayed in Ship Position Box. 
 
Ship Name:                                 

 Allows user to edit the name of the ship, the ship name will be displayed in the caption of 
the ship position box and in the viewing area, adjacent to the ship.  The name may be up to 
eighteen characters long. 

 Note: The ship name will only be displayed in the view area when the Display Label check 
box is checked and the ship heading marker is visible (the ball and line.) 
 
Ship Name Position:                     
Allows the user to select automatic or manual positioning of the ship name.  If the user 
selects manual then the user can select the orientation of the ship name using the Ship 
Name Alignment combo box. 
 
Ship Name Alignment: 
Allows the user to set the alignment of the ship name with respect to the ship shape.  The 
options are Lower Right, Middle Right, Upper Right, Lower Left, Middle Left and Upper 
Left.  The default setting is Upper Left. 
 
Position Box Display Items:         
Allows the user to select the values that will be displayed in the Ship Position Box by 
toggling the corresponding check box.  If the box is checked, the value will be displayed in 
the ship position box.  The following are the possible values that may be displayed: 

Time of fix. 
Ship Latitude and Longitude. 
UTM: Eastings and Northings. 
Compass Depth 
Heading Roll and Pitch: Compass heading 
roll and pitch. 
COG\SOG: CTD salinity and sound 
velocity. 
Status, # of satellites  
 

Raw Display Tab: 
 

Unavailable at this time. 
 

Filtered Display Tab: 
 
Ship Shape Fill Style:                 
Allows the user to enter the style that will be used to fill in the ship shape displayed in the 



Integrated Positioning System Version 7.7.1.10 111 

Creative Underwater Technologies Copyright 1992-2019 

IPS viewing grid.  The available fill styles are as follows: Fill Hollow, Fill Solid, Fill Horizontal, 
Fill Vertical, Fill F Diagonal, Fill B Diagonal, Fill Cross, and Fill Diagonal Cross.  The IPS 
default is Fill Hollow (no fill inside ship shape).  Setting the fill style to something besides 
Fill Hollow is useful when the ship and target shapes are being displayed over a 
chart.  Filling in the ship shape makes the ship shape stand out and be easier to see. 
 
Ship Shape Line Size:                    
Allows the user to enter the line size that will be used to draw the ship shape displayed in 
the IPS viewing grid.  The available line sizes range from 1 to 20.  The IPS default is 1.   
 
 
Track By:                               
Allows the user to select whether the number of data positions on the screen will be set by 
number of points or time. 
 
If No. Points is selected, the value in the edit box opposite the No. Points radio button sets 
the number of currently collected data point positions that will be displayed.  The number of 
points displayed may range from 0 to 16000.  The display begins with the currently active 
data point and moves back through the data points with respect to time.  The "snail trail" is 
displayed in the color selected below using the Point Color button.   The trail length is 
independent for each target.  For normal use, select approximately 10 to 40 points.  To 
display all points enter 16000.  In both Relative mode and North Up mode no data points 
are displayed. 
 
If Time is selected all the data points between the time entered the time edit box and the 
current time will be displayed.  
Note: If skip decimation is set to anything besides 0, some points will be skipped.  Please 
see the help file item directly below. 
 
Skip Decimation:                        
Allows the user to set the number of points in the snail trail to be skipped.  For example if 
the number 1 is entered, only every other point will be displayed.  If 10 is entered only 
every 10th point will be displayed. This setting allows the user to view an extensive history 
of the mission without displaying every point.  Each point is still saved in the mission 
database, regardless of what number is entered in the skip edit box.  A number between 0 
and 99 may be entered.  The default is 0. 
 
Point Color:                                  
Clicking this button displays a dialog box that allows the user to set the color of the points 
displayed in the view screen snail trail for the ship. 
 
Tracking:                                       
Allows the user to specify whether or not data from the ship will be tracked and updated by 
the IPS software.  The default mode for the ship is auto.  The position information for the 
ship will be displayed in the Ship Position Box.  
 
Auto Center:                                
Places the ship in the center of the display screen if the current position goes out of the 
current viewing area.  To center the viewing area about the ship if it is currently out of the 
viewing display press the Home key.  This is a good selection to have activated for the 
general navigating of a surface ship that will be underway for long periods of time.  To 
center the viewing area about a target being tracked use the Auto Setting option setting 
under the Input Menu Target Settings.  Only one target or the ship may be centered at a 
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time. 
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Display Label:                              
If this option is checked the ship name will be displayed in the viewing area. 
Note: The ship name will only be displayed in the view area when the ship heading marker 
is visible (the ball and line). 
 
Display Range Ring:                             
Enables or disables the display of a range ring centered about the ship.  The radius of the 
range ring is determined by the Display Range Size. 
 
Display Range Ring Size:                      
Sets the radius of the range ring in system units. The Range Ring is always centered about 
the vessel. 
 
Display Range Ring Color:             
Clicking this button displays a dialog box that allows the user to set the color of the ship 
range ring displayed in the view screen. 
 
System Units:                               
Displays the system units set in the VIEW->Display Settings dialog box.  This field is for 
display purposes only and cannot be edited by the user. 
 
Draw Rate:                                    
Sets the rate at which the positions for the ship will be displayed in the viewing area.  The 
maximum amount of time allowed between display updates is 3600 seconds (60 
minutes).  The minimum amount of time allowed between display updates is 2 seconds.  If 
a draw rate has not been set, the default time of 20 seconds between each screen update 
will be used. 
 
Waypoint Settings Tab: 
 
Text Display:                                 
Allows the user to select the values that will be displayed in the Ship Position Box by 
toggling the corresponding check box.  If the box is checked, the value will be displayed in 
the target position box.  The following are the possible values that may be displayed: 
 

Range and Bearing 
ETA 
TTG 
XTE 
 

Apply:                                         
Displays the values selected above in text display in Ship Position Box immediately.  
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System Inputs Command 
 
The System Input command allows the user to set input parameters such as the type of 
equipment sending the input data and what error checking will be used when processing the 
data. The dialog box composed of four pages each represented by a tab will appear. To 
move from page to page click the appropriate tab. The pages are as follows: 
 
Ship and Target Tab: 
 
Ships Position Input:   
allows the user to specify the source of the surface support vessel's position.  Five 
selections are available, GGA, F-180 UDP Port, Fixed, Demo\Replay or IPS Remote Display 
UDP Input.  If GGA is selected the user may select the Use DGPS Only option, see 
below.   If the Fixed selection is chosen the user must enter the constant latitude and 
longitude of the surface support vessel in the edit box provided.  Select the desired setting 
by clicking the corresponding radio button. 
Note:  See the section above listing Typical IPS Equipment. 
 
        
Entering New Waypoints: 
 
When entering the fixed position the latitude and longitude must be in a specific format to 
be accepted.  This format is degrees, minutes and seconds. Acceptable formats are given 
below: 

 
Latitude 
N or S ## ## #### 
 
Longitude 
E or W ### ## #### 
Note:  The # symbol represents a 
number between 0 and 9.  However the 
minutes of latitude or longitude may not 
be greater than 60.  Degrees of latitude 
may not be greater than 90 and degrees 
of longitude may not be greater than 
180. 

 
The following are examples of 
unacceptable latitude and longitude 
entries. 
 

  N  95:04.3643  Degrees of latitude > then 90. 
  W 140:70:2891  Minutes Greater than 60. 
  - 080:58.0010  Region is entered as - not W. 
 

If the entered latitude or longitude is invalid (i.e. a latitude of more than 90 ) the latitude or 
longitude will be corrected automatically, and Fixed Position Invalid, Adjusted will be 
displayed in the IPS message box. 
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Use DGPS Only: 
If GGA is selected the user may select the Use DGPS Only option.  If Use DGPS Only is 
selected and differential GPS input with at least 4 satellites reporting is not detected then 
the GPS data will not be used.  If this is the case, DGPS Off Line and the time since the last 
valid DGPS input will be displayed in the ships position box instead of the ships 
name.  Some older GPS units do not output the status of the differential GPS in the NMEA 
output string, therefore if DGPS only is selected no GPS data will be accepted at all.  The 
IPS default is to disable Use DGPS Only. 
 
Use GPS Check Sum: 
allows the IPS software to use the check sum field of the GPS data string to verify that 
incoming data has not been corrupted.  If Use GPS Check Sum is checked, the check sum 
field of the incoming data will be used to authenticate GPS data.  The check sum is a field at 
the end of the data string that can be used by the receiving software to verify that a data 
string has not been corrupted during transmission. If the IPS determines that the incoming 
GPS data string has been corrupted a message will be displayed in the IPS message box and 
the data string will not be used.  The IPS default is to disable Use GPS Check Sum. 
 
 
ORE Data:                          
selects the type of acoustic tracking system being used.  The current selections available 
are None or the BATS system.  If BATS is selected a UDP port 5002 is automatically 
opened.  However Broadcast UDP should be selected as Output Device in the Trackman 
software.  See the IPS BATS Setup Procedure for more information.     
 
Use ORE Check Sum:                    
allows the IPS software to use the check sum field of the ORE data string to verify that 
incoming data has not been corrupted.  If Use ORE Check Sum is checked, the check sum 
field of the incoming data will be used to authenticate ORE data.   The check sum is a field 
at the end of the data string that can be used by the receiving software to verify that a data 
string has not been corrupted during transmission. If the IPS determines that the incoming 
ORE data string has been corrupted a message will be displayed in the IPS message box 
and the data string will not be used. 
 
Compass Tab: 
 
Compass Data:                             
selects the method of compass input to the IPS program.  The possible selections are none, 
NMEA VHW, NMEA HDM, NMEA HDT and NMEA HDG.  If the method of compass input is 
HDM or HDG the user should input the local compass variance.  See the section on INPUTS 
->SYSTEM INPUTS COMMAND - > Variance below for more information. 
 
Compass Time Out:                      
the user may select the time that must elapse without valid compass input before the 
program considers the compass to be non functional.  The options are 10 seconds, 30 
seconds, 1 minute, 2 minutes and 5 minutes.  If the user does not select a time, the default 
time of 1 minute will be used.  When the IPS software determines that compass input is 
non functional a dotted line will be used for the vessel outline instead of a solid line.  In 
addition, the error message "Error in compass input?" will be displayed at the bottom of the 
screen and COG will be displayed on the lower right of the screen next to the target's 
heading until valid compass input is received. 
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Use Compass Check Sum:             
allows the IPS software to use the check sum field of GPS data to verify that incoming data 
has not been corrupted.  If Use Compass Check Sum is checked, the check sum field of the 
incoming data will be used to authenticate GPS data.   The check sum is a field at the end 
of the data string that can be used by the receiving software to verify that the text string 
has not been corrupted during transmission. If the IPS determines that the incoming GPS 
data string has been corrupted a message will be displayed in the IPS message box and the 
data string will not be used. 
 
Offsets: 
 
Variance:                       
allows the user to enter the compass variance.  The maximum value for variance that may 
be entered is 45 degrees.  If the value entered is greater than 45, the variance will be 
changed to 45 degrees and an error message will be displayed. Only 'E' for east and 'W' for 
west may be displayed in the second Variance edit box. 
 
ORE Sound Velocity:             
allows the user to enter the ORE sound velocity.  This value must be between 1000.00 ms 
and 2000.00 ms.  The default value is 1500.00 
 
User Sound Velocity Profile:         
if the box is checked, the user sound velocity profile will be used.  The default is off. 
 
Ship Sound Velocity:                     
allows the user to enter the ship sound velocity.  This value must be between 1000.00 ms 
and 2000.00 ms.  The default value is 1500.00. 
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VRU/Depth: 
 
Remote VRU/AHRS:                               
the user may select one of the following: VRU none, ORE MRU (R/P) TSS1 Maretron 
$PMAROUT, ORE MRU (R/P/H) TSS HHRP $PRDID, KVH GyroTrk, CDL RLG MinRLG1 (Subsea 
DVL Nav) or Octans FOG $PSXN (Subsea DVL Nav).  The ORE MRU (R/P) TSS1 reports roll, 
pitch and heave and should be used with the standard ORE MRU system.  The ORE MRU 
(R/P/H) TSS option reports roll, pitch, heave and heading and should be used only if you 
have the ORE MRU package with the heading feature and want to get your heading from the 
MRU.  The default is VRU none.  The heading, pitch, roll and heave will be reported in the 
Ship Position Box. 
 
Use VRU Check Sum:                   
allows the IPS software to use the check sum field of VRU data to verify that incoming data 
has not been corrupted.  If Use VRU Check Sum is checked, the check sum field of the 
incoming data will be used to authenticate VRU data.   The check sum is a field at the end 
of the data string that can be used by the receiving software to verify that the text string 
has not been corrupted during transmission. If the IPS determines that the incoming VRU 
data string has been corrupted a message will be displayed in the IPS message box and the 
data string will not be used. 
 
Depth:                                          
allows the user to select the depth string used to input the target depth.  The choices are 
None, DBT (Depth Below Transducer) or DPT (Depth Below Transducer + Offset).  The IPS 
default is none. 
 
DBT Offset:                                    
allows the user to enter the DBT Offset.  This offset is the distance between the surface of 
the water and the transducer.  The number entered in the edit box will be added to the DBT 
depth.  This value must be between 0 meters and 30 meters (98.4 ft).  The default value is 
3 meters (9.8 ft).  The DBT Offset will be displayed in feet if the system units are feet, 
yards or nautical miles.  If the system units are meters then the DBT Offset will be 
displayed in meters. The system units may be changed using the VIEW->Display->Display 
Units   menu option.   Please note the units displayed next to the DBT Offset edit box when 
entering the depth. 
 
Use Depth Check Sum:                  
allows the IPS software to use the check sum field of Depth data to verify that incoming 
data has not been corrupted.  If Use Depth Check Sum is checked, the check sum field of 
the incoming data will be used to authenticate VRU data.   The check sum is a field at the 
end of the data string that can be used by the receiving software to verify that the text 
string has not been corrupted during transmission. If the IPS determines that the incoming 
VRU data string has been corrupted a message will be displayed in the IPS message box 
and the data string will not be used. 
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Chart 
 
Chart Open 
 
The Chart Open menu option allows the user to open a graphic chart (i.e. ESRA, Raster) 
that the IPS can display on and navigate over.   A dialog box displaying the current 
directory and all subdirectories containing chart files in that directory will appear. 
 
Map Properties 
 
Description:   a tag that describes the layer data or nature (data type) of the map. 
 
Map Layers:   allows user to select the layer that the following actions will be applied to. 
 
Disconnect:   disconnects or closes the layer so that layer is no longer part of the map.  To 

see that layer again you must reopen it. 
 
Properties:   the Layer Properties dialog box will be displayed allowing the user to view 

and/or edit the following properties of the selected layer: 
  

Visible:  toggles the layer from visible to hidden. 
Query:  gives permission to search for individual objects (points of interest) in  

the selected layer.  This feature will be implemented in the future. 
Paged:   this feature will be implemented in the future. 
Memory Based:   allows the user to choose to retrieve layer information from RAM or  

peripheral device (i.e. CD Rom). 
Minimum View Scale: allows the user to set the minimum scale used to draw the selected layer. 
Maximum View Scale: allows the user to set the maximum scale used to draw the selected layer.  
Area:  displays the coordinates in degrees of latitude and longitude of the north  

west (top) and southeast (bottom) of the selected layer. 
 
Center On:     allows user to select a portion of the layer to center on in the viewing area. 
 
To Top:          returns the view to the top of the map. 
 
Area:             displays the coordinates in degrees of latitude and longitude of the 

northwest (top) and southeast (bottom) of the entire map. 
 
Center X:      allows user to set an x coordinate used to center the entire map. 
 
Center Y:      allows user to set a y coordinate used to center the entire map. 
 
Scale:           allows user to set the scale for the entire map.  Entering a larger number will 

cause more of the map to appear in the viewing area.  Therefore each 
individual object will appear smaller. 

Rotation:      rotates the map in a clockwise direction relative to the north of the map in 
decimal degrees.  The view angle affects the view of the map only.  Image 
layers are not rotated.  Use of this feature is not advised. 

Scroll Bars:   toggles scroll bars on and off. 
 
Color Raster: toggles between gray tones and color.  This feature will be implemented in 

the future 
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Convert Layer Coordinate System 
 
Opens a dialog box that allows the user to select a vector data file to convert (i.e. state 
plane coordinate systems, UTM, U.S. state plane) to the IPS data format.  The vector data 
file that is not in the IPS format (WGS-84 latitude longitude) will be converted into a file 
that can used by the IPS.  A copy of the file will which has been modified to fit WGS-84 will 
be saved in the same directory as oldfilename_IPS.  The file may then be opened using the 
Chart -> Chart Open menu command. 
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Import Layer Properties 
 
The Layer Display Properties dialog box allows the user to set the viewing attributes of 
points, shapes and lines in a layer.  The Layer Display Properties must be set prior to 
opening the layer, or they will have no effect on the layer. 
 
 
Point Symbol:   
sets the symbol that will be displayed representing each point in the layer.  The available 
symbols are as follows: 
 

Solid Circle 
 
Solid Square 
 
Solid Diamond 
 
X 
 
Circle 
 
Circle - Dot 
 
Circle - Cross 
 
Circle - X 
 
Filled Cross 
 
Thumb Tack 
 
Triangle - Dot 
 
Triangle 
 
Solid Triangle 
 
Square - Dot 
 
Cross 
 
Airplane 

 
The IPS default is a solid diamond.  To see the symbol clearly 
use a larger point size. 
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Point Color:      
sets the color of the points in the layer.  The available colors are as follows: 
 

Black    
 
Light Gray   
 
Gray       
 
Dark Gray   
 
White    
 
Red  
 
Yellow  
 
Green   
 
Cyan     
 
Blue      
 
Magenta   
 
Dark Red     
 
Dark Green   
 
Dark Yellow   
 
Dark Blue    
 
Dark Magenta   
 
Dark Cyan   
 
Money Green 
 
Sky Blue 
 
Cream 
 
 

The IPS default is a sky blue. 
 

Point Size:         
sets the size of the points in the layer.  The size range is 1 to 20 and the default is 7. 
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Fill Style:         
sets the fill type that will be used to fill in certain shapes (i.e. polygons) in the layer.  The 
available fill styles are as follows: 
 

Fill Hollow 
 
Fill Solid 
 
Fill Horizontal 
 
Fill Vertical 
 
Fill F Diagonal 
 
Fill B Diagonal 
 
Fill Cross 
 
Fill Diagonal Cross 

 
The default is Fill Hollow. 

 
Fill Color:        
sets the color that will be used for certain shapes (i.e. polygons) in the layer.  The available 
fill colors are as follows: 
 

Black    
 
Light Gray   
 
Gray       
 
Dark Gray   
 
White    
 
Red  
 
Yellow  
 
Green   
 
Cyan     
 
Blue      
 
Magenta   
 
Dark Red     
 
Dark Green   
 
Dark Yellow   
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Dark Blue    
 
Dark Magenta   
 
Dark Cyan   
 
Money Green 
 
Sky Blue 
 
Cream 
 

The default is yellow. 
Line Style:        
sets the style that will be used for lines in the layer. The available line styles are as follows: 
 

Solid 
 
Dash 
 
Dot 
 
Dash Dot 
 
Dash Dot Dot 

 
The default line style is dash. 
 

Line Color:       
sets the color of the lines displayed in the layer.  The available colors as follows:                
 

Black   
 
Light Gray   
 
Gray       
 
Dark Gray   
 
White    
 
Red  
 
Yellow  
 
Green   
 
Cyan     
 
Blue      
 
Magenta   
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Dark Red     
 
Dark Green   
 
Dark Yellow   
 
Dark Blue    
 
Dark Magenta   
 
Dark Cyan   
 
Money Green 
 
Sky Blue 
 
Cream 

 
The default is light gray. 
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View 
 
Display Settings 
 
A dialog box allowing the user to set the following display parameters will appear when this 
option is selected: 
 
Grid Style:                         
selects one of four available styles of viewing display. The chart mode should be used when 
an outside vender raster or vector chart has been loaded in using the CHART->Chart 
Settings menu command.  The grid mode shows both the ship and target in terms of their 
geodetic latitude and longitude positions.  The grid mode is scaled in latitude and longitude 
with true north at the top of the screen.  Two of the displays have the ship centered at all 
times and display the target either relative to the ship's bow (heading up) or relative to the 
compass's north (north-up).  When a target(s) is displayed relative to the ship's bow both 
filtering capabilities and the track plot line are disabled.  When a target(s) is displayed 
relative to the compass's north the maximum number of data points displayed is 15.   
 
Grid Format:                                 
allows the user to select the way the latitudes and longitudes will be displayed on the edge 
of the view screen.  The options are as follows: None, the latitudes and longitudes will not 
be displayed.  Degrees, the latitude and longitude will be displayed as degrees and 
fractional degrees in the following format: ##.####.   Degrees minutes seconds, the 
latitude and longitude will be displayed in the following format: ## ## ##.  Degrees 
minutes fractional minutes the latitude and longitude, minutes and fractional minutes will be 
displayed in the following format ###.##.###. 
 
Display Units:                               
sets the display units to feet, yards, meters or nautical miles.  If the units selected are feet, 
yards or nautical miles the depth will be displayed in feet.  If the units selected are meters 
the depth will also be displayed in meters.  The full scale edit box will be changed to reflect 
any change in display units.  In addition, if the units selected are meters, the display units 
will automatically change to kilometers when the display scale is increased beyond 1000 to 
1500 meters. 
 
Heading Up\North Up Scale:          
sets the maximum size for the graphical display area when in north-up or heading-up.  Use 
the dropdown list box to select the maximum display size.   The minimum size available is 
200 feet and the maximum size available is 12,000 feet.  The selections in the dropdown 
box are in the units set in DISPLAY SETTINGS-> Display Units. 
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Show Toolbar Command 
 
The IPS ToolBar is a row of icons that represent IPS menu commands.  Selecting this option 
will display the IPS ToolBar if it is hidden and hide the IPS ToolBar if it is visible.  Clicking 
one of the icons is a faster alternative to choosing a command from the menu. If the IPS 
ToolBar is currently being displayed check mark will appear next to the Display ToolBar 
Menu option.  
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Night View Command 
 
Sets the screen, Ship Position box, Target Position box, IPS Message Box and Search Box 
backgrounds to black so the IPS screen is easier to view in dim light.  The text inside the 
text boxes mentioned previously, gridlines and grid label will be set to white.  The user will 
be given the option of setting the waypoints to white, otherwise they will remain their 
current color. When switching back to regular view the waypoints will all be displayed in red 
if the user set them to white in night view.   If the IPS is currently in Night View mode a 
check mark will appear next to the Night View Menu option.  To access night view use the 
VIEW->Night View menu option.  
 
Show Waypoint Box Command 
 
The IPS Waypoint Box allows you to enter the latitude and longitude and a memo for up to 
200 Waypoints.  Selecting this option will display the Waypoint Box if it is hidden and hide 
the Waypoint Box if it is visible.  The default placement of the Waypoint Box is in the middle 
right portion of the screen just outside the plot area.  The Waypoint Box can be dragged to 
different position on the screen if desired.  If the Waypoint Box is currently being displayed 
check mark will appear next to the Show Waypoint Box Menu option.  
 
Also See: 
 
Waypoint List Window 
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Cursor Waypoint Activated 
 
If the Cursor Waypoint Activated option is on the user will be allowed to add waypoints by 
left mouse clicking the portion of the grid corresponding to the desired waypoint 
location.  The number of the new waypoint will be displayed in red on the grid.  If the 
Waypoint Box is currently being displayed, the new waypoints latitude and longitude will be 
shown in the Waypoint Box.  The new waypoints latitude and longitude will be displayed in 
the latitude and longitude edit boxes in the waypoint box.  The latitude and longitude may 
be edited at this time and a memo may be added if desired.  If the Cursor Waypoint 
Activated option is on a check mark will appear next to the Cursor Waypoint Activated Menu 
option. 
Range and Bearing Calculator 
 
The Range and Bearing Calculator menu command displays a window that calculates and 
displays the Range, Bearing and Speed Made Good between two waypoints.  The Range is 
the distance between the two waypoints.  Speed Made Good is the Range in nautical miles 
divided by the time difference between the two waypoints.  The Bearing is the direction or 
heading with respect to true north.  
 
To select the two waypoints to be used in the calculations, use the combo boxes labeled 
Waypoint 1 and Waypoint 2.  Click the arrow on the right of the combo box and a list box 
with all the waypoints will be displayed.  The waypoint number will be displayed at the far 
left of the list box entry, followed by the waypoint latitude and longitude.  When scrolling 
through the list of waypoints the memo corresponding to the waypoint will be displayed in 
the static box directly above the combo box.  To select a waypoint use the mouse or the 
arrow key to scroll through the list of waypoints.  Then either mouse click on the waypoint 
or hit the enter key to choose a waypoint.  To calculate and display the Range, Bearing and 
Speed Made Good click the Cal push button.  To clear the display, click the Clear push 
button. 
 
As two unique waypoints must be selected for Range and Bearing calculation, this menu 
command will be disabled until at least two waypoints have been entered.  Waypoints may 
be entered using the Cursor Waypoint Activated menu option or the Waypoint List Window. 
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Survey Lines 
 
Allows the user to create survey lines for navigational use.  The user must enter a valid 
start and end waypoint.  Please see the Waypoint List Window or   Cursor Waypoint 
Activated section of this manual for more information. 
 
Two unique waypoints must be selected for the survey lines feature to be used and the 
selected waypoints must be at least 1.0 meters apart. 
 
Start Waypoint:        
selects the beginning waypoint used to create the survey lines.  Click the arrow on the right 
of the combo box and a list box with all the waypoints will be displayed.  The waypoint 
number will be displayed at the far left of the list box entry, followed by the waypoint 
latitude, longitude and memo.  To select a waypoint use the mouse or the arrow key to 
scroll through the list of waypoints.  Then either mouse click on the waypoint or hit the 
enter key to choose a waypoint. 
 
End Waypoint:                           
selects the end waypoint used to create the survey lines.    
 
Spacing:     
sets the space in meters between each line.  The maximum allowed space between the 
survey lines is 5000.00, the minimum is 1.00 and the IPS default is 25.0 meters. 
 
Number of Lines:                   
sets the number of survey lines.  The maximum number of lines allowed is 100, the 
minimum is 1 and the IPS default is 10. 
 
Directions:                                    
allows the user to select whether the survey lines will be to the left or right of the 
waypoints.  The IPS default is left. 
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System Calibration 
 
The System Calibration feature calculates and displays the overall azimuth error in the 
system and gives the scaling factor to correct the raw slant ranges.  These system 
calibration parameters can be saved in the configuration file.  The last set of System 
Calibration parameters that have been saved in the configuration file will be displayed in the 
System Calibration dialog box when it is initially activated.   If no System Calibration 
parameters have been saved to configuration file, the System calibration parameters will all 
be zero.  
 
The QC Threshold edit box may be used to determine the quality of the data used in the 
calibration.  The higher QC factor entered, the stricter the criteria is for selecting the data 
used for calculating the calibration.  The options are 1 through 10 and the default setting is 
8.    
After a successful calibration the Calibration Dialog box will be displayed showing the new 
Calibration parameters.  If $POREG data is being used as ORE data enter the Hydrophone 
Mounting Angle Offsets into the Calibration Dialog box.  To apply these offsets click the 
Update Hydro Offsets push button.  To view the before and after Calibration Frequency Plots 
click the 3D Viewer Button.  
 
Please see the following sections of the IPS Manual for more information on the system 
calibration: 
 
Equipment Offset Measurement 
 
Sheltered Water Calibration 
 
IPS Off-Line USBL Calibration Procedure 
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Weather Station 
 
The Met Station dialog box displays true or relative direction and wind speed as well as the 
current temperature, pressure and percent relative humidity. It uses weather data from an 
Airmar Weather Station 200WX (or comparable device that outputs NMEA $IIMDA and 
$IIMWV files) aided by the ship’s navigation data.  
 

 

 
 

Relative or True Indicator Button: 
 

  The user can toggle between true and relative wind speed by clicking on the 
indicator button, T means true 
R means relative this selection will be reflected in the wind speed indicated by the 
red button, the wind speed displayed in the green rectangle and the wind speed 
displayed in knots. 

 
Wind Speed Display: 
Displays the wind speed in knots in the upper right hand corner of the display. 
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Compass Rosette: 
 

     Current wind direction is indicated by small red square on compass, it can be 
displayed in either relative or true depending on the Relative or True Indicator 
button setting. 

 
     The 2 minute average wind speed is indicated by small cyan square on compass. 

This is always displayed as True. 
 

     The ship’s heading is indicated by the yellow square on the compass. 
 

   The current wind direction is displayed in the green rectangle in the center of the 
compass.  

 
Temperature Button:  
Displays the temperature in either Fahrenheit or Celsius. Click the temperature button to 
toggle between Fahrenheit or Celsius. 
 
Pressure Button:  
Displays pressure in millibars.  
 
Relative Humidity Button: 
Displays relative humidity. 
 
Two Minute Ave Button: 
The 2 minute average wind speed is displayed. This is always displayed as True. 
 
10 Minute Gust: 
Will display the 10 minute wind average. Not operational yet. 
 
Recorded Data Format 
The IPS automatically outputs MET data in the following format: 
 

 ·Comma separated text file with header 
 ·Data is saved with other IPS files see File Save Command (the default directory is 

usually   ORE Offshore\IPS). The file is named METlog YEAR-MO-DY_HR-MN-SEC.txt.  
 ·Collected and time stamped at one second intervals. 
 ·Ship position, heading, course and speed. 
 ·Relative wind speed and direction. 
 ·True wind speed and direction are 2 minute averages for both. 
 ·Gusts at 14 kts and above. 
 ·Temperature (Celsius), Relative Humidity and Pressure (millibars). 

 
Header and Example Data: 
Type,DateTime,Lat,Long,ShipHead,COG,SOG,RelWndSp,RelWndDr,TrWindSp,2minAVG,TrWindDr,AVGWindir,G
UST,TempC,RH,MB 
$PIMET,2013-03-04 
16:18:00,27.7620778,-82.6293364,274.62,0.00,0.03,7,143,6,5,57,55,0,11,30,1023 
$PIMET,2013-03-04 
16:18:01,27.7620778,-82.6293364,274.62,0.00,0.08,6,145,6,5,59,55,0,11,30,1023 
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3D Plot 
 
The IPS 3D data display allows a user to load ASCII X,Y,Z text files into a 3D display 
environment.  A concise pop up menu that is activated by right clicking on the 3D display 
window has the following options: Home, Center, Rotate, Zoom, Pan, Info, Make Wpt, Load 
File, Add Data File, Make VRML File, Save as BMP and Clear Plot. 
 
Show IPS Messages Command 
 
If the Show IPS Messages option is activated any messages generated by the IPS software 
or the ORE system will be displayed in the IPS Message Box.  These messages include 
messages from the ORE system such as target tracking errors, telemetry errors and 
warning messages.  The IPS messages include the latitude and longitude of new waypoints 
and filtering errors.  The IPS message window can hold twenty messages, however the 
scroll bar must be used to view messages beyond the latest five.  If the scroll bar is not 
visible and more five messages have been displayed, expand the window by dragging the 
right border of the window further right.  
 
Selecting the Show IPS Messages option will display the IPS Message Box if it is hidden and 
hide the IPS Message Box if it is visible.  The default placement of the IPS Message Box is in 
the middle right portion of the screen just outside the plot area.  The IPS Message Box can 
be dragged to different position on the screen if desired.  If the IPS Message Box is 
currently being displayed check mark will appear next to the Show IPS Messages Menu 
option.  
 
Show Ship Position Box 
 
If the Ship Position Box is not showing clicking this menu option will display the Ship 
Position Box.  If it is showing, clicking this option will hide the Ship Position Box.  If a check 
mark is visible on the left of this menu option the Ship Position Box is being displayed. 
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Search Data Settings 
 
The Search Data Settings Dialog Box allows the user to select the information that will be 
displayed in the Search Position Box.  The information that can be displayed about the 
selected data point includes: the targets or ships latitude, the targets latitude, the targets 
depth or compass position and the time the data point was acquired.  To set the data to be 
displayed in the Search Position Box toggle the corresponding check box.  If the box is 
checked, the value will be displayed in the Search Position Box.  Time, Lat\Long and Depth 
and Altitude are defaulted to on. The following are the possible values that may be 
displayed:  
 
 
Time:                         
Data point time tag. 
 
Latitude:                    
Latitude of current fix in N or S in ##:##.#### format. 
Longitude:                 
Longitude of current fix in E or W in ###:##.#### format. 
 
UTM:                         
  UTM Northings and Eastings. 
 
Depth and Altitude:            
The ship's depth sounder value and heading sensor (Gyro) data if valid.  For a target the 
depth below the surface and altitude the above the bottom as reported by the altimeter (if 
available). 
 
Heading, Roll Pitch:                  
Compass heading roll and pitch. 
 
COG\SOG:                  
Current COG\SOG of the data point. 
 
Horz Range, Relative & True Bearing:                      
For the targets only: Horz Range- The range from the ship to the target along the surface of 
the water (Horizontal plane). Relative bearing- The bearing of the target with respect to the 
ships bow (center line, Off the Bow 000 deg, Starboard beam 090 etc.).  True Bearing- The 
bearing to the target with respect to true north. 
 
X,Y,Z:                          
The individual components that define the vector to the target from the ship.  Horz Range = 
(x^2 + y^2)^1/2, Z = depth. 
 
Error Code and Message:                              
Ship-The number of satellites used to determine the GPS position. Target-ORE Error code 
and  message. 
 
CTD Time, Depth and Temp:   
     
CTD Salinity and Sound Velocity:  
      
DVL COG/SOG:    
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DVL Water Speed and Direction:        
 
DVL Altitude and Speed of Sound: 
 
For more information please see: 
 
Search 
 
Search Mode 
 
If the Search Mode option is enabled the user can search through the currently displayed or 
any loaded data file.  A search position window will also be displayed in the center of the 
screen with position information about the selected data point.  
 
To activate the search mode use the VIEW drop down menu and select SEARCH MODE.  If 
the Search Mode is enabled a check mark will be displayed to the left of the menu 
item.  Once Search mode is activated, use the right mouse button to select a data point.  If 
the right mouse button is clicked and a valid data point is within 48 miles, the data point's 
position information will be displayed in the Search position information window.  Please see 
the OPERATIONS SEARCH section of this manual for more information about searching data 
points.   Use the focus button in the Tool Bar to select the target or ship whose data will be 
searched.  
 
This menu option is disabled (grayed out) if the Display Mode is either North - Up or 
Heading - Up.  To enable the SEARCH MODE menu option use the DISPLAY menu option in 
the VIEW pull down menu, and select either Chart or Grid as Grid Style.  Please see section 
on the VIEW -> Display Settings menu option in this manual for more information. 
 
Mission Statistics 
 
The Mission statistics box provides general information about the ship and each target 
currently being tracked or loaded into the system.  Id 10 represents the tracking vessel and 
the IDs 1-9 correspond to the ORE targets.  The mission information dialog box may be 
accessed using the VIEW -> MISSION STATICS menu command.  When the Mission Statics 
dialog box is enabled a check mark appears next to the Mission Statistics menu item.  The 
information format is as follows: 
 
Target No.          No. Points          Start Time           Stop Time         Max Depth in Meters 
 
Target No:                                 Min Latitude        Max Longitude 
 
Target No:                                 Max Latitude       Max Longitude 
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Filter Menu 
 
Filter Command 
 
A window allowing the user to set various filtering parameters will appear when this option 
is selected.  To edit a targets filter parameters select the target number from the target 
number list box using the mouse or the arrow keys.  The current filter parameters for that 
target will be displayed in the filter window controls.  Change the filter parameters to the 
desired settings.  To set the new filter parameters click the Apply button or the Ok 
button.  The Ok button will save the filter settings for that parameter and exit the program. 
The Apply button will save the filter settings for that parameter but not exit the 
program.  To set the filter parameters for more than one target at once, you must select 
the target number using the list box, change the desired settings and click Apply for each 
target. 
 
Note: The Max Range, Min Depth and Max Depth settings are the same for each 
target.  For example, changing the Max Range, Min Depth and Max Depth filter parameters 
for target number 1 will change the Max Range, Min Depth and Max Depth to the new 
settings for all targets. 
 
Please note the Alpha Beta and On Site filters may not be used at the same time.  However 
either Alpha Beta or On Site may be used with the Velocity filter.  In addition Alpha Beta, 
On Site and Velocity may not be set to on (checked) when Raw is selected.  If the Raw 
check box is clicked, the Alpha Beta, On Site and Velocity filters will be automatically set to 
off.  If the Alpha Beta filter is selected, both the On Site filter and Raw or will automatically 
set to off.  If the On Site filter is selected, both the Alpha Beta filter and Raw or will 
automatically set to off.  However the Max Depth, Min Depth and Max Range filters may be 
used when Raw or any of the other filters are selected. 
 
IPS Target:                 
allows the user to select which of nine possible targets the filter data will be applied to.  The 
type of filter used for a target will be displayed after the target name in the target position 
box in the lower right hand corner of the screen.  For example if raw data is being used for 
target number one Fish, then only Fish will be displayed as the target name in the target 
position box.  If the velocity filter and on-site filter are set to on then Fish FVO will be 
displayed as the target name.  If the target name exceeds 16 characters then the last 4 
characters of the target name will be truncated to make room for the filter information if 
necessary.  The Max-Range, Min-Depth and Max-Depth settings will not appear after the 
target name as they are not specific for each target.  For more information see the Target 
Position Box section of this manual. 
 
System Units:                         
displays the current system units.  This setting cannot be changed from this dialog box.  To 
set system units select Display Settings from the View Menu and select the appropriate units 
under the Display Units option. 
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Raw Data:                       
all useful BATS data is saved without any IPS software filtering at a rate determined by the 
output rate of the instrument used to track the target(s) or ship.  See the section File Save 
Command in the FILE MENU portion of the IPS help for further information.  The data is 
displayed in the target information box in the lower right portion of the screen.  If the most 
recently acquired data point is fully acceptable the highlighted portion in the box reads 
"OK".  Otherwise the most recently acquired data point has been rejected or is 
questionable.  In this case an error or warning message corresponding to a BATS error code 
or warning message will be displayed in the highlighted portion of the target information 
box. Only the Max Range, Min Depth and Max Depth are available if Raw Data has been 
selected. 
 
Velocity: 
the total linear distance between the last accepted data position and the newly acquired 
data point is calculated.  If the current position is unreasonable based on the maximum 
target velocity entered and time between acquiring of the data points the new data point 
will be discarded.  The error message "Geo Vel" will also be displayed in the target 
information box.  Use of this filter is appropriate at all times.  Allowing the IPS software to 
control velocity filtering instead of the BATS is advantageous because the IPS calculates the 
total linear distance between the data points using the geodetic positions of the target.  The 
BATS calculates the velocity between two points based on the relative heading of the 
ship.  Therefore a rapid change in the heading of the ship could cause a valid data point to 
be rejected.  If a data point is rejected by the BATS system error code 5 "excessive target 
velocity" will be displayed in the dialog box.  The IPS software also allows adjustment of the 
maximum velocity of the target used in velocity filtering.  Select Velocity and enter the 
maximum velocity in the edit box provided next to the Velocity option.  The minimum 
maximum target velocity allowed is 0.25 knots.  The largest maximum target velocity 
allowable and the default maximum velocity are both 10 knots.  When using the BATS for 
velocity filtering the maximum target velocity used is nominally 4.5m/sec (8.7 knots). 
 
Alpha-Beta:                     
filter is equivalent to a first order Kalman filter.  The range and bearing values from the 
BATS system are processed for an improved estimate of the range, bearing and velocity of 
the target relative to the surface support ship.  This filter is best used to track an active 
target moving in a predictably.  For example for a target moving in a preprogrammed 
manner at a relatively slow speed such as an side scan sonar the Alpha Beta filter could be 
set at 80% or higher.  For a target moving in a less predictable manner and a higher rate of 
speed such as ROV the Alpha Beta filter should be set to less than 80%.  Enter the desired 
Alpha Beta percent in the edit box provided next to the Alpha Beta option.  The minimum 
percentage that may be entered is 0 the maximum number of seconds is 99.  The default 
value is 50. 
 
On-Site:                           
the filtering of the positional data acquired for a submerged target is done in order to 
improve the displayed positions.  By rejecting any data point(s) that are statistically 
different from the majority of the data points collected in the user selected period, based 
upon a Chi square distribution with two degrees of freedom (df=2).  On Site filtering should 
be used if the target is known to be at one location ==> "on-site".  Enter the number of 
seconds for the selected period in the edit box provided next to the On Site option.  The 
minimum number of seconds that may be entered is 2 the maximum number of seconds is 
60.  The default value is 20. 
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The filtering model utilized, for the improvement of a submerged target's display is based 
upon the following conditions: 1) The latitudes and longitudes are normally distributed 
about the mean latitude and mean longitude. 2) The existence of independence; the 
squares of distances are Chi Square distributed.  Once the data has be filtered the 
individual data points are then reduced using a "Maximum-Likelihood" estimation.  This 
process calculates weighting factors for each data point to give more influence to data 
points that are closer to the mean latitude and longitude. 
 
DVL Aided:                        
if enabled (checked) and if real time DVL data is coming in the DVL course and speed over 
ground data will be used to remove scatter in the USBL data.  Not implemented at this 
time. 
 
Depth Offset:                    
allows the user to enter the Depth Offset used in filtering.  The Depth Offset must be 
between 32.81 feet and -32.81 feet (10.00 to -10.00) meters.  The default is 0.00. 
 
Depth Scale Factor:         
allows the user to enter the Depth Scale Factor used in filtering.   The Depth Scale Factor 
must be between 10.00 to -10.00.  The default is 0.0000. 
 
Max Range:                     
the maximum range the target can be from the surface support vessel.  Any BATS data 
received that has the x, y, or Horizontal range greater than Max Range is rejected.  The 
minimum range allowed is 0 feet.  The maximum range allowed and the default value are 
both 13120 feet (4000 m).  Enter the maximum range in the edit box provided. 
 
 
Min Depth:                        
the minimum depth that will be accepted from the BATS system.  If the depth from the 
current reading is less than the Min Depth setting in the IPS software the reading is 
rejected.  The minimum depth allowed and the default value are both 0 feet.  The 
maximum Minimum Depth allowed is 10000 feet (3048 m).  Enter the Minimum Depth in 
the edit box provided. 
 
Max Depth:                   
the maximum depth that will be accepted from either the BATS system.  The maximum 
depth that may be entered and the default value are both 10000 feet (3048 m).  The 
minimum depth is 0 feet.  Enter the Maximum Depth in the edit box provided. 
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Setup Menu 
 
Sailplan Settings Command 
 
A dialog box allowing the user to set the following waypoint parameters will appear when 
this option is selected: 
 
Run\Start:       
enables or disables the current sailplan.  When Run is checked and either the Apply or OK 
sailplan configuration buttons are pressed, a message box asking the user if they want to 
begin a sailplan for that target is displayed. To start the sailplan click the OK button in the 
message box.  If a sailplan is running, the sailplan will be displayed in the bottom portion of 
either the ship or target position box.  The range, bearing, XTE (cross track error, see 
below) TTG (time to go) and ETA of the waypoint currently being navigated to will be 
displayed.  
 
When Run is checked and a sailplan is already running for that target, a message box 
asking the user if they want to reset the sailplan for that target is displayed. To reset the 
sailplan click the OK button in the message box.  Resetting the sailplan will allow any 
changes made to the sailplan configuration (i.e. Display Cross Track Error Lines, Line Style) 
to be applied.  The cross track error will also be reset. 
 
If a sailplan is running and the run check box is toggled to off, a message box will appear 
warning the user that the current sailplan will be terminated.  To terminate the current 
sailplan click yes.  To continue running the current sailplan click no or press the enter key. 
Note:  If the sailplan direction is single, the sailplan will be terminated.  To restart 
navigation to a single waypoint, open the Waypoint List window, select a waypoint and click 
the Goto push button. 
 
Direction:                     
the direction setting tells the router how the waypoints should be used, which waypoints 
should be used and what order they should be used in.  The options that may be selected 
are as follows: 
 
Forward -             
the router will go through the waypoint list from top to bottom of the list using any 
waypoint that is not a marker.  The router will store the waypoints in a separate list and run 
the sailplan using this list.  This direction is the IPS system default. 
 
Reverse -     
the router will go through the waypoint list from the end of the list to the beginning of the 
list using any waypoint that is not a marker. 
 
Track:                  
allows the user to choose to display the ship's intended course between all waypoints or not 
to display the course at all.  None is the IPS system default. 
 
XTE Lines:         
the cross track error or XTE lines will be displayed only if XTE lines is enabled (on). 
 
Course Line:          
enables or disable the line displaying the ships current course. 
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Include Markers:          
enables or disables the marker display. 
 
Criteria:  
tells the sailplan manager how to determine if a given waypoint has been reached.  The 
following options are available: 
 
 

Radius -                the sailplan manager will compare a 
targets (ship's) current position to 
that of the waypoint position.  If the 
range between the two is less than 
or equal to the value specified by 
the menu selection Radius then the 
waypoint has been reached. 
Note: With this selection it is very 
possible to "miss" a waypoint by 
passing it to one side or the 
other.  This often occurs when the 
vessel must maneuver to avoid 
other traffic. 
 

Plane-                   the sailplan manager will consider a 
waypoint reached if the vessel 
breaks a plane that is perpendicular 
to the desired course. 

 
Radius and Plane -  the sailplan manager will consider a 

waypoint reached if either the vessel 
breaks a plane that is perpendicular 
to the desired course or the vessel 
gets within the radius of the 
waypoint. as specified by the menu 
selection Radius. 
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Cross Track Error:                  
the XTE or cross track error is the perpendicular great circle distance from the vessel's 
present position to the desired course.  The menu selection XTE allows the user to specify 
how far from the desired course to display the cross track error lines. The minimum cross 
track error that may be entered is 0.00 nautical miles. The maximum cross track error that 
may be entered is 9.999 nautical miles.  The XTE lines and value are used only for display 
purposes. The default value is 0.100 nm. 
Note: The XTE lines will only be displayed if the Waypoint dialog box menu selection XTE 
lines: on is enabled (on).  The default value is 0.100 nm.  The desired course can be reset 
at any time 
 
Radius:                                  
allows the user to specify the size of the radius around each waypoint.  The vessel must 
pass within the distance of the radius around the waypoint for the sailplan manager to 
consider the vessel has reached that waypoint.  The minimum radius that may be entered is 
0.00 nautical miles. The maximum radius that may be entered is 9.999 nautical miles.  The 
default radius is 0.050 nautical miles.  Enter the appropriate radius size in the edit box 
provided. 
 
Line Color:                    
clicking this button displays a dialog box that allows the user to set the color of the 
Waypoint and Cross Track Error lines. 
 
Line Style:                    
allows the user to select which line style will be used for the Waypoint lines.  The options 
are Solid, Dash, Dot, Dash Dot and Dash Dot Dot.  The default is solid. 
 
Line Size:                            
allows the user to select which line size will be used for the Waypoint lines.  The options are 
1-20 and the default is 1.   
 
 
See Also: 
               Waypoint List Window 
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Serial Out Command 
 
A dialog box allowing the user to set the Serial Out parameters will appear when this option 
is selected.  The dialog box is composed of three pages each represented by a tab. The tabs 
are standard, Acoustic Modem and TC-100 Settings.  To move from page to page click the 
appropriate tab.  
 
Standard: 
 
Port Selection:   
allows the user to select any currently open port as an output port.  If the upper portion of 
the combo box displays a 'No Ports Open'  message use the SETUP-> Communications 
menu command to open at least one serial port or use SETUP->Ethernet Configuration 
menu command to open at least one UDP port.  The port number currently selected is 
displayed in the upper portion of the combo box.  To select a different port number click the 
arrow button on the right side of the combo box.  A dropdown box displaying all open ports 
will appear.  Select a port using the mouse or the arrow keys.  The settings listed below are 
applied to the port number selected in this combo box.  The apply button may be used to 
set serial out parameters without exiting the Serial Out dialog box. 
 
Priority Target ID:         
allows the user to select which of multiple targets will be associated with the selected 
port.  The selections are 1 through 10, with 1 to 9 being targets and 10 being the ship. 
Verify that the correct target ID is set or inappropriate data or no data may be sent.  The 
following data strings: GGA2, TTMT, WHOI AM, RMC, Fledermaus, GGA\VTG\HDT, SCT 
Video, HDT, DBS, GGA\TLL\VTG, TC-100,  Platform (Echo Scope) Nav Data and 
GGA\ZDA\VTG   require a priority target to be selected because they do not have a target 
ID field. Any target ID is valid with the majority of the NMEA options, but TTMT and SCT 
Video require a subsea (non ship) target.  In addition the ship (ID 10) is the only ID 
allowed with the WHOI AM option.   It is not necessary to set the target ID if the Remote 
IPS option is selected as the Remote IPS Display sends out all valid target data.  Please see 
Serial Out ID Selection for more information.  Enter the appropriate target number in the 
edit box provided. 
 
Check Sum:  
allows the user to enable or disable the check sum field.  A check sum is a field at the end 
of the data string that can be used by the receiving software to verify that the text string 
has not been corrupted during transmission.  If the check sum is enabled an asterisk will be 
displayed after the text string format selected.  The check sum may not be used if SCT 
Video is selected for NMEA output, therefore the check sum will be disabled (grayed out) if 
SCT Video is selected. The check sum is required for the RMC string according to the NMEA 
manual. 
 
GPS Echo:  
enables the output of GGA, VTG and ZDA strings through the port selected as the output 
port.  A port must be open for a GPS Echo to be output.  Please see the Communications 
section of this manual for more information.  
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Data Rate:  
allows the operator to select the IPS data output speed.  The options are Fastest (when 
available), Moderate (5Hz or less), Slow (1 Hz or less). The default is Fastest.  The age of 
the receiving piece of equipment should be considered when making the data rate 
selection.  For example an older side scan may need to receive data at a low rate (> 
5).  The data rate selection doesn't increase the data output speed, it just limits it when one 
of the two slower options is selected. The data rate will be automatically set to slow (1 Hz or 
less) for the RMC string.         
 
Output Data Format:   
allows the operator to select a National Marine Electronic Association (NMEA) or NMEA like 
format for the serial output or to disable serial output.  Click the appropriate radio button to 
select one of the 20 formats or to disable serial output.  The 19  options for NMEA serial 
output are  None, GGA 2.x, TTMT, WHOI AM, TPD (Target Position & Depth), RMC,  TP 2EC, 
TLL, Fledermaus (Platform Positions), GGA/VTG/HDT, SCT 50 Video, HDT (True Heading), DBS 
(Depth Below the Surface), GGA/TLL/VTG, TC-100 Video Time Code Sync, Link Quest DVL 
(Enable Tx), Platform (EchoScope) Nav data and Remote IPS Display ($PIUDP), 
GGA/VTG/VTG, Ext Trigger USBL (UDP).  Please see the NMEA Summary section of this 
manual for more detailed information on serial output formats. 
•   Note: The following serial output strings: GGA, TPD, TLL and Remote IPS Display 

($PIUDP) have target location data values that are also independent of the reference 
location.  However the locations of the serial output string TTMT is with respect to the 
reference location if it is enabled.  If the reference location is enabled the word 'ref' will 
be displayed in the target position box. 

•   Note: When the TPD format is selected as NMEA serial output the target's depth will be 
given in the current IPS system units.  This means the target's depth will be expressed 
in meters if meters are the current system units and feet in all other cases. 

  
 
Using the SCT Video Feature: 

The SCT Video selection will display text onto a 
video image in real time.  To use the IPS SCT 
Video feature follow the instructions listed below.  

 
1.  Open the appropriate port with a baud rate of 

9600 using the SETUP -> Communications 
menu. Please see the Communications section 
of this manual for more information. 

 
2.  Select SCT Video as the SERIAL OUT ->Output    

Data Format. 
 
3.  Set SERIAL OUT -> Priority Target to number 

of the target that is being tracked.  This must 
be done, or no data will be sent out to the 
video image. 

 
4.  Set the hardware ID on the SCT-50 to 01. 
 
5.  Remember that if SCT Video is selected 

SERIAL OUT -> Check Sum and SERIAL -OUT 
-> GPS Echo cannot be used. (grayed out). 
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The text displayed when using the SCT Video 
includes the latitude, longitude, PC time, depth 
reported by the depth sounder and depth of the 
priority target. The targets latitude and longitude 
are displayed on the upper left of the screen.  The 
targets depth is displayed in the upper right of the 
screen.  The PC time is displayed in the lower left 
of the screen and the depth below the ship in the 
lower right.  The depth below the ship is supplied 
by its depth sounder via the NMEA string DBT in 
units of feet.  The current PC time is adjusted by 
the Zone Description.  
 
The Horita Serial Control Titler model number 
SCT-50 may be used as an interface device to send 
the IPS output string to video device.  From more 
information on the SCT-50 contact Horita at the 
following address: 
 
Horita 
 
P.O. Box 3993 
Mission Viejo, CA 92690 
(714) 489-0240 
www.Horita.com 
 
 

 
PAL Format:  
allows the user to set PAL format to on or off.  If the check box is checked PAL format will 
be used when sending out SCT Video data.  This setting has no effect if SCT Video has not 
been selected as the Output Data Format.  The default setting is off. 
 
Output Display: 
Opens a window that displays all serial out data.  The window will remain open when the 
Serial Out dialog box is closed. 
 
Acoustic Modem: 
 
Acoustic Modem Tracking: 
this check box must be on (checked) to allow acoustic modem tracking to occur. 
 
Range: 
when the Range push button is clicked the slant range is calculated by interrogating the 
micro modem.  The transponder is not used in the calculation and the bearing information is 
not provided.  The answer is displayed in the edit box to the right of the range push button. 
 
Bluefin AUV Commands: 
The following three AUV commands are only enabled if Acoustic Modem Tracking check box 
has been selected. 
Return-Transit to End: 
The AUV will return to the last mission waypoint. 
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Stop Kill Tailcone: 
Disables power to the AUV tailcone(thruster) and the AUV will float to the surface if it is 
positively buoyant. 
Drop Weight: 
Starts the dropweight process for the AUV. 
 
End Mission: 
not available at this time. 
 
USBL Track Time/Cycle: 
determines how long the USBL tracking continues before an acoustic modem command is 
sent out.  You would only get on possible ping once the target if the track time is set to the 
minimum (2 seconds). 
 
Target USBL ID: 
allows the user to select which of the USBL targets will be used to send a type 28 message 
to the acoustic modem.  The type 28 message consists of the ships position data and the 
USBL's geodetic position and a position error estimate. 
 
Vehicle Status: 
query to send back vehicle status. 
 
Sub INS ID: 
allows the user to assign an unused ORE target number to a target position coming from an 
acoustic modem. 
 
Modem Configuration: 
opens the Modem Configuration dialog box. 
 
Target Ship Configuration: 
opens the Target Ship Configuration dialog box. 
 
TC-100 Settings: 
This tab allows the user to set the variables that effect the TC-100 video overlay 
appearance. 
 
TC-100 Font Size: 
Allows the user to set the font size on the TC-100 video overlay. 
 
TC-100 Screen Position:  
Allows the user to set position of the TC-100 video overlay to the top or bottom of the 
screen. 
 
TC-100 on Screen Display: 
If enabled (checked) the TC-100 information will be displayed on the screen. 
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Sync TC-100 Time to PC Clock: 
If this check box is enabled the TC-100 time is synchronized with the PC clock. 
 
Apply TC-100 Settings: 
Applies and saves the setting shown above.  This does the same thing as clicking the apply 
button on the bottom of the dialog box, but only the TC-100 settings are changed. 
 
AM Configuration: 
 
Modem NVRAM Configuration Parameters:  
Allows the user to select which of 33 NVARM parameters such as BR1  [0-7]  Baud rate for 
serial port 1 or PTO  Int  Packet timeout (sec)  can be set in the  Parameter Settings see edit 
box below. 
 
Parameter Settings: 
Allows the user to enter the parameter setting that corresponds with the configuration 
parameter selected in Modem NVRAM Configuration Parameters.  For example if BR1 
[0-7] Baud rate is selected the Modem NVRAM Configuration Parameters list box then 
the valid entries for Parameter Settings are 
 
Check Settings: 
If this check box is enabled the check sum will be added at the end of the AM modem 
configuration string. 
Also See: 
 
Target Settings 
 
Ship Settings 
 
Communication 
 
Ethernet Configuration 
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Communications Command 
 
A dialog box allowing the user to select a serial port and set the corresponding parameters 
will be displayed.  Communication ports one through sixteen may be selected, provided 
they are available.  Select the serial port you want to use from the port selection list box 
using the arrow keys or mouse.  Then set the parameters listed below and click the Open 
button to open the port for serial input or output. 
 
Port Selection:               
allows the user to select a port number.  If a port is already open, the word open will be 
displayed in the list box after the port number.   The port number currently selected is 
highlighted.  To select a different port number use the arrow keys or mouse to highlight a 
different port.  The settings listed below are applied to the port number selected in this list 
box. 
 
Port Status: 
if the port selected in the port selection combo box is open, the active radio button will be 
highlighted.  If the selected port is closed, the inactive radio button will be 
highlighted.  This group box is for display purposes only and cannot be changed by the 
user.           
 
Baud Rate:  
allows the user to select the appropriate baud rate from the group of radio buttons.  The 
available baud rates range from 110 to 115200.  The IPS system default is 4800. 
 
Collect Data Strings: 
allows the user to enable or disable the collect data strings option.  If the box is checked, all 
serial data will be stored in a file.  The IPS default value is false, no data strings will be 
collected. 
 
Open Port:   
Opens the port selected in the port selection list box.  A message will be displayed in the 
view window with the port number, the baud rate, number of data bits, stop bits and 
parity.  If there is an error in opening the port an IPS error message will be displayed. 
 
Close Port: 
closes the port selected in the port selection list box.  
 
Clr Display: 
clears the view port window. 
 
Display all Data: 
If the check box is true (checked) data from all of the open ports will be 
displayed.  Otherwise only data from the port selected in the Port Selection box will be 
displayed. 
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View Port Window: 
This window displays incoming and outgoing communications data (i.e. BATS data, GPS 
data Compass data).  This window can be used to determine if target or ship information is 
not being displayed due to incorrect communication port settings or incorrect IPS parameter 
settings.  For example if SETUP -> System Inputs Command -> Ore System is set to none 
and the target position input is from a BATS, no target position information will be displayed 
even if all the communication port settings are correct.  If incoming serial strings are 
displayed in the view window, this would indicate that the communication port settings are 
correct. 
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Ethernet Configuration 
 
The Ethernet Configuration dialog box allows the user to set the parameters used for remote 
display of IPS data.  Please see the Remote IPS Display section of this manual for more 
information. 
 
Local Port: 
Allows the user to enter a local port number between 0 and 65535.  Setting the local port 
number to 0 enables the TCP/IP stack to choose a port at random. Otherwise, a port 
number above 2000 is suggested as port numbers 1 to approximately 2000 are reserved. 
Transmit IPS Data: 
If true (checked) allows the transmission of IPS data.  This allows the computer to be the 
master station. 
Receive Data: 
If true (checked) allows the IPS to receive data.  This allows the computer to be the remote 
host. 
Do Not Support Routing: 
If set to true (checked) the socket is forced to send data directly to the interface (no 
routing). 
Remote Port: 
Allows the user to enter a Remote Port number. The Remote Port is the UDP port on the 
Remote Host where UDP datagrams will be sent.  A valid port number (a value between 1 
and 65535) is required.  
Note:  This is the Remote Port number that will be entered in the “Remote Display” PC’s 
IPS Ethernet Configuration dialog box Local Port field. 
Remote IP: 
Allows the user to enter the IP address of the Remote Host. The Remote Host property 
specifies the IP address (IP number in dotted internet format) of the remote host. If 
Remote Host is set to 255.255.255.255, the IPS will broadcast the data on the local 
subnet. 
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Equipment Offset Commands 
 
Ship Offset 
 
Note: All offsets are now entered with respect to the center of roll pitch. 
 
System Units:          
This edit box displays the system units.  If the system units are meters the edit box will 
display meters.  If the system units are feet, yards or nautical miles feet will be displayed in 
the edit box.  This edit box is applies to each page of the dialog box but may not be edited 
by the user.  
Ship Offsets Sub Menu: 
 
Ship\GPS: 
 
Ship Length:  
allows the user to enter the ships overall length in feet or meters.  The maximum offset 
that may be entered is 300 meters/ 984.25 feet, the minimum amount that may be enters 
is 1 meter /3 feet.  The default value which will be used if the user has not entered the 
ships length is 62.18 meters/204 feet.  
 
Ship Beam: 
allows the user to enter the ships beam in feet or meters.  The maximum offset that may 
be entered is 100 meters/ 328 feet, the minimum amount that may be enters is 1 meter/3 
feet. The default value which will be used if the user has not entered the ships beam is 
11.58 meters/ 37.99 feet. 
 
GPS Antenna X: 
allows the user to enter the GPS antenna X position, which is the distance the GPS antenna 
is horizontally (along the X axis) from the center of the ship.  If the GPS antenna is 
starboard of the center of the ship the position must be a positive number.  If the GPS 
antenna to port of the center of the ship the position must be a negative number.  The 
maximum offset that may be entered is 1/2 half the amount entered for ships beam, the 
minimum amount is the negative of 1/2 the amount entered for ships beam.  
Note: The default GPS position is 0, 0 the center of the ship. 
 
GPS Antenna Y: 
allows the user to enter the GPS antenna Y position, which is the distance the GPS antenna 
is ahead of or behind (along the Y axis) the center of the ship.  If the GPS antenna is 
forward of the center of the ship the position must be a positive number.  If the GPS 
antenna is aft of the center of the ship the position must be a negative number.  The 
maximum offset that may be entered is 1/2 half the amount entered for ships length, the 
minimum amount is the negative of 1/2 the amount entered for ships length.  
 
If a number that does not fall in the range given above is entered, a warning message will 
be displayed and a number equal to 1/2 the ships length will be filled in the edit box.  To 
accept the number that is now displayed in the edit box the user must click Ok or 
Apply.  The user may also enter another value in the correct range and click Ok or Apply. 
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GPS Antenna Z: 
allows the user to enter the GPS antenna Z position, which is the distance the GPS antenna 
is ahead of or behind (along the Z axis) the center of the ship.  If the GPS antenna is 
forward of the center of the ship the position must be a positive number.  If the GPS 
antenna is aft of the center of the ship the position must be a negative number.  The 
maximum offset that may be entered is 98.42 feet or 30.0 meters. The Hydrophone Z offset 
may be positive or negative.  
 
D (CPR to LOA/2):  
allows the user to enter a center of roll pitch reference offset to be used only for displaying 
the ship shape on the main grid. The ship shape is now displayed as a Mercator projection.  
 
 
Display on Screen Position: 
allows the user to enable or disable the display of the GPS offset position on the equipment 
offset ship bitmap.  If the box is checked, the on GPS position will be displayed on the ship 
bitmap.   The IPS default is false, the GPS position will not be displayed. 
 
Reference: 
 
Reference X: 
allows the user to position the GPS antenna over the hydrophone by setting the reference 
position to the hydrophones actual position.  This frees the user from having to enter 
hydrophone offsets into the BATS systems. 
The reference position is the position displayed (lat/long) as ships position in the display box 
in the upper right hand corner of the screen.  If the reference X position is starboard of the 
center of the ship the position must be a positive number.  If the reference X position is 
port of the center of the ship the position must be a negative number.  The maximum offset 
that may be entered is 1/2 half the amount entered for ships beam, the minimum amount is 
the negative of 1/2 the amount entered for ships beam.  
Note: To use the reference position a valid compass input must be supplied. 
 
Reference Y:  
If the reference Y position is forward of the center of the ship the position must be a 
positive number.  If the reference Y position is aft of the center of the ship the position 
must be a negative number.  The maximum offset that may be entered is 1/2 half the 
amount entered for ships length the minimum amount is the negative of 1/2 the amount 
entered for ships length. 
Note: The default reference position is 0,0 the center of the ship. The reference position is 
defined to allow the user the flexibility of selecting a position onboard the vessel other than 
the locations of the actual GPS antenna and hydrophone. For example the reference position 
may be set to the stern of the vessel where launch and recovery of an ROV or other 
equipment takes place.  To use the Reference position valid compass input must be 
supplied. 
 
Display on Screen Position: 
allows the user to enable or disable the display of the reference offset position on the 
equipment offset ship bitmap.  If the box is checked, the reference offset position will be 
displayed on the ship bitmap.   The IPS default is false, the on screen position will not be 
displayed. 
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Use Reference Offset in Processing:  
allows the user to enable or disable the use of the reference offsets when calculating 
position statistics.  The IPS default is false, the reference offsets will not be used in 
calculations. 
 
Hydrophone: 
 
Hydrophone X:   
hydrophone X, Y, and Z allow offsets to be entered that cause the hydrophone's apparent 
position to be directly under the GPS antenna.  This is important because the target's 
latitude and longitude are based on the ship's latitude and longitude.  The X offset adjusts 
the distance the hydrophone is ahead of or behind the GPS antenna.   The maximum offset 
that may be entered is 1/2 half the amount entered for ships beam the minimum amount is 
the negative of 1/2 the amount entered for ships beam.  
 
Hydrophone Y:   
the Y offset adjusts the distance the hydrophone is laterally from the GPS antenna.  The 
maximum offset that may be entered is 1/2 half the amount entered for ships length the 
minimum amount is the negative of 1/2 the amount entered for ships length.   
 
Hydrophone Z:   
the Z offset adjusts the distance the hydrophone is below the water surface.  The maximum 
offset that may be entered is 98.42 feet or 30.0 meters. The Hydrophone Z offset may be 
positive or negative. 
 
Heading:  
allows the user to enter the heading bias.  The maximum heading bias that may be entered 
is 360 degrees.  The offset may be positive or negative.  The IPS default is 0.0 degrees. 
 
Roll:  
allows the user to enter the roll bias.  The maximum roll bias that may be entered is 10.0 
degrees.  The offset may be positive or negative.  The IPS default is 0.0 degrees. 
 
Pitch:     
allows the user to enter the pitch bias.  The maximum pitch bias that may be entered 
is 10.0 degrees.  The offset may be positive or negative.  The IPS default is 0.0 degrees 
 
Display on Screen Position: 
allows the user to enable or disable the display of the reference offset position on the 
equipment offset ship bitmap.  If the box is checked, the reference offset position will be 
displayed on the ship bitmap.   The IPS default is false, the on screen position will not be 
displayed. 
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Target Offset 
 
Target Offsets Sub Menu: 
 
Immediately after the Target Equipment Offsets Command is selected the Target Selection 
dialog box with nine radio buttons and corresponding bitmaps is displayed.  To select a 
target click the radio button to the right of the bitmap representing that target, then click 
the Ok push button.  To escape without changing any targets, click the cancel push 
button.  The Target Offset dialog box allowing the user to enter the General, DVL, 
Reference and Depth Sensor Offsets will appear. 
 
Target Number:  
Displays the target number selected in the target selection dialog box. All changes made 
in the dialog box will be applied to this target number.  This field is for display purposes 
only and cannot be edited by the user. 
 
System Units: 
This edit box displays the system units.  If the system units are meters the edit box will 
display meters.  If the system units are feet, yards or nautical miles feet will be displayed in 
the edit box.  This edit box may not be edited by the user. 
 
General: 
 
UWV LOA: 
lows the user to enter the targets overall length in feet or meters.  The maximum offset 
that may be entered is 100 meters/ 328 feet, the minimum amount that may be enters is 1 
meter /3.28 feet.  The default value which will be used if the user has not entered the 
targets length is 7.2 meters / 23.62 feet.  
 
UWV Beam: 
allows the user to enter the targets overall beam in feet or meters.  The maximum offset 
that may be entered is 50 meters/ 164 feet, the minimum amount that may be enters is 1 
meter /3.28 feet.  The default value which will be used if the user has not entered the ships 
length is 2.5 meters/8.2 feet.  
 
Latitude: 
allows the user to enter the targets latitude. This is the latitude that would be used for 
calculating the DVL start position if manual has been selected for the DVL start 
position.  This latitude would also be used to reset the DVL position if manual has been 
selected for reset position. 
 
Longitude: 
allows the user to enter the targets longitude.  This is the longitude that would be used for 
calculating the DVL start position if manual has been selected for the DVL start 
position.  This longitude would also be used to reset the DVL position if manual has been 
selected for reset position. 
 
DVL Sound Velocity: 
allows the user to have the IPS DVL sound velocity calculated from the DVL temperature 
and depth or calculated using the manual sound velocity. 
 
Manual Sound Velocity:   
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allows the user to enter a manual sound velocity that may be used to calculate the DVL 
sound velocity.  The maximum sound velocity that may be entered is 2000.00 m/s, the 
minimum is 1000.0 m/s.  The IPS default is 1500.0 m/s. 
 
Salinity: 
allows the user to enter a salinity that may be used to calculate the DVL sound 
velocity.  The maximum salinity that may be entered is 45.0 practical salinity units, the 
minimum is 1.0 PSU.  The IPS default is 35.0 PSU.  This value is only used if calculate from 
DVL temperature depth is selected in the DVL Sound Velocity group box.  This parameter is 
important because the salinity of the water effects the DVL sound velocity. 
 
DVL Start Position: 
allows the user to select either manual or ship reference position as the DVL start 
position.   The IPS default is manual. 
 
Reset Position: 
allows the user to select either the Manual, Ship Reference Position, ORE Target, Fuse 
DVL/USBL or Reset DVL Waypoint data position to use to reset the DVL position.  The IPS 
default is manual. 
 
Reset ORE Target: 
allows the user to enter the ORE Target whose position will be used when resetting the DVL 
position.  The maximum target number that may be entered is 9, the minimum is 0. The 
IPS default is 0.  This value is only used if ORE Target is selected in the reset position group 
box. 
 
Reset Lat/Lon Position:  
allows the user to reset the DVL position based on the values entered above.  The DVL 
position will be reinitialized and the data accumulators will be set to zero.  This means that 
the new DVL latitude and longitude will be based on data collected after the DVL position 
was reset. 
 
DVL Navigation: 
begins DLV navigation based on the values entered above.  The positions calculated for the 
DVL will be shown in the display grid.  If the DVL Navigation check box is not checked 
nothing will be done with the DVL data that is collected. The IPS default is DVL navigation 
off. 
 
 
DVL: 
 
DVL X:  
allows the user to enter the DVL X value.  The maximum offset that may be entered is 1/2 
half the amount entered for target's UWV Beam the minimum amount is the negative of 1/2 
the amount entered for UWV Beam.  The IPS default is 0.0.    
 
DVL Y: 
allows the user to enter the DVL Y value.  The maximum offset that may be entered is 1/2 
half the amount entered for UWV LOA the minimum amount is the negative of 1/2 the 
amount entered for UWV LOA.  The IPS default is 0.0.   
 
DVL Z: 
allows the user to enter the DVL Z value.  The maximum offset that may be entered is 
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16.4   feet or 5.0 meters. The Hydrophone Z offset may be positive or negative.  The IPS 
default is 0.0.                   
 
Mounting Angles: 
this refers to the angle the DVL is mounted at relative to the navigation frame.  If the DVL 
unit is correctly aligned with the vessel's navigation frame the mounting angle heading, roll 
and pitch biases would be zero.  Please note the example in the DVL dialog box.  In this 
example the DVL unit is tilted 10 degrees off the ROV/Sub level, therefore the pitch bias is 
10.       
  
Heading:  
allows the user to enter the heading bias.  The maximum roll bias that may be entered is 
359.90 degrees.  The offset may be positive or negative.  The IPS default is 0.0 degrees. 
 
Roll:  
allows the user to enter the roll bias.  The maximum roll bias that may be entered is 180.0 
degrees.  The offset may be positive or negative.  The IPS default is 0.0 degrees. 
 
Pitch: 
allows the user to enter the pitch bias.  The maximum pitch bias that may be entered 
is 180.0 degrees.  The offset may be positive or negative.  The IPS default is 0.0 degrees 
 
Manual DVL Depth:  
allows the user to enter a manual DVL depth that may be used in DVL calculations.  The 
maximum DVL depth that may be entered is 4999.99 meters or 16,4004.00 feet the 
minimum is 0.0.  The IPS default is 0.0. 
 
Vehicle Depth: 
allows the user to select either Manual DVL Depth, DVL Sensor Depth or SVP or CTD Depth 
to be used in DVL calculations.  If Manual DVL Depth is selected, the value entered in the 
Manual DVL Depth edit box above will be used.  The IPS default is Manual DVL Depth. 
 
Filter DVL Data:                     allows the user to set the DVL Filter on or off. 
 
Filter Plot:                              displays a popup window with a graph of the filtered DVL 
data. 
 
 
Reference: 
 
USBL Beacon X:  
allows the user to enter the USBL Beacon X value.  The maximum offset that may be 
entered is 1/2 half the amount entered for ships UWV Beam the minimum amount is the 
negative of 1/2 the amount entered for UWV Beam.  The IPS default is 0.0.    
 
USBL Beacon Y: 
allows the user to enter the USBL Beacon Y value.  The maximum offset that may be 
entered is 1/2 half the amount entered for UWV LOA the minimum amount is the negative 
of 1/2 the amount entered for UWV LOA.  The IPS default is 0.0.   
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USBL Beacon Z: 
allows the user to enter the USBL Beacon Z value.  The maximum offset that may be 
entered is 16.4   feet or 5.0 meters. The Hydrophone Z offset may be positive or 
negative.  The IPS default is 0.0.  
 
Reference X:  
allows the user to position the GPS antenna over the hydrophone by setting the reference 
position to the hydrophones actual position.  This frees the user from having to enter 
hydrophone offsets into the BATS systems.   
The reference position is the position displayed (lat/long) as target position in the display 
box in the lower right hand corner of the screen.  If the reference X position is starboard of 
the center of the target the position must be a positive number.  If the reference X position 
is port of the center of the target the position must be a negative number.  The maximum 
offset that may be entered is 1/2 half the amount entered for UWV Beam, the minimum 
amount is the negative of 1/2 the amount entered for UWV Beam.  
Note: To use the reference position a valid compass input must be supplied. 
 
Reference Y:  
If the reference Y position is forward of the center of the target the position must be a 
positive number.  If the reference Y position is aft of the center of the target the position 
must be a negative number.  The maximum offset that may be entered is 1/2 half the 
amount entered for UWV LOA the minimum amount is the negative of 1/2 the amount 
entered for UWV LOA. 
Note: The default reference position is 0,0 the center of the target. The reference position is 
defined to allow the user the flexibility of selecting a position onboard the target other than 
the locations of the actual GPS antenna and hydrophone. For example the reference position 
may be set to the stern of the vessel where launch and recovery of an ROV or other 
equipment takes place.  To use the reference position valid compass input must be 
supplied. 
 
 
Reference Z:  
If the reference Z position is below the target's data center the Z the position must be a 
positive number.  If the reference Z position is above target's data center the Z position 
must be a negative number.  The maximum offset that may be entered is 1/2 half the 
amount entered for UWV LOA the minimum amount is the negative of 1/2 the amount 
entered for UWV LOA. 
Note: The default reference position is 0,0 the center of the target. The reference position is 
defined to allow the user the flexibility of selecting a position onboard the target other than 
the locations of the actual GPS antenna and hydrophone. For example the reference position 
may be set to the stern of the vessel where launch and recovery of an ROV or other 
equipment takes place.  To use the Reference position valid compass input must be 
supplied. 
 
 
 
Use Ref Offsets in Processing: 
allows the user to have the reference offsets entered above used in processing. The IPS 
default is off. 
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Depth Sensor: 
 
Depth Sensor X:  
allows the user to enter the Depth Sensor X value.  The maximum offset that may be 
entered is 1/2 half the amount entered for target's UWV Beam the minimum amount is the 
negative of 1/2 the amount entered for UWV Beam.  The IPS default is 0.0.    
 
Depth Sensor Y: 
allows the user to enter the Depth Sensor Y value.  The maximum offset that may be 
entered is 1/2 half the amount entered for UWV LOA the minimum amount is the negative 
of 1/2 the amount entered for UWV LOA.  The IPS default is 0.0.   
 
Depth Sensor Z: 
allows the user to enter the Depth Sensor Z value.  The maximum offset that may be 
entered is 16.4   feet or 5.0 meters. The Hydrophone Z offset may be positive or 
negative.  The IPS default is 0.0.  
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Fixed Target 
 
Fixed Target Offsets Sub Menu: 
 
Allows the user to enter the fixed target's length, beam, shape and line properties.  The 
reference and heading offsets and the fixed target's latitude and longitude may also be set.  
 
 
Display Properties: 
 
Vessel Length:  
allows the user to enter the fixed target's overall length in feet or meters.  The maximum 
offset that may be entered is 100 meters, the minimum amount that may be enters is 0.1 
meters.  The default value which will be used if the user has not entered the ships length is 
50.0 meters.  
 
Vessel Beam:                    
allows the user to enter the fixed target's beam in feet or meters.  The maximum offset 
that may be entered is 50.0 meters, the minimum amount that may be enters is 0.1 meter. 
The default value which will be used if the user has not entered the ships beam is 7.0 
meters. 
 
Line Size: 
allows the user to select the size (width) of the line used in drawing the fixed target in the 
viewing area.   The allowable line sizes range from 1 to 10 and the default line size is 3. 
 
Line Color:  
allows the user to select the color of the line used in drawing the fixed target in the viewing 
area.  The available colors are: black, light gray, dark gray, gray, white, red, yellow, green, 
cyan, blue, magenta, dark red, dark green, dark yellow, dark blue, dark magenta, dark 
cyan, money green, sky blue and cream.  The default line color is light gray. 
 
Shape: 
allows the user to choose a ship shape or barge shape to represent the fixed target on the 
IPS viewing area.  The default shape is ship. 
 
Display: 
allows the user to display the fixed target in the IPS viewing area.  If display is not checked 
none of the values selected above will have any effect. The default is display off. 
 
 
Reference: 
Reference X:                           
allows the user to position the GPS antenna over the hydrophone by setting the reference 
position to the hydrophones actual position.  This frees the user from having to enter 
hydrophone offsets into the BATS systems. 
If the reference X position is starboard of the center of the fixed target the position must be 
a positive number.  If the reference X position is port of the center of the target the position 
must be a negative number.  The maximum offset that may be entered is 1/2 half the 
amount entered for Vessel's Beam, the minimum amount is the negative of 1/2 the amount 
entered for Vessel Beam.  
Note: To use the reference position a valid compass input must be supplied. 
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Reference Y: 
if the reference Y position is forward of the center of the fixed target the position must be a 
positive number.  If the reference Y position is aft of the center of the fixed target the 
position must be a negative number.  The maximum offset that may be entered is 1/2 half 
the amount entered for Vessel Length the minimum amount is the negative of 1/2 the 
amount entered for Vessel Length. 
Note: The default reference position is 0,0 the center of the fixed target.  The reference 
position is defined to allow the user the flexibility of selecting a position onboard the target 
other than the locations of the actual GPS antenna and hydrophone. For example the 
reference position may be set to the stern of the vessel where launch and recovery of an 
ROV or other equipment takes place.  To use the Reference position valid compass input 
must be supplied. 
 
Heading: 
allows the user to enter the fixed target heading.  The maximum heading allowed is 359.0 
degrees and the minimum heading is 0.0 degrees.  The IPS default heading is 0.0. 
 
Latitude: 
allows the user to enter the fixed target latitude.  
 
Longitude: 
allows the user to enter the fixed target longitude.  
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Mission Information 
 
Allows the user to enter information about the mission such as the Cruise ID and the Pilot's 
names.  This information will be displayed at the start the IPS program if the Show on Start 
Up box is enabled.   The information entered below is stored in the file IMinfo.txt in the IPS 
start directory.  
 
Cruise ID:                           
allows the user to enter the cruise ID.  The cruise ID must be alphanumeric and can be up 
to 30 characters. 
 
Dive ID:                                
allows the user to enter the dive ID.  The dive ID must be numerical and can be up to 
8 characters.  The dive ID is incremented each time the IPS is run.  However, all of the 
other parameters will remain unchanged. 
 
Main Vehicle ID:   
allows the user to enter the main vehicle ID.  The main vehicle ID must be alphanumeric 
and can be up to 30 characters. 
 
Pilot 1:  
allows the user to enter the first pilot ID.  The first pilot ID must be alphanumeric and can 
be up to 30 characters.   
 
Pilot 2:      
allows the user to enter the second pilot ID.  The second pilot ID must be alphanumeric and 
can be up to 30 characters.   
 
Observer 1: 
allows the user to enter the first observer.  The first observer must be alphanumeric and 
can be up to 30 characters.  
 
Observer 2:    
allows the user to enter the second observer.  The second observer must be alphanumeric 
and can be up to 30 characters.  
 
Show on Start Up:  
if the show on start up check box is enabled (checked) the mission information dialog box 
will be shown automatically each time the IPS program is run. 
 
 
 
 

 



Integrated Positioning System Version 7.7.1.10 162 

Creative Underwater Technologies Copyright 1992-2019 

Time Options 
 
Zone Description: 
allows the user to enter a zone description of -12.0 to 12.0 hours to adjust the IPS time 
used for serial or text/NMEA output data to match UTC (Universal Coordinated Time) or GMT 
(Greenwich Mean Time).  The default is 0.0.  For more information on text/NMEA or GIS 
output data see FILE -> Export Data Command.  For more information on serial output data 
see SETUP -> Serial Out Command.  
 
GPS Time Sync on Start Up: 
allows the user to synchronize the PC system time with the GPS time as reported by the 
NMEA ZDA string.  The PC time is synchronized when the system is started and every five 
minutes when the IPS data is automatically backed up.  The default is off (unchecked). 
 
Time Sync Command 
 
Allows the user to synchronize the PC system time with the GPS time as reported by the 
NMEA ZDA string on a one time basis.  The PC time is can also be synchronized when the 
system is started and every five minutes when the IPS data is automatically backed up 
using the SETUP -> Time Options -> GPS Time Sync on Start Up.  
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NMEA Strings 
 
DBT Depth Below Transducer 
 
Water depth referenced to the transducer. 
 
                1          2            3 
$--DBT,2500.0,f,752.0,M,416.7,F*hh 
 
1.        Water depth in feet. 
2.        Water depth in meters. 
3.        Water depth in fathoms. 
Note: For DBT, the IPS will only use the first field (feet). 
 
DPT Depth Position Target 
 
MO Resolution A.224(VII).  Water depth relative to the transducer and offset of the 
measuring transducer.  Positive offset numbers provide the distance from the transducer to 
the waterline.  Negative offset numbers provide the distance from the transducer to the 
part of the keel of interest. 
 
             1       2 
$--DPT,300.0,175.0,*hh 
 
 
1.        Water depth relative to the transducer in meters. 
2.        Offset relative to the transducer in meters. 
 
Note: 
 

•  For DPT, the IPS will only use a positive transducer offset (the distance from the water 
line to the transducer) in order to calculate the total water depth with respect to the 
surface. 

 

•  If the second field contains a negative value this would indicate the distance from the 
transducer to the keel. The IPS will ignore this value and return the depth with respect 
to the transducer.   
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DTF IPS Data Base Format 
 
IPS Database Format. 
 
     1               2           3              4                                  5          6         7       8         
 9      
10/4/2001,10:09:16,2,35.00204523,-75.40662995,61.7,m,-1.0,m,278.4,1.2,kt,10.
8, 
 
         10        11         12                13     14       15                16     17    18   19 
-3.82 1.40 ,0.00,m, 127,244.00,0.00,0.00,7,1500.0,m/s,-12.6,-28.9,61.7,9 
 
 
 
1.      Date 
 
2.      Time 
 
3.      Target id 
 
4.      Lat long degrees.  For example 20 degrees 30 minutes = 20.5000. 
 
5.      Depth and altitude in system units.  If the IPS system units are meters, then the 

units are in meters, otherwise they are in feet. 
 
6.      Altitude in system units.  If the IPS system units are meters, then the units are in 

meters, otherwise they are in feet.  If either the depth or altitude are invalid a -1 will 
be displayed in that field. 

 
7.     Course over ground (COG) [deg]. 
 
8.     Speed over ground [knots]. 
 
9.      Platform heading.  Note the platform is the target ID.  These values will not equal 

the USBL heading, roll pitch unless it is ship data.  For example the platform could be 
an AUV, ROV Manned sub etc. 

 
10.    Platform roll. 
 
11.    Platform pitch. 
 
12.    Platform heave. If system units = meters => meters else feet. 
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13.     Platform attitude quality flag: 
 

{- bit #: 8    7    6    5    4    3    2    1  } 
 
{-        0   PR   PP   PH   PZ   UR   UP   UH  } 
        USBL HeadingValid = 1;  {- 00000001 } 
        USBL PitchValid = 2;    {- 00000010 } 
        USBL RollValid = 4;     {- 00000100 } 
        Platform HeaveValid = 8;    {- 00001000 }               
        Platform HeadingValid = 16; {- 00010000 } 
        Platform PitchValid = 32;   {- 00100000 } 
        Platform RollValid = 64;    {- 01000000 } 

 
14.    USBL Heading, 
 
15.    USBL Roll 
 
16.    USBL Pitch  
 
17.    USBL quality flag (see above) 
 
18.    Sound velocity in m/s or feet/s 
 
19.     Position quality flag: ORE raw x,y,z [m] quality factor.  If Ship (GPS) Number of 

satellites, GPS quality indicator (0 '?'none, 1' '-GPS, 2 'D'-DGPS, 3'P'-PPP mode fix 
valid, 4'R'-RTK Fixed, 5'F'-RTK float, 6'I'-Free inertial, DOP (dilution of precision), Age 
of differential GPS data [sec], Differential reference station ID 0000-1023. 
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DTF NOAA With ARCView Data 
 
This format includes all of the information in the DTF IPS Data Base Format described 
above, but also includes a tab deliminated header and the mission information.  The 
mission information is the Cruise_ID, Dive_ID, Vehicle_ID, Pilot_1, Pilot_2, Obs_1 and 
Obs_2.  The mission information may be entered in Setup->Mission Information.   A 
separate directory is also created for the text file using the dive name and number.  
 
 
        1            2          3                   4                           5                      6                     
  7 
ROV_2006        728        SeaMax        Steven Smith           Mike 
Thomas      Charlie Davis        John Wilson 
 
     8               9       10               11                        12         13         14     15      16     
    
10/4/2001,10:09:16,2,35.00204523,-75.40662995,61.7,m,-1.0,m,278.4,1.2,kt,10.
8, 
 
  
  17       18   19       20     21       22     23  24    25                   26 
-3.82 1.40 ,0.00,m, 127,244.00,0.00,0.00,7,1500.0,m/s,-12.6,-28.9,61.7,9 
 
1.          Cruise_ID         
2.          Dive_ID         
3.          Vehicle_ID         
4.          Pilot_1         
5.          Pilot_2         
6.          Obs_1         
7.          Obs_2 
8.        Date 
 
9.        Time 
 
10.      Target id 
 
11.     Lat long degrees.  For example 20 degrees 30 minutes = 20.5000 
 
12.      Depth and altitude in system units.  If the IPS system units are meters, then the 

units are in meters, otherwise they are in feet. 
 
13.      Altitude in system units.  If the IPS system units are meters, then the units are in 

meters, otherwise they are in feet.  If either the depth or altitude are invalid a -1 
will be displayed in that field. 

 
14.     Course over ground (COG) [deg]. 
 
15.     Speed over ground [knots]. 
 
16.      Platform heading.  Note the platform is the target ID.  These values will not equal 

the USBL heading, roll pitch unless it is ship data.  For example the platform 
could be an AUV, ROV Manned sub etc. 
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17.    Platform roll. 
 
18.    Platform pitch. 
 
19.    Platform heave. If system units = meters => meters else feet. 
 
20.     Platform Attitude quality flag: 
 

{- bit #: 8    7    6    5    4    3    2    1  } 
 
{-        0   PR   PP   PH   PZ   UR   UP   UH  } 
        USBL HeadingValid = 1;  {- 00000001 } 
        USBL PitchValid = 2;    {- 00000010 } 
        USBL RollValid = 4;     {- 00000100 } 
        Platform HeaveValid = 8;    {- 00001000 }               
        Platform HeadingValid = 16; {- 00010000 } 
        Platform PitchValid = 32;   {- 00100000 } 
        Platform RollValid = 64;    {- 01000000 } 

 
21.    USBL Heading, 
 
22.    USBL Roll 
 
23.    USBL Pitch  
 
24.    USBL quality flag (see above) 
 
25.    Sound velocity in m/s or feet/s 
 
26.    Position quality flag: EdgeTech raw x,y,z [m] quality factor.  If Ship (GPS) Number of 

satellites, GPS quality indicator (0 '?'none, 1' '-GPS, 2 'D'-DGPS, 3'P'-PPP mode fix 
valid, 4'R'-RTK Fixed, 5'F'-RTK float, 6'I'-Free inertial, DOP (dilution of precision), Age 
of differential GPS data [sec], Differential reference station ID 0000-1023. 
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GGA 2.x Global Positioning System Fix Data 
 
NMEA format version 2.x GGA contains the latitude and longitude of the target and is the 
most commonly used format for shipboard navigation.  The drawback of this format is that 
it does not give a target number or depth.  The main difference between format 2.x and 
format 1.x is that format 2.x gives the UTC of position in hours minutes and seconds 
format.  The GGA 2.x text string is appropriate to use as serial output when the IPS 
software is being used primarily for ship navigation.  If a GGA text string has been selected 
for serial output the only the GGA data received from the target selected as a priority target 
will be used as serial output.  See the field definitions section in the NMEA version 2.x 
manual for more detailed information. 
Note:  
   The IPS software disregards the last two fields in the NMEA format 2.x GGA version for 

both serial input and output. 
•   The serial output of target location data in the 2.x GGA strings created by IPS will 

always be with regard to the hydrophone location independent of the reference (R) 
location. 

 
                   1              2            3       4          5   6 7  8       9           10     11      12 
GPGGA, 221024.15 ,2619.307,N,08005.280,W,1,6,01.0,000027.5,M,00027.5,M*76 
 
1.         UTC of position. 
 
2.         GPS of Latitude. 
 
3.         Latitude N. or S. 
 
4.         GPS Longitude. 
 
5.         Longitude E or W. 
 
6.         GPS quality indicator. 
 
7.         Number of GPS satellites being used. 
 
8.         Horizontal dilution of precision (HDOP). 
 
9.         Antenna height. 
 
10.        Antenna height units. 
 
11.        Geoidal Height 
 
12.         Geoidal Height Units. 
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TLL Target Latitude and Longitude 
 
A TLL text string in the format displayed below that contains data associated with the 
tracked target in. NMEA format version 2.x TLL. The TTL text strings is appropriate to use as 
serial output when the IPS software is being used primarily for target navigation as The TTL 
text string has a target ID number. 
 
NOTE: The serial output of target location data in the TLL strings created by IPS will always 
be with regard to the hydrophone location independent of the reference (R) location. 
 
             1      2           3       4           5     6        7           8 
$IPTLL,05,2409.251,N,09120.214,W,Lxt-1,214619.44T,,*53 
 
1.        Target Number From 0 To 9. 
 
2.        Target Latitude. 
 
3.        Latitude N. or S. 
 
4        Target Longitude. 
 
5.        Longitude E. or W. 
 
6.        Target name display only first 8 characters. 
 
7.        UTC of data. 
 
8.        Target status. 
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TPD Target Position and Depth 
 
A TPD text string in the format displayed below that contains data associated with the 
tracked target in a format similar to TLL string with the target's depth replacing the target 
name.  When the TPD format is selected as the NMEA serial output the target's depth will 
be given in the current IPS system units.  This means the target's depth will be expressed 
in meters if meters are the current system units and feet in all other cases. 
 
NOTE: The serial output of target location data in the TPD strings created by IPS will always 
be with regard to the hydrophone location independent of the reference (R) location. 
 
 
             1       2          3       4           5       6           7           8 
$IPTPD,05,2606.102,N,08003.984,W,,0010,f,210918.09,T,*3F 
 
1.        Target Number From 0 to 9. 
 
2.        Target Latitude. 
 
3.        Latitude N. or S. 
 
4        Target Longitude. 
 
5.        Longitude E. or W. 
 
6.        Target depth in feet [f] or meters [m]. 
 
7.        UTC of data. 
 
8.        Target status. 
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RMC Recommended minimum specific GPS/Transit data 
 
RMC is the recommended minimum data to be provided by a GPS or Transit receiver. Time, 
date position, course and speed data are provided by a GPS or TRANSIT navigation receiver. 
A check sum is mandatory.  This data string should be transmitted at speeds of 1 hertz 
when used with the IPS.   All data fields must be provided, null fields should be used only 
when the data is temporarily unavailable. 
 
           1       2     3       4      5         6      7       8        9       10     11  12 
RMC,220516,A,5133.82,N,00042.24,W,173.8,231.8,130694,004.2,W*70 
              
 
 

1.        Time Stamp 220516  22:05:16 UTC 
 

2. .        A   validity - A-ok, V-invalid 
 

3.        5133.82    current Latitude 
 

4.         N          North/South 
 

5. .       00042.24   current Longitude 
 

6.        W          East/West 
 

7.        173.8      Speed in knots 
 

8.        231.8      True course 
 

9. .       130694     Date Stamp 
 

10.        004.2      Variation 
 

11.        W          East/West 
 

12.        *70        checksum 
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TTMT Tracked Message Target 
 
A TTMT text string in the format displayed below that contains data associated with the 
tracked target relative to the true north in NMEA format version 2.x TTM.  At this time the 
IPS software only sends out valid information in the target number, distance, bearing, time, 
target name and target status fields.  The time stored in the time field is the current DOS 
time of the computer being used to run the IPS software unless the operator used Time 
Zone to adjust local time to GMT.  The usable fields are in bold type in the example 
below.  All other fields will be either zero or null.  See the field definition section in the 
NMEA 0183 version 2.x manual for more detailed information. 
 
Note:  The location of the serial output strings TTMT is with respect to the reference 
location if it is enabled.  If the reference location is enabled the word 'ref' will be displayed 
in the target position box. 
 
             1      2     3         4   5        6      7     8    9   10 11  12       13 
$IPTTM,01,0.031,104.4,T,0.0,0.0,T,0.752,123.3,N,BATS-1,T,,132424.12,A*5E 
 
1.        Target number from 0 to 9. 
 
2.        Targets distance from own ship. [NM] 
 
3.        Bearing from own ship,(T true).  [deg] 
 
4.        Target speed. SOG [knots] 
 
5.        Target course degrees. COG [deg] 
 
6.        Range CPA 
 
7.        Time to CPA '-' = increasing 
       
8.        Speed distance Units K/N/S 
 
9.        Target Name, displays only 1st 8 characters. 
 
10.        Target status ,L ,Q or T. 
 
11.        Reference target = R, null otherwise. 
 
12.        UTC of data. just time 
 
13.        Type of acquisition, A = Auto, M = manual. 
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PORE ORE Proprietary Format 
 
The format “PORE” or NMEA ORE is a NMEA 0183 string length of 70 characters not 
including <CR><LF>.  It follows the sentence structure for a NMEA 0183 version 2.1 
proprietary sentence.  
Example of the NMEA ORE Format: 
$ P O R E , # # , HHMMSS, , , B R G , X ( m ) , Y ( m ) , Z ( m ) , R O L L , PT C H , WC, 
QF* CS 
$PORE,01,072450,,,300.8,-00001.0,000000.6,00505.4,000.00,000.00,00,10*18 
Example of the NMEA ORE Format with compass heading enabled: 
$PORE,##,HHMMSS,HDG,ID, BRG, X (m), Y (m) , Z (m), ROLL, PTCH,WC,QF*CS 
$PORE,01,072537,125.8,M,125.5,000000.2,-00000.2,00505.4,-00.03,-00.02,00,10*16 
 
For more information please see the Operation and Maintenance Manual for the Track Point 
3 section 3.7.6.1. 
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UDP EchoScope Format 
 
UDP EchoScope nav string format: 
 
$PIES,Lat,R,Long,R,depth,heave,heading,roll,pitch,SV<cr><lf> 
 
$PIES - Header for EchoScope Lat/Long format   "I-IPS, ES- EchoScpoe 
 
Lat - [DDmm.mmmm]  Lat WGS-84  - NMEA 0183 format 
Region - 'N' or 'S' 
Long - [DDDmm.mmmm] Long WGS-84  - NMEA 0183 format 
Region - 'W' or 'E' 
 
Depth - [m]   + down min depth 0.00 (surface) 
Heave - [m]   +vert up 
 
Heading - [deg] 0-359.99 
Roll - [deg] +Port side up  (TSS CoordSys) 
Pitch - [deg] +Bow up 
 
SV - [m/s] 
 
<CR> - ASCII 13 Dec 
<LF> - ASCII 10 Dec 
 
To be used for the Code EchoScope MK II. 
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PIUDP Data Format 
 
UDP data nav string format: 
 
NOTE: The serial output of target location data in the $PIUPD strings created by IPS will 
always be with regard to the hydrophone location independent of the reference (R) location. 
 
   $PIUDP,HHMMSS.sss,mm-dd-yyyy,id,dddd.dd,hhh.h,rr.rr,pp.pp,yyy.yy,RR.RR,PP.PP, 
          aaa.a,ccc.c,s.ss,vvvvv.v,S,AF,DD.ddddd,LL.lllll,nnn,QFSt*CS<cr><lf> 
 
   $PIUDP,143755.000,02-25-2003,9,4.37,83.59,-3.75,-2.24,1.77,85.15,0.49,1507.74,1,27
.1234567,-83.1234567,1,2,3*A6 
 
   1  $PIUDP header 
   2  HHMMSS.sss  Hours 24 hr clock, LMT hours minutes seconds and milliseconds 
   3  mm-dd-yyyy local data 
   4  id = target is ship_ID, 1-9 ORE, SHIP_ID Just set a default of 10 
   5  ddd.dd subsea depth [m] or ship heave + down 
   6  hhhh.h True heading [deg] 
   7  rr.rr roll (+Port side up) [deg] 
   8  pp.pp pitch (+Bow up) [deg] 
   9  yyy.yy Yaw rate (+CCW) [deg/sec] 
  10  RR.RR  Roll rate [deg/sec] 
  11  PP.PP  Pitch rate [deg/sec] 
  12  aaa.a altitude [m] and ship depth sounder 
  13  ccc.c course over ground from processed DVL+AHRS+CTD [deg] wrt true north or 
GPS ship 
  14  ss.ss speed over ground in knots from processed DVL+AHRS+CTD [deg] or GPS ship 
  15  vvvv.v sound velocity [m/s] 
  16  S DVL status 0-no bottom lock, 1-bottom lock 
  17  AFlag : word;  status of all attitude values 
     -- Constants for Attitude quality factor -------- 
      P= Platform, U= USBLL                            
      Can assembly multi valid angles by OR-ing.   
      flag := PHeadingValid or UPitchValid or URollValid 
      To check for example USBL roll 
       if ( URollValid = (flag and URollValid) ) then 
      bit #: 8    7    6    5    4    3    2    1  
             0   PR   PP   PH   PZ   UR   UP   UH  
     UHeadingValid = 1;  // 00000001 
     UPitchValid = 2;    // 00000010 
     URollValid = 4;     // 00000100 
 
     PHeaveValid = 8;    // 00001000 
     PHeadingValid = 16; // 00010000 
     PPitchValid = 32;   // 00100000 
     PRollValid = 64;    // 01000000 
 
     // Note need to be 16 bit since Aflag : 2 byte Uint 
     PHeaveError =   $FFF7;  // 11110111 
     PHeadingError = $FFEF;  // 11101111 
     PPitchError =   $FFDF;  // 11011111 
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     PRollError =    $FFBF;  // 10111111 
 
     PDVLAHRSValid = 112;      // 01110000 
     PDVLAHRSHeaveValid = 120; // 01111000 
 
  18  Lat deg.1234567,  7 places to Rt . for 0.00001 min of resoulation + North 
  19  Long deg.1234567  +East 
  20  nnn   PosFrom // typically 0 from actual tracking station else for remote display IPS 3 
dig key number 
  21  QFst [30]  //  quality factor string is a function of target type {-ID field is 4; Ship ID 
= 10, USBL or DVL targets id = 1-9} 
                 // Subsea targets: 
                 // ORE USBL- raw SR [m], relative bearing [deg], dpeth [m] (w.r.t still water), 
USBL QF (0-9), Hx,Hy,Hz, [m] 
                 //           Hydrophone yaw, hydrophone roll, hydphone pitch mounting biases 
[deg], USBL processing method 
                 // DVL Nav-  Bottom Vel X,y,z, [m/s] Alt [m],Fixed QF =10,Gyro yaw rate 
                 // Ship - Num Sats, GPS quality,DOP,Age of DGP corrections sec,DGPS Station 
ID  (ex. 8,D,1,4,0) 
                 // GPS quality = {- 0 = '?' fix not available or invalid 
                                    1 = ' ' C/A Standard GPS fix valid 
                                    2 = 'D' DGPS mode fix valid 
                                    3 = 'P' PPP mode fix valid 
                                    4 = 'R' RTK Fixed 
                                    5 = 'F' RTK float 
                                    6 = 'I' Free inertial 
                                    7 = 'W' WAAS 
                                    8 = 'S' OmniStar normal VBS 
                                    9 = 'H' OmniStar HP 
                                  } 
  22  * 
  23  NMEA checksum (XOR) 
  24 <cr> 
  25 <lf> 
 
Examples: 
 
$PIUDP,082949.690,01-29-2005,10,0.00,316.74,1.30,-0.61,0.00,0.00,0.00,0.00,317.32,6.
80,1500.0,0,120,30.3878394,-81.5628697,304,8,D,1,4,0*25 
 
$PIUDP,082952.271,01-29-2005,10,0.00,316.66,1.38,-0.61,0.00,0.00,0.00,0.00,317.24,6.
79,1500.0,0,120,30.3878742,-81.5629067,304,8,D,1,4,0*29 
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Serial Out ID 
 
Serial Out ID Selection 
 
 
 
 

Description Valid 
id range 

Subsea- 1..9 

Remarks 

GGAv2 NMEA GGA version 2 
string 

Any id It advisable to enable Echo GPS if ship id 
is selected 

TTMT NMEA Tracked Target 
Message True 

Subsea The target bearing with respect to True  
North from the GPS position or Ship Ref  
‘R’ position if enabled 

WHOI AM WHOI acoustic micro 
modem 

Ship only USBL/modem ORE TP3 

TPD Target Position Depth Any id Subsea targets id/lat/long/depth/time 
RMC minimum data to be 

provided by a GPS or 
Transit receiver 

0-10 Must set priority target, A check sum is 
mandatory, data string should be  
transmitted at speeds of 1 hertz when 
used with the IPS. 

 
 

 
 

 
 

 
 

TLL NMEA Target 
id/Latitude/Longitude 
string 

Any id  
 

DTF IPS Database Format 
with ID 

Any id Contains all the tracking information 

GGA/HDT/VTG NMEA strings typically 
used for side scan 
sonar and sub-bottom 
profilers 

Any id Sends out three NMEA strings: GGA / HDT / VTG

STC 50 video Horita Serial Control 
Titler 

Any id Adds Lat/Long and depth on top of video 

TSS1 TSS1 format: heave, 
roll and pitch data 
string 

Any id  
 

RDI DVL 
Depth/Zero 

IPS command to RDI 
workhorse DVL to zero 
its depth sensor 

Subsea  
 

TLD (Target 
Location Depth 

Tx) 

Upon a query to IPS 
with the IPS $PITLR = 
Target Location 
Request will return the 
Targets position and 
depth 

Any id Typically used for imaging sonars to get a 
target’s geodetic position 

TC-100 Video 
Time Code Sync 

To set this time code 
generator and video 
text overlay 

Any id Used with older 3-Beam systems 

Horita Video Horita PG-2100 time. 
IPS sets PG-2100 to 
PC clock 

Subsea Used with older 3-Beam systems 
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Platform UTM 
Nav 

Provides a compact 
position (UTM), 
heading, roll, pitch, 
SV data string 

Any id Specific id required 

Remote IPS 
Display 

($PIUDP) 

Remote display of all 
IPS data on another 
(or many) PCs 

None 
required 

all targets 
are 

supported 
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Error Messages 
 
Target Tracking Error Messages 
 
The following is a list of possible target tracking error messages that can occur when 
running the IPS program: 
 
 
Target Tracking Errors: 
 
0.        No errors detected. 
 
1.        Error: Unusable signal received. 
 
2.        Error: Signal timing error. 
 
3.         Error: Range cannot be determined. 
 
4.         Error: Low quality factor. 
 
5.        Warning: Target velocity excessive. 
 
6.        Error: No recent replies. 
 
7.        Error: Minimum range error. 
 
8.        Error: Simultaneous reply error. 
 
9.        Error: Transmitter inoperative. 
 
10.        Error: Travel Time < Turn Around Time. 
 
 
Telemetry Errors and Warnings: 
 
22.        Warning: Telemetry signal timing error. 
 
23.        Warning: Telemetry timing out of range. 
 
24.        Error: Telemetry depth greater then slant range. 
 
26.        Warning: No recent telemetry replies. 
 
 
Warnings: 
 
50.        Warning: Target input depth not within normal limits of calculated depth. 
 
51.        Error: Pinger D.A. < 20 , with hydrophone offsets. 
 
52.        Error: Pinger D.A. < 20 . 
 



Integrated Positioning System Version 7.7.1.10 180 

Creative Underwater Technologies Copyright 1992-2019 

53.        Warning: Pinger D.A. < 20  - 45 . Position  ». 
 
54.        Warning: Target centered mode canceled. 
 
55.        Warning: Compass not active. 
 
56.        Warning: Transponder or responder D.A. > 45 . 
 
57.        Error: Depth > Slant range. 
 
59.        Warning: No external key received. 
 
60.         Warning: System ignores the phase count depression angle. 
 
61.         Error: Horizontal range calculation > slant range 
 
62.        Warning: Auto offset enabled. 
 
64        Warning: Low quality factor lower, quality factor lower than average previous 5 
replies. 
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Lateral Positional Offset Errors 
 
Table 1.       
 
Lateral positional offset errors caused by small inaccuracy in the data from the support 
vessels compass about the actual or true headings.  Ranges in the table are listed in 
meters.  The underlined areas in the table highlight lateral positional errors of 
approximately 5 meters or less.  See notes below for assumed conditions. 
 

 
  Horz. Range 

[meters] 
 0.5 Deg 1.1.0 Deg 2.0 Deg 3.0 Deg 5.0 Deg

150  1.3  2.6 5.2 7.9  13.1 
300 2.6 5.2 10.5  15.7 26.1 
500   4.4     8.7   17.4 26.2 43.6 
750 6.5 3.1 26.2 39.3 65.4 
1000   8.7    17.5       34.9   52.3 87.2 
1500 13.1  26.2      52.3  78.5 130.7 
2000    17.5        34.9  69.8 104.7 174.3 

 
Notes: 
Correct speed of sound is used. 
 
Correct hydrophone offsets are used. 
 
Hydrophone motion is corrected in the IPS with data from a vertical referencing unit (VRU), 
as done with a BATS system.  
 
The above omitted any DGPS induced errors. 
 
Support vessels compass headings contains no bias and is with respect to true North 
 
Table 2.       
 
Maximum tracking range in meters for beacons with and without depth telemetry.  Note 
that the listed values have be rounded down to the closes hundreds of meters for 
clarity.  The values in the table below are based upon a beacons turn-around-time (TAT) of 
15 ms, a speed of sound of 1500 m/s and if used a depth telemetry Full Scale period of 
1000 ms. 
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           Interrogation Rate 

       [sec] 
                   Max Range 

           [meters] 
W/O Telemetry    With Telemetry 

2.0 1400             700 
3.0 2200           1400 
4.0 2900           2200 
5.0 3700         22900 

 



Integrated Positioning System Version 7.7.1.10 183 

Creative Underwater Technologies Copyright 1992-2019 

             Equipment Setup 
 

RDI DVL Configuration 
 
Objective:     To configure the RDI Workhorse DVL to support the 

use of an external Attitude Heading Reference 
System (AHRS).  

 
Figure 1. RDI Workhorse heading Alignment 
 

 
 
Table 1. Required DVL Configuration: 

Item Name Description Default Setting 

 
 

1 CR-Settings Resets the DVL command set to 
factory/user settings. CR keeps the 
present baud rate and does not change it 
to ROM setting 

CR0 CR1 

2 EA-Heading Alignment To reference beam 3 to vehicle 
centerline or Y-Axis, in 100th of 
degrees. Clockwise(+) see fig 1 

EA00000 EA+04500 

3 EB-Heading Bias To convert compass heading to true 
magnetic reference (NOT USED) for 
JSL [100th of degrees] 

EB00000 EB00000 
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4 EC-Speed of sound Sets the DVL speed of sound value that 
is used to scale the velocity values by 
[m/s].  Note the actual speed of sound is 
determined by the onboard CTD and all 
velocities are scaled by the ratio of the 
CTD speed of sound to 1500 m/s 

EC1500 EC1500 

5 EH-Heading Sets the DVL heading angle [100th of 
degrees]. Note EZ heading field = 0, 
the DVL uses the EH value instead of 
the DVL internal heading sensor. 

EH00000 EH00000 

6 EP-Pitch Sets the DVL pitch angle [deg]. Note 
EZ Pitch field = 0, The DVL uses the 
EP value instead of the DVL internal 
pitch sensor. 

EP0000 EP0000 

7 ER-Roll Sets the DVL Roll angle [deg]. Note 
EZ Roll field = 0, The DVL uses the 
ER value instead of the DVL internal 
roll sensor. 

ER0000 ER0000 

8 ES-Salinity Sets the water’s salinity value [PSU] ES35 ES35 
9 ET-Temperature Sets the water’s temperature [100th of 

deg C].  Note EZ temp field = 0, The 
DVL uses the ET value.  This must be a 
constant otherwise the DVL will adjust 
the speed of sound and velocity values 
based upon a value of other then 1500 
m/s.  See EC above 

ET2500 ET2500 

10 EX-Coordinate 
Transformation 

Sets the coordinate transformation 
processing flags.  For JSL set so DVL 
provides the velocity components 
X,Y,Z wrt ship coordinates (see Fig 
1).  The EA command value is used, 
internal heading is not used and 
Roll/pitch will not be used since bit 3 of 
EZ =0. 
Bit fields: 
EX10…= Ship coord, 
EX..0.. = do not use DVL Roll/Pitch, 
EX…11 allow 3-beam solution and bin 
mapping 

EX11111 EX10011 

11 EZ-Sensor Source Selects the source of the environmental 
sensor data.  Format Ezcdhprst  
c- Speed of sound = 0 = manual EC 
1500  
d – Depth = 1 = DVL depth sensor 
h – heading = 0 = manual EH 0.00 
p – pitch = 0 Manual EP 0.0 
r – roll = 0 = Manual ER 0.0 
s – Salinity = 0 = Manual ES 35 ppt 
t – temp = 1, (Manual ET 25.0 C) 

EZ111111
1 

EZ0100001 
 
Note: Depth and Temp 
required for Sound 
Velocity 

12 CF-Flow ctrl Flow Ctrl 
(EnsCyc;PngCyc;Binry;Ser;Rec) 
Auto ensemble, auto ping, bin, serial, no 
recording 

 
 

CF11110 

13 CB-Baud rate DVL Serial port settings, defaults to 
9600,8,1,n (CB411) 
Set to 19200,8,1,n (CB511) 

CB411 CB511 
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14 PD-Data select Selects the type of ensemble output data 
structure. Set to PD6 “Send a special 
DVL ASCII data stream” 

PD0 PD6 

15 TE-Time Per Ensemble Sets the minimum interval between data 
collection cycles, default 
TE01:00:00.00 

TE01:00:0
0.00 

TE00:00:00.00 

16 TF-First ping TF- Time to First Ping. Sets the time to 
wake up DVL and start data collection 

**/**/**,*
*:**:** 

**/**/**,**:**:** 

17 TP-Time Between Pings Time Between Pings. Set the minimum 
time between pings.. Format 
TPmm:ss.ff (mm-Min, ss-sec, ff-hsec) 

TP01:20.0
0 

TP00:00.00 

18 BP-Bottom Pings Bottom Track pings per ensemble. Sets 
the number of bottom pings to average 
together in each data ensemble 

BP001 BP001 

19 CK Save settings (Verify settings)  
 

 
 

20 CS Start pinging  
 

 
 

 
Configuration settings 
 
>B? 
BA = 030 ----------------- Evaluation Amplitude Min (1-255) 
BB = f934 ---------------- High Bandwidth Maximum Depth (dm) 
BC = 220 ----------------- Correlation Magnitude Min (0-255) 
BD = 000 ----------------- Delay Re-Acquire (# Ensembles) 
BE = 1000 ---------------- Max Error Velocity (mm/s) 
BF = 00000 --------------- Depth Guess (0=Auto, 1-65535 = dm) 
BG = 0,30,000 ------------ Restricted Xmit: Enable; MaxXmit[%]; MaxXmit[ms] 
BH = 3,0,0000 ------------ BM6 Configuration BW; Code; Velocity(cm/s) 
BI = 020 ----------------- Gain Switch Depth (0-999 meters) 
BK = 0 ------------------- Layer Mode (0-Off, 1-On, 2-Lost, 3-No BT) 
BL = 160,0320,0480 ------- Layer:  Min Size (dm), Near (dm), Far (dm) 
BM = 5 ------------------- Mode (4 = Def, 5 = Coherent, 6 = No Amb. Res.) 
BN = 0,999 --------------- Speed Log Hold/Drop Control (hold=1,timeout) 
BO = 025 ----------------- Distance Measure Filter Constant (1/100ths) 
BP = 001 ----------------- Pings per Ensemble 
BR = 0 ------------------- Resolution (0 = 4%, 1 = 2%, 2 = 1%) 
BS ----------------------- Clear Distance Traveled 
BW = 00001 --------------- Water Reference Interval (0-65535 pings) 
BX = 02500 --------------- Maximum Depth (10-65535 dm) 
BZ = 004 ----------------- Coherent Ambiguity Velocity (cm/s radial) 
 
>C? 
CA = 000 ----------------- Periodic Output 1/10 sec. (0-Off, [10-600]) 
CB = 511 ----------------- Serial Port Control (Baud [5=19200]; Par; Stop) 
CF = 11110 --------------- Flow Ctrl (EnsCyc;PngCyc;Binry;Ser;Rec) 
CK ----------------------- Keep Parameters as USER Defaults 
CL = 1 ------------------- No Sleep Between Pings (0 = ON, 1 = OFF) 
CN = 1 ------------------- Save NVRAM to recorder (0 = ON, 1 = OFF) 
CR # --------------------- Retrieve Parameters (0 = USER, 1 = FACTORY) 
CS ----------------------- Go (Start Pinging) 
CT = 1 ------------------- Turnkey (0 = OFF, 1 = ON) 
CX = 0 ------------------- Trigger Enable (0 = OFF, 1 = ON) 
CY = 8800C000 ------------ Clear Error Status Word 
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CZ ----------------------- Power Down Instrument 
>CK 
[Parameters saved as USER defaults] 
 
 
>E? 
EA = +04500 -------------- Heading Alignment (1/100 deg) 
EB = +00000 -------------- Heading Bias (1/100 deg) 
EC = 1500 ---------------- Speed Of Sound (m/s) 
ED = 00000 --------------- Transducer Depth (0 - 65535 dm) 
EF = 100 ----------------- Pressure Smoothing Constant (1-100,100=off) 
EH = 00000 --------------- Heading (1/100 deg) 
EP = +0000 --------------- Tilt 1 Sensor (1/100 deg) 
ER = +0000 --------------- Tilt 2 Sensor (1/100 deg) 
ES = 35 ------------------ Salinity (0-40 pp thousand) 
ET = +2500 --------------- Temperature (1/100 deg Celsius) 
EX = 10011 --------------- Coord Transform (Xform:Type; Tilts; 3Bm; Map) 
EZ = 0000000 ------------- Sensor Source (C;D;H;P;R;S;T) 
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Ocatns AHRS Configuration 
 
1.        Verify Octans interface wiring (Subcon 16 pin connector): 
 

Config RS232 (DB9) 
      GND-16 (5) 
      Tx-15 (2) 
      Rx-14 (3) 
 
Port A (to IPS) 
     RS232 GND-10 (5) 
     RS232 Tx-3 (2) 
  
Power (12 w) 
     19-35 vdc-1 
     GND-2 

 
2.        If not already installed, install the IXSEA programs “OCTANS Installation Software” 
(setup.exe). 
 
3.        Connect Octans configuration port to PC (typically com 1). 
 
4.        Launch the “OCTANS Installation Software. 
 
5.        Select the appropriate PC serial port. 
 
6.        If powered and the PC is interfaced correctly the following dialog box should be 
visible. 
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7.        Set and verify the Octans heading, Roll and Pitch biases. 
 

 
After any required value changes check the appropriate check  
boxes and select the Set button before exiting the dialog box. 

 
 
8.        Set and verify the Speed log and latitude information. 
 

 
After any required value changes select the “Set” button 
before exiting the dialog box. 
 

11.        Save the configuration to the Octans PROM by selecting the Save To Prom button 
from the main menu. 

12.        If changes were made verify that the Octans stored the changes correctly by 
accessing the above configuration dialog boxes. 
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DVL/AHRS Interface 
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Index 
3D, 96 
3D plot, 96 
 
Automatic Identification System (AIS), 39 
 
BATS, 10, 13, 16, 21, 23, 26, 62, 115,  
137, 151, 172 
 
Calibration, 49, 51, 62, 72, 130 
Chart Open, 118 
Communications Command, 147 
Compass, 5, 15, 17, 30, 106, 110, 148, 

173, 180, 183 
Conversion of WinFrog USBL Text Files to 

IPS File Format, 76 
Convert Layer Coordinate System, 119 
Copy To Clipboard, 104 
Creating a 3Beam Data File, 83 
Cursor Waypoint Activated, 8, 33, 128 
 
Data Subset, 45 
DBT, 117, 144, 163 
Didson Sub Menu, 93 
Display Settings, 125 
DPT Depth Position Target, 163 
 
EdgeTech, 5, 6, 10, 16, 26, 167 
Equipment Offset Commands, 150 
Equipment Offset Measurements, 62 
Equipment offsets, 62 
Equipment Offsets, 64, 153 
Ethernet Configuration, 46, 149 
 
File Close, 90 
File Exit Command, 105 
File New Command, 90 
File Open Command, 90 
File Print Command, 104 
File Save As Command, 90 
File Save Command, 90 
Fixed Target, 158 
Focus Icon Box, 37 
Frequently Asked Questions, 8 
 
GGA 2.x Global Positioning System Fix 

Data, 168 
GIS/Image Sub Menu, 92 
GPS receiver, 10, 26 
GPS Receiver, 18 

Hardware Key, 8, 29 
Home key, 108 
Home Key, 38 
 
Import Layer Properties, 120 
Import WinFrog Text Data, 104 
IPS 3D Sensor Processing, 49 
IPS BATS Setup Procedure, 19 
IPS Introduction, 5 
IPS Off-Line USBL Calibration Procedure, 

67 
IPS Screen FTP Export Sub Menu, 94 
 
Lateral Positional Offset Errors, 181 
List of Typical IPS Equipment, 10 
 
Map Properties, 118 
Menu Bar Overview, 89 
Merging DVL and USBL IPS Files, 78, 101 
mission information, 166 
Mission Information, 161 
Mission Statistics, 135 
Modem File, 100 
MRU, 10, 117 
 
Night View Command, 127 
 
Ocatns AHRS Configuration, 187 
Offsets, 50, 64, 65, 130, 150, 153, 156, 

158, 179 
 
PIUDP Data Format, 175 
PORE, 173, 175 
Print Setup Command, 105 
 
Range and Bearing Calculator, 128 
RDI DVL Configuration, 183 
Remote IPS Display, 46, 142, 178 
RMC, 142, 143 
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Sailplan Settings Command, 139 
Search, 12, 67, 135 
Search Data Settings, 42, 134 
Sensor Processing Sub Menu, 96 
Serial Out Command, 142 
Serial Out ID Selection, 177 
Sheltered Water Calibration, 64, 65 
Ship Offset, 150 
Ship Position Box, 30, 110, 117, 133 
Ship Settings Command, 110 
Show IPS Messages Command, 133 
Show Toolbar Command, 126 
Show Waypoint Box Command, 127 
Survey Lines, 129 
system calibration, 43 
System Calibration, 68, 130 
System Inputs, 114 

 
Target Offset, 153 
target position box, 113, 136 
Target Position Box, 31, 106 
Technical Support, 6 
Text/NMEA Sub Menu, 91 
Three Axis Magnetometer Calibration, 72 
Time Options, 162 
TLL, 91, 143, 169 
TPD, 45, 91, 143 
Trackman, 19, 115 
TrackMan, 64 
TTMT, 142 
 
UDP EchoScope Format, 174 
 
Waypoint Icon Box, 32 
Waypoint List window, 32 
Waypoint List Window, 33, 128 

 


